


 

Περίληυη  

Βαζηθφο ζηφρνο ηεο παξνχζαο δηπισκαηηθήο είλαη ε παξνπζίαζε νξηζκέλσλ ρξήζηκσλ 

ππνδείμεσλ γηα πην εχθνιε θαη γξήγνξε εθαξκνγή ηνπ Pro/NC, ηνπ  βαζηθφηεξνπ, 

δειαδή, ππνζπζηήκαηνο ηνπ Pro/Manufacturing ηνπ Pro/Engineer. Γεληθφηεξα, 

παξνπζηάδεηαη ν ζρεδηαζκφο θαη ε εθηέιεζε θαηεξγαζηψλ γηα CNC θξέδεο ηξηψλ 

αμφλσλ, κε έλα ζχγρξνλν θαη εχρξεζην ηξφπν κέζσ ηνπ πξνγξάκκαηνο Pro/Engineer. 

Δπηπιένλ, παξνπζηάδνληαη παξάιιεια βαζηθέο ιεηηνπξγίεο ηνπ πξνγξάκκαηνο 

πξνζνκνίσζεο Vericut, ην νπνίν απνηειεί ζεκαληηθφ βνεζεηηθφ πξφγξακκα ζηνλ 

ζρεδηαζκφ θαηεξγαζηψλ. 

Ζ εξγαζία πνπ αθνινπζεί πεξηιακβάλεη ηέζζεξα θεθάιαηα. 

 Αξρηθά, γίλεηαη κηα παξνπζίαζε ησλ εξγαιεηνκεραλψλ CNC, θαζψο θαη 

δηαθφξσλ πιεξνθνξηψλ πνπ ζρεηίδνληαη κε ηα θνπηηθά εξγαιεία θαη ηηο ζπλζήθεο 

κε ηηο νπνίεο ζα πξέπεη λα ρξεζηκνπνηνχληαη απηά. Δπηπιένλ, γίλεηαη κηα ζχληνκε 

αλαθνξά ζηνλ θψδηθα ησλ εξγαιεηνκεραλψλ θαη ζηνλ ηξφπν δεκηνπξγίαο ηνπ. 

 ην δεχηεξν θεθάιαην, γίλεηαη κηα ζχληνκε αλαθνξά ζην ζχζηεκα 

Pro/Manufacturing θαη ζηα ππνζπζηήκαηά ηνπ. Δπίζεο, παξνπζηάδεηαη ην ινγηθφ 

δηάγξακκα ξνήο γηα ην ζχζηεκα απηφ. 

 ην ηξίην θεθάιαην, παξνπζηάδεηαη αλαιπηηθά ν ηξφπνο ζρεδηαζκνχ θαηεξγαζηψλ 

ζην ζχζηεκα Pro/Manufacturing γηα θξέδεο ηξηψλ αμφλσλ. Παξάιιεια κε απηφ 

παξαηίζεληαη θαη πιεξνθνξίεο γηα ηηο παξακέηξνπο πνπ είλαη ζεκαληηθέο ζηελ 

εθάζηνηε θαηεξγαζία θαη γηα ηηο βαζηθφηεξεο επηινγέο δηάηαμεο γηα θαιχηεξε 

δηακφξθσζε ηνπ ιεηηνπξγηθνχ πεξηβάιινληνο ηνπ πξνγξάκκαηνο.  

 ην ηέηαξην θαη ηειεπηαίν θεθάιαην, παξνπζηάδεηαη ν ηξφπνο ρξήζεο ηνπ 

πξνγξάκκαηνο πξνζνκνίσζεο Vericut, θαζψο θαη ζεκαληηθέο πιεξνθνξίεο γηα 

ηελ ξχζκηζε ηεο πξνζνκνίσζεο.  

Ζ  δηπισκαηηθή  εξγαζία  θιείλεη  κε  ηα  παξαξηήκαηα, φπνπ πξνβάιινληαη θαη ηα 

κεραλνινγηθά ζρέδηα ηνπ ππφ θαηεξγαζία δνθηκίνπ.    

 

 

 

 

 

 

 

 



Δσταριζηίες 

Με  ην  πέξαο  ηεο  παξνύζαο  δηπισκαηηθήο  εξγαζίαο  ζα  ήζεια  λα  επραξηζηήζσ  ηνλ 

θαζεγεηή θ. Μπηιάιε Νηθόιαν γηα ηελ επθαηξία πνπ κνπ έδσζε λα αζρνιεζώ κε ην 

ζπγθεθξηκέλν ζέκα, θαζώο θαη γηα ηελ πνιύηηκε βνήζεηα θαη θαζνδήγεζή ηνπ θαζ‟ όιε ηε 

δηάξθεηα εθπόλεζήο ηεο. 

Θα ήζεια επίζεο λα επραξηζηήζσ ηνλ ππνςήθην δηδάθηνξα Σαπόγινπ Νηθόιαν γηα ηηο 

ζπλερείο ππνδείμεηο θαη εύζηνρεο παξαηεξήζεηο, πνπ ήηαλ θαηαιπηηθέο γηα ηελ εθπόλεζε 

ηεο εξγαζίαο απηήο. 
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I. Διζαγφγή 

1. Ιζηοπικό επγαλειομησανών 

Ζ αλάπηπμε ησλ εξγαιεηνκεραλψλ ρξνλνινγείηαη γχξσ ζην 1775 θαη παξνπζηάδεη 

γξήγνξε αχμεζε θαηά ηνλ 19
ν
 αηψλα.  

Σν 1775 ν Άγγινο John Wilkinson θαηαζθεχαζε έλα νξηδφληην δξάπαλν (θξεδνδξάπαλν) 

γηα ηελ επεμεξγαζία ησλ εζσηεξηθψλ επηθαλεηψλ ππξνβφισλ ζην νπνίν ε θηλεηήξηα 

δχλακε ηεο κεραλήο εξρφηαλ απφ έλα πδξνηξνρφ. 

Σν 1794 ν Henry Maudslay θαηαζθεχαζε έλα κεηαιιηθφ ηφξλν κε απηνδχλακε 

πξνψζεζε ηνπ θνπηηθνχ εξγαιείνπ (Δηθόλα I.1.1) θαη ηα επφκελα ρξφληα θαηαζθεχαζε 

δηάθνξνπο φκνηνπο ηφξλνπο κε κεηαβαιιφκελε ηαρχηεηα πεξηζηξνθήο, θαζψο επίζεο θαη 

θνπηηθέο κεραλέο γηα ζπεηξψκαηα θαη γξαλάδηα. 

 

 

 

 

 

  

Δηθόλα I.1.1 

Ο πξψηνο ηφξλνο ηνπ Μφζιπ γηα 

θνπή ζπεηξσκάησλ  

 

Καηά ηε δεθαεηία ηνπ 1810 ν James Watt θαηαζθεχαζε έλαλ παληνγξάθν, κηα κεραλή 

πνπ ρξεζηκνπνηείηαη ζπρλά θαη ζήκεξα γηα λα «αληηγξάθεη» αλάγιπθεο επηθάλεηεο 

(λνκίζκαηα θ.ά.) θαη ν Thomas Blanchard έλαλ ηφξλν, γηα παξαγσγή θαλψλ κηθξψλ 

φπισλ, ζηνλ νπνίν έλα πξνθαηαζθεπαζκέλν ππφδεηγκα θαζνδεγνχζε ην θνπηηθφ 

εξγαιείν. Έπεηηα ζηε δεθαεηία ηνπ 1840 θαηαζθεπάζηεθε ν πξψηνο απηφκαηνο ηφξλνο 

(ξεβφιβεξ). 

ην δεχηεξν κηζφ ηνπ 19
νπ

 αηψλα παξαηεξείηαη αλάπηπμε κεγάιεο πνηθηιίαο 

εξγαιεηνκεραλψλ γηα ηηο βαζηθέο ιεηηνπξγίεο θνπήο κεηάιινπ, φπσο ηφξλεπζε, 

θξεδάξηζκα, δηάηξεζε, πιάληζκα θαη ιείαλζε, νη νπνίεο αξρίδνπλ λα ρξεζηκνπνηνχληαη 

επξέσο ζηνλ βηνκεραληθφ ηνκέα.   
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εκαληηθή ήηαλ ε ζπκβνιή ηνπ  Άγγινπ Joseph Whitworth, ν νπνίνο αζρνιήζεθε κε 

θαηαζθεπέο νξγάλσλ κεηξήζεσο θαη ζπεηξσκάησλ, θαζψο επίζεο δεκηνχξγεζε θαη ηηο 

αξρέο ηππνπνίεζεο. Λφγσ απηψλ ησλ αξρψλ, θάζε εμάξηεκα ζε κηα κεραλή, ζε 

πεξίπησζε βιάβεο, κπνξνχζε εχθνια λα αληηθαηαζηαζεί κε έλα αληαιιαθηηθφ 

παλνκνηφηππν. Έηζη επέξρεηαη καδηθνπνίεζε ηεο κεραλνινγηθήο παξαγσγήο. 

Καηά ην 1800 ζηελ Αγγιία θαηαζθεπάδνληαη νη πξψηεο πιάλεο γηα κεηαιιηθέο 

επηθάλεηεο θαη ζηηο πξψηεο δεθαεηίεο ηνπ 19νπ αηψλα ζεκεηψλεηαη ε θαηαζθεπή κεγάισλ 

πιαλψλ, γηα ζεκαληηθέο κεηαιιηθέο θαηαζθεπέο, ζε Αγγιία, Ακεξηθή θαη Γεξκαλία. 

Σν 1947 ήηαλ αδχλαην γηα ηελ θαηαζθεπαζηηθή βηνκεραλία λα θαιχςεη ηηο αλάγθεο ηεο 

Ακεξηθάληθεο Πνιεκηθήο Αεξνπνξίαο. Γελ ήηαλ κφλν ε κεησκέλε παξαγσγηθή 

ηθαλφηεηα ησλ ζπκβαηηθψλ εξγαιεηνκεραλψλ, αιιά θαη ε ζπλερήο παξαγσγή ρσξίο 

ζπληήξεζε θαη ε θφπσζε ησλ ηερληθψλ, πνπ νδεγνχζε ζπρλά ζε ειαηησκαηηθά θαη 

επηθίλδπλα θνκκάηηα. Έηζη ην 1949 ν John Parsons ηεο Parsons Corporation θαη ην 

Σερλνινγηθφ  Ηλζηηηνχην ηεο Μαζαρνπζέηεο  (ΜΗΣ) αλέιαβαλ ηελ αλάπηπμε 

απηνκαηνπνηεκέλσλ εξγαιεηνκεραλψλ. Έπεηηα, ην 1952,  ην ΜΗΣ νινθιήξσζε κε 

επηηπρία ηελ πξψηε  ςεθηαθή εξγαιεηνκεραλή (κεραλή αξηζκεηηθνχ ειέγρνπ - 

Numerical Control – N.C.), κηα θξέδα κε θαηαθφξπθε άηξαθην, ε νπνία θέξεη ην φλνκα 

Cincinnati Hydrotel, θαη έρεη ηελ δπλαηφηεηα λα θαηαζθεπάδεη εμαξηήκαηα κε 

ηαπηφρξνλεο θηλήζεηο θνπήο ζε ηξεηο άμνλεο θαη λα εηζάγεη πιεξνθνξίεο κέζσ δηάηξεηεο 

ηαηλίαο (Δηθόλα I.1.2). Σν 1954 άξρηζε λα δεκηνπξγείηαη ε πξψηε ζπκβνιηθή γιψζζα 

πξνγξακκαηηζκνχ, ν “Απηφκαηνο Πξνγξακκαηηζκφο Δξγαιείσλ” (Automatically  

Programmed  Tool,  APT), φπσο νλνκάζηεθε. Μηα απφ ηηο θαηαζθεπέο ηεο πξψηεο 

ςεθηαθά θαζνδεγνχκελεο εξγαιεηνκεραλήο κε ηε βνήζεηα ηεο APT είλαη ην ηαζάθη ηεο 

Δηθόλαο I.1.3. 

 

   Δηθόλα I.1.2 
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   Δηθόλα I.1.3 

 

Σν 1958, ε εηαηξία Bendix, αγφξαζε ηελ παηέληα απφ ηνλ Parsons θαη θαηαζθεχαζε ηελ  

πξψηε  εκπνξηθή  ςεθηαθά  θαζνδεγνχκελε  εξγαιεηνκεραλή. 

Απφ εθείλε ηελ πεξίνδν θαη κεηά, ε ρξήζε ησλ κεραλψλ απηψλ γίλεηαη απαξαίηεηε ζηνλ 

βηνκεραληθφ ηνκέα. Αξρίδεη, ινηπφλ, ε πξνζπάζεηα απηνκαηνπνίεζεο φισλ ησλ 

κεραλνπξγηθψλ θαηεξγαζηψλ θαη ε αλάπηπμε  αληηζηνίρσλ  NC  εξγαιεηνκεραλψλ. 

Ζ  εμέιημε  ησλ  ειεθηξηθψλ θπθισκάησλ, ησλ εκηαγσγψλ θαη ησλ κηθξνυπνινγηζηψλ 

νδήγεζε ζηε κεηάβαζε απφ ηηο NC ζηηο CNC εξγαιεηνκεραλέο (Computer Numerical 

Control ) θαη ε αλάπηπμε ησλ αηζζεηήξσλ  θαη  ησλ  ζπζηεκάησλ  απηνκάηνπ  ειέγρνπ  

ζηηο  αληίζηνηρεο  DNC (άκεζα θαζνδεγνχκελεο εξγαιεηνκεραλέο κε ειεθηξνληθφ 

ππνινγηζηή - Direct Numerical Control). Σα ζπζηήκαηα CNC απνηεινχζαλ ζπζηήκαηα 

ειέγρνπ κε κηθξνυπνινγηζηέο, ζηα νπνία ηα πξνγξάκκαηα κπνξνχζαλ λα κεηαθεξζνχλ 

ζηελ κεραλή είηε κε καγλεηηθέο θαζέηεο (Δηθόλα I.1.4) είηε κέζσ ζχξαο RS-232 (Δηθόλα 

I.1.5). Δλψ, ε ιεηηνπξγία DNC ραξαθηήξηδε ην είδνο ηεο ιεηηνπξγίαο θαηά ην νπνίν 

πεξηζζφηεξεο κεραλέο CNC ήηαλ εθηθηφ λα πάξνπλ ηα πξνγξάκκαηα ηνπο απφ έλαλ 

θεληξηθφ ππνινγηζηή. Έηζη, ζήκεξα,  απφ  ηελ  απιή  δηάηξεζε,  έσο  ηελ  πνιχπινθε  

επεμεξγαζία  αλάγιπθσλ επηθαλεηψλ,  ρξεζηκνπνηνχληαη  απιέο  θαη  θζελέο  ή  

ζχλζεηεο  θαη  αθξηβέο εξγαιεηνκεραλέο. 

 

  Δηθόλα I.1.4 
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 Δηθόλα I.1.5 

 

ηε ζπλέρεηα, βάζε ησλ θαηεξγαζηψλ κε NC, CNC θαη DNC  κεραλέο θαη άιισλ 

ειεθηξνληθψλ ιεηηνπξγηψλ, δεκηνπξγνχληαη νινθιεξσκέλα ζπζηήκαηα παξαγσγήο κε 

ππνινγηζηή, ηα CIM. Έηζη, ηα ζπζηήκαηα αλάπηπμεο (Computer Aided Engineering - 

CAE) έξρνληαη λα βειηηζηνπνηήζνπλ ην επηζπκεηφ πξντφλ. Σα ζπζηήκαηα απηά 

πεξηιακβάλνπλ ζπζηήκαηα ζρεδίαζεο (CAD - Computer Aided Design) θαη  

πξνγξάκκαηα δηαθφξσλ ππνινγηζκψλ κε ηε ρξήζε ηεο κεζφδνπ ησλ πεπεξαζκέλσλ 

ζηνηρείσλ (FEM – ππνινγηζηηθή κέζνδνο ζηαηηθήο θαη δπλακηθήο αληνρήο θαηαζθεπψλ 

θαη φρη κφλν). Ο πξνγξακκαηηζκφο δε ησλ θαηεξγαζηψλ γίλεηαη  ζε  ζπζηήκαηα  CAM 

(Computer Aided Manufacturing), ιακβάλνληαο ππφςε δηάθνξεο ηερλνινγηθέο 

παξακέηξνπο ησλ θαηεξγαζηψλ απηψλ. 

Σα ζχγρξνλα κεραλνπξγεία  εληάζζνπλ  ηηο ΝC, CNC θαη DNC  εξγαιεηνκεραλέο ζε 

αθφκα πην ζχλζεηεο δνκέο, πνπ νλνκάδνληαη επέιηθηα ζπζηήκαηα παξαγσγήο (FMS- 

Flexible Manufacturing System) (Δηθόλα I.1.6
 
α θαη β). Σν FMS ζπληζηάηαη απφ κεραλέο 

πνπ εθηεινχλ θάπνηνλ αξηζκφ εξγαζηψλ, έλα ζχζηεκα δηαρείξηζεο πιηθψλ (MHS) θαη κηα 

ππνινγηζηηθή κνλάδα γηα ηνλ έιεγρν ηνπ ζπζηήκαηνο. Σν ζχζηεκα απηφ ελζσκαηψλεη 

ειεθηξνληθφ ζρεδηαζκφ ηεο παξαγσγήο, απηφκαηεο κεηαθνξηθέο  δηαηάμεηο  θαη  

απνζήθεο,  βηνκεραληθά  ξνκπφη  θαη  δηαηάμεηο  πνηνηηθνχ  ειέγρνπ (Δηθόλεο I.1.7).  ια  

απηά  θαζνδεγνχληαη  θαη  επνπηεχνληαη  απφ  έκπεηξνπο κεραληθνχο  θαη  ηερληθνχο,  κε  

ηε  βνήζεηα  δηθηχνπ  ειεθηξνληθψλ  ππνινγηζηψλ. Με ηνλ  ηξφπν  απηφ,  ε παξαγσγή  

απνηειεί πιένλ κηα ειεγρφκελε θαη απινπνηεκέλε δηαδηθαζία.  

ηηο κέξεο καο έρνπλ αλαπηπρζεί θαη πςειψλ ζηξνθψλ κεραλέο (High speed), νη νπνίεο 

κε ηελ βνήζεηα ησλ ζπζηεκάησλ FMS, κεηψλνπλ ζε πνιχ ζεκαληηθφ βαζκφ ηνλ ρξφλν 

παξαγσγήο. Οη κεραλέο απηέο δηαθέξνπλ απφ ηηο ζπκβαηηθέο CNC κεραλέο, σο πξνο ηελ 

ηερλνινγία πνπ ρξεζηκνπνηνχλ. Γηα ηελ εθηέιεζε high speed θαηεξγαζηψλ πξέπεη λα 

έρνπκε ηαρχηεηα πεξηζηξνθήο αηξάθηνπ κεγαιχηεξε απφ 6000 RPM, πξφσζε έσο θαη 18 

m/min, θαηάιιεια θαη δπγνζηαζκηζκέλα θνπηηθά εξγαιεία θαη θψλνπο γηα HSM, 

ζχζηεκα CAD/CAM γηα κεζνδνινγία HSM θαη εμεηδηθεπκέλνπο ρεηξηζηέο. ηελ 

παξαθάησ εηθφλα (Δηθόλα I.1.8) θαίλεηαη κηα θαηεξγαζία θξεδαξίζκαηνο πςειψλ 

ηαρπηήησλ HSM.  
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  Δηθόλα I.1.8 
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 Δηθόλεο I.1.7 

 

 Δηθόλα I.1.6α 
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Δηθόλα I.1.6β 

πκπεξαζκαηηθά, ε ρξήζε ηεο ηερλνινγίαο ινγηζκηθνχ θαη ππνινγηζηψλ, κε ζηνηρεία 

ηερλεηήο λνεκνζχλεο , νδεγεί ζηελ πξψηκε  έλλνηα  ηνπ  απηφκαηνπ  εξγνζηαζίνπ,  ζην  

νπνίν  ε  ζπκκεηνρή  ηνπ αλζξψπηλνπ παξάγνληα ζηε ιήςε απνθάζεσλ θαη ζηελ 

θαζνδήγεζε κεηψλεηαη αθφκα πεξηζζφηεξν. Σν ζχγρξνλν πιένλ απηφκαην εξγνζηάζην 

απνηειείηαη απφ εξγαιεηνκεραλέο κε ςεθηαθή θαζνδήγεζε, πνπ επηθέξνπλ κελ 

εληππσζηαθή αχμεζε ηεο παξαγσγηθφηεηαο, αιιά απαηηνχλ δε εμεηδηθεπκέλνπο 

ρεηξηζηέο. 

ηελ εηθφλα πνπ αθνινπζεί (I.1.9) παξνπζηάδεηαη δηαγξακκαηηθά ε ηζηνξηθή εμέιημε ησλ 

εξγαιεηνκεραλψλ απφ ηα αξρηθά ζηάδηα έξεπλαο κέρξη ηελ νινθιεξσηηθή θαη 

επηηπρεκέλε εθαξκνγή ηνπο. 

  Δηθόλα I.1.9 

ήκεξα, πιένλ, ην απηφκαην εξγνζηάζην είλαη ζην ζηάδην ηεο νινθιεξσηηθήο εθαξκνγήο 

κε ζπλερηδφκελεο, φκσο, ηάζεηο εμέιημεο. Αμίδεη λα ζεκεησζεί φηη ηψξα ε Δπξσπατθή 

Έλσζε ρξεκαηνδνηεί ηα „Δξγνζηάζηα ηνπ Μέιινληνο‟ (Factories of the Future) κέζα 

απφ ην 7
ν
 Πξφγξακκα Πιαίζην.  
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2. Γενικέρ απσέρ απιθμηηικού ελέγσος 

 

Οριζμός αριθμηηικού ελέγτοσ 

Αριθμητικός  έλεγχος  εργαλειομηχανών  είλαη  ν  ηχπνο  ειέγρνπ  πνπ  ρξεζηκνπνηεί 

αξηζκεηηθέο  ηηκέο  γηα  ηελ  αλαθνξά  ζηε  ζέζε  θαη  ηελ  θίλεζε  ησλ  αμφλσλ  ηεο 

κεραλήο,  γηα  ηνλ  νξηζκφ  εξγαιείσλ,  ζηξνθψλ  αηξάθηνπ  θιπ.. Ο αξηζκεηηθφο έιεγρνο 

δίλεη ηελ δπλαηφηεηα ζηνλ ρεηξηζηή λα «επηθνηλσλεί» κε ηελ εξγαιεηνκεραλή θαη λα ηελ 

«θαζνδεγεί» κέζσ ελφο θψδηθα, δειαδή κέζσ κηαο αθνινπζίαο γξακκάησλ θαη αξηζκψλ. 

Μέζσ ηεο κνλάδαο ειέγρνπ ηεο εξγαιεηνκεραλήο εθηεινχληαη θαηεξγαζίεο κε χςηζηε 

αθξίβεηα θαη ειέγρνληαη φιεο νη ιεηηνπξγίεο ηεο. Οη εξγαιεηνκεραλέο πνπ ιεηηνπξγνχλ κε 

απηφ ηνλ ηξφπν ιέγνληαη ςεθηαθά θαζνδεγνχκελεο εξγαιεηνκεραλέο (NC). 

Δάλ παξεκβάιιεηαη ειεθηξνληθφο ππνινγηζηήο νη εξγαιεηνκεραλέο νλνκάδνληαη 

ςεθηαθά θαζνδεγνχκελεο εξγαιεηνκεραλέο κε ειεθηξνληθφ ππνινγηζηή (CNC). ηηο 

CNC εξγαιεηνκεραλέο απηνκαηνπνηείηαη ε ιεηηνπξγία θαη ν έιεγρνο ηνπο κπνξεί λα γίλεη 

θαη απφ απφζηαζε (remote control). 

ηελ παξαθάησ εηθφλα παξνπζηάδνληαη δηάθνξεο ςεθηαθά θαζνδεγνχκελεο 

εξγαιεηνκεραλέο. 

 
Δηθόλα I.2.1 
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Σα θχξηα ζηνηρεία εξγαιεηνκεραλήο αξηζκεηηθνχ ειέγρνπ (Δηθόλα I.2.2) είλαη ηα εμήο :  

 

•  Οη άμνλεο ηεο εξγαιεηνκεραλήο - ζπλδπαζκφο γξακκηθψλ θαη πεξηζηξνθηθψλ, φπνπ 

θάζε άμνλαο  λνείηαη  θαη  κε  ηελ  θηλεκαηηθή  ηνπ  έλλνηα,  αιιά  θαη  ζαλ  ζχζηεκα  

κεηάδνζεο θίλεζεο, φπσο  επίζεο  θαη κέηξεζεο  ησλ ζηνηρείσλ απηήο  ηεο θίλεζεο 

(ζέζε,  ηαρχηεηα, επηηάρπλζε). Παξάδεηγκα γξακκηθήο θίλεζεο απνηειεί ε πξφσζε  ηνπ  

ηξαπεδηνχ  κηαο θξέδαο, ελψ πεξηζηξνθηθήο ε πεξηζηξνθή ηνπ δηαηξέηε ηεο θξέδαο. 

•  Σν  ειεθηξνληθφ  ζχζηεκα  ειέγρνπ  ην  νπνίν  πεξηιακβάλεη  ζπλήζσο  έλα  αξηζκφ  

κηθξν-επεμεξγαζηψλ, RAM, ROM  θαη  νινθιεξσκέλσλ  θπθισκάησλ  γηα  ηελ  

επεμεξγαζία  θαη δηαρείξηζε ηνπ πξνγξάκκαηνο θαζψο θαη ειεθηξνληθά ηζρχνο γηα ηνλ 

έιεγρν ησλ αμφλσλ.  

•  Σν  ινγηζκηθφ -  ιεηηνπξγηθφ  ζχζηεκα  ην  νπνίν  πεξηιακβάλεη  παξακέηξνπο  

κεραλήο, πεξηβάιινλ  πξνγξακκαηηζκνχ,  ζηαζεξέο  ξνπηίλεο  επηκέξνπο  θαηεξγαζηψλ,  

ξνπηίλεο δηεπθφιπλζεο  ηνπ  πξνγξακκαηηζκνχ  ηεο  κνλάδαο  ειέγρνπ,  ζχζηεκα  

ελδείμεσλ ηξέρνπζαο θαηάζηαζεο, δηαγλσζηηθά βιαβψλ θιπ.  

•  Γηάθνξα πεξηθεξεηαθά γηα ηελ εηζαγσγή ηνπ πξνγξάκκαηνο ζηε κεραλή, ηελ 

εθηχπσζε αξρείσλ θαη ελδερφκελα ηελ παξαθνινχζεζε ηεο ιεηηνπξγίαο ηεο 

εξγαιεηνκεραλήο. 

 

 Δηθόλα I.2.2 

 

Σα ζεκεξηλά  ζπζηήκαηα  ειέγρνπ  CNC  (αξηζκεηηθφο  έιεγρνο  κε  Ζ/Τ)  

ρξεζηκνπνηνχλ επηπξφζζεηα αξηζκεηηθέο ηηκέο θαη γηα ιεηηνπξγίεο, φπσο ν  

κεηαζρεκαηηζκφο ζπζηεκάησλ ζπληεηαγκέλσλ,  ε  δηαρείξηζε  πηλάθσλ  δεδνκέλσλ  ,  ε  

αληηζηάζκηζε δηακέηξνπ  θαη  κήθνπο  εξγαιείνπ  θιπ.  Απηέο  θαζψο  θαη  επηπξφζζεηεο  

ιεηηνπξγίεο γξαθηθψλ, επηθνηλσλίαο κε άιινπο Ζ/Τ θαη πεξηθεξεηαθά αληηδηαζηέιινπλ 

ηνλ απιφ αξηζκεηηθφ έιεγρν (NC) κε απηφλ πνπ βαζίδεηαη ζε ειεθηξνληθφ ππνινγηζηή 

(CNC). ήκεξα  πιένλ  δελ  πθίζηαηαη  NC κε  ηελ  αξρηθή  ηνπ  έλλνηα,  απιά, CNC  θαη  

απηφ ελλννχκε πιένλ κε ηνλ φξν «αξηζκεηηθφο έιεγρνο».   
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Πλεονεκηήμαηα και περιοριζμοί ηοσ Αριθμηηικού Δλέγτοσ 

Οη  ζεκεξηλέο  κνλάδεο  CNC  εθηεινχλ κεγάιεο ζρεηηθά έθηαζεο  επεμεξγαζία  ησλ 

δεδνκέλσλ, ην νπνίν, λαη κελ ηνπο  πξνζζέηεη ιεηηνπξγηθφηεηα, αιιά θαη 

πνιππινθφηεηα. Σν  βαζηθφηεξν  θίλεηξν  ζηελ  αλάπηπμε ησλ  εξγαιεηνκεραλψλ  κε  

ζχζηεκα  αξηζκεηηθνχ  ειέγρνπ,  απνηέιεζε  ε  αλάγθε  γηα πςειή  αθξίβεηα  ζηηο 

θαηαζθεπέο  εμαξηεκάησλ  πνιχπινθεο  γεσκεηξίαο, ζε ζπλδπαζκφ ηφζν κε ηελ 

επαλαιεςηκφηεηα ηνπ απνηειέζκαηνο φζν θαη κε ηε κείσζε ηνπ  ρξφλνπ  θαηεξγαζίαο. 

Γηα ηνπο παξαπάλσ ιφγνπο, ε πιεηνςεθία ησλ εξγαιεηνκεραλψλ πνπ πσινχληαη ζήκεξα 

είλαη CNC εξγαιεηνκεραλέο. Ζ  αλάδεημε  ησλ  πιενλεθηεκάησλ  ησλ  εξγαιεηνκεραλψλ 

CNC κπνξεί  λα  γίλεη ζπγθξίλνληαο  ηηο  δπλαηφηεηεο  ηνπο κε απηέο  ησλ ζπκβαηηθψλ 

εξγαιεηνκεραλψλ.  

Καηαζθεπέο  πςειήο  αθξίβεηαο,  ηεο  ηάμεο  ηνπ  0.01mm  ή  κηθξφηεξν,  απαηηνχλ  ζηηο 

ζπκβαηηθέο  εξγαιεηνκεραλέο  εμαηξεηηθά  ρξνλνβφξεο θαηεξγαζίεο, αθνχ ν  ρεηξηζηήο 

είλαη  ππνρξεσκέλνο  λα  δηαθφπηεη  ζπρλά  ηελ  θνπή  γηα  λα  κεηξά  ηηο  δηαζηάζεηο  ηνπ 

θνκκαηηνχ, έηζη ψζηε λα εμαζθαιίζεη ηελ απαηηνχκελε αθξίβεηα. Οη εξγαιεηνκεραλέο 

CNC, φκσο, εμνηθνλνκνχλ απηφ  ην  ρξφλν, αθνχ ε αθξίβεηα θνπήο – ζπλήζσο  ίζε πξνο  

ηε δηαθξηηηθή ηθαλφηεηα ηεο εξγαιεηνκεραλήο – είλαη δεδνκέλε απφ ην ζχζηεκα. 

Δπηπιένλ εμνηθνλνκείηαη ρξφλνο κε ηηο CNC θαη θαηά ηελ αιιαγή ηεο θάζεο 

θαηεξγαζίαο, φπνπ ν ρεηξηζηήο ζπκβαηηθήο κεραλήο ζα ήηαλ ππνρξεσκέλνο λα 

ζηακαηήζεη, έηζη ψζηε λα είλαη δπλαηή ε ζπλέρηζε ηεο επφκελεο θάζεο.  

Ζ  παξαγσγηθή  δηαδηθαζία  θαη  ην  απνηέιεζκά  ηεο  εμαξηάηαη  αθφκα  θαη  απφ  ηελ 

θφπσζε  ηνπ  ρεηξηζηή. ηα  ζπζηήκαηα CNC,  παξαθάκπηνληαη  απηά  ηα  πξνβιήκαηα 

θαη επηπιένλ, επεηδή ε επαλαιεςηκφηεηα ηνπ απνηειέζκαηνο είλαη ζε πςειά επίπεδα, ν 

έιεγρνο ηεο πνηφηεηαο πεξηνξίδεηαη ζην πξψην κφλν θνκκάηη. 

Δλψ φιεο νη κεραλνπξγηθέο θαηεξγαζίεο, απιέο ή ζχλζεηεο, κπνξνχλ λα γίλνπλ απφ 

ςεθηαθά θαζνδεγνχκελεο εξγαιεηνκεραλέο, δελ ζπκβαίλεη ην ίδην θαη κε ηηο ζπκβαηηθέο. 

ηηο  ζπκβαηηθέο  εξγαιεηνκεραλέο, ε  δπλαηφηεηα  θνπήο  πεξηγξακκάησλ  ηα  νπνία 

απαηηνχλ  θίλεζε  ηνπ  θνπηηθνχ  εξγαιείνπ  ηαπηφρξνλα  ζε  δχν  άμνλεο,  βξίζθεηαη  ζε 

άκεζε  εμάξηεζε  απφ  ηελ  εκπεηξία  θαη  δεμηνηερλία  ηνπ  ρεηξηζηή  θαη  απηφ  κφλν  γηα 

απιά  θνκκάηηα,  ελψ  ε  θνπή  πεξηγξακκάησλ  ζε  ηξεηο  δηαζηάζεηο  είλαη  εληειψο 

αδχλαηε. Αληίζεηα ζηηο εξγαιεηνκεραλέο CNC, νη δπλαηφηεηεο απηέο είλαη 

ραξαθηεξηζηηθέο. 

ε  αληηζηάζκηζε  απηψλ  ησλ  πιενλεθηεκάησλ,  νη  εξγαιεηνκεραλέο  CNC  έρνπλ 

πςειφηεξν θφζηνο αγνξάο θαη ζπληήξεζεο θαη απαηηνχλ έκπεηξνπο πξνγξακκαηηζηέο 

εμνηθεησκέλνπο  κε  ηηο  κεραλνπξγηθέο  θαηεξγαζίεο,  ηνλ  πξνγξακκαηηζκφ  θαη  ηε 

ιεηηνπξγία ηνπο. 
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3. Άξονερ καηεπγαζίαρ 

Ζ έλλνηα ηνπ ηχπνπ ειέγρνπ ησλ αμφλσλ έρεη ηδηαίηεξε ζεκαζία γηα ηελ θαηαλφεζε  ηεο  

αξρήο  ιεηηνπξγίαο  ηεο  εξγαιεηνκεραλήο.  Γηα   ηελ  θίλεζε  ησλ  αμφλσλ  έρεη  ζεκαζία  

ην  αξρηθφ  ζεκείν,  ην  ηειηθφ  ζεκείν (πξννξηζκφο) θαη ε ηαρχηεηα ηεο θίλεζεο. Ο  

απινχζηεξνο  ηξφπνο  θίλεζεο  απφ  ην  αξρηθφ  ζην  ηειηθφ  ζεκείν  είλαη  ε  αλεμάξηεηε 

κεηαηφπηζε θάζε άμνλα ηαπηφρξνλα, αιιά ρσξίο ζχλδεζε ησλ αμφλσλ κεηαμχ ηνπο 

(ζεκείν πξνο ζεκείν). Απηφο ν ηξφπνο είλαη ζαθέο φηη θηλεί, πρ έλα εξγαιείν θνπήο, απφ 

έλα ζεκείν ζε έλα άιιν, αιιά ρσξίο λα δίλεη ζεκαζία ζηελ αθνινπζνχκελε  ηξνρηά. Ο 

ηξφπνο απηφο ρξεζηκνπνηείηαη ζπλήζσο απφ  ηηο  παιαηφηεξεο  κεραλέο  δηάηξεζεο  θαη  

θάπνηεο  εξγαιεηνκεραλέο δηακφξθσζεο ειαζκάησλ. 

Παξαιιαγή  ηνπ  ηχπνπ  απηνχ απνηειεί ε  κεηαηφπηζε  θάζε  άμνλα δηαδνρηθά, ή φπσο 

νλνκάδεηαη ζπλήζσο “γξακκηθήο ηξνρηάο”, ζηνλ νπνίν εθηεινχληαη  ζπλήζσο  δηαδνρηθέο  

γξακκηθέο  θηλήζεηο, πνπ έρνπλ φκσο πεξηνξηζκέλε ρξεζηκφηεηα, επεηδή είλαη δχζθνιν 

λα αθνινπζεζεί ζπγθεθξηκέλε ηξνρηά ζηε γεληθή πεξίπησζε. Ο  πην  εμειηγκέλνο  ηχπνο  

θίλεζεο  ησλ  αμφλσλ  είλαη  κε  ζπγρξνληζκφ  ηνπο  έηζη  ψζηε  λα δηαγξάθεηαη  κία  

ζπγθεθξηκέλε  ηξνρηά  ζην  ρψξν.  Ζ  πην  ζπλεζηζκέλε  πεξίπησζε  είλαη  ν 

ζπγρξνληζκφο  ηξηψλ  αμφλσλ, κε ηνλ νπνίν είλαη  δπλαηή  ε  δηαγξαθή  θακπχισλ  ζην  

ρψξν. Μηα παξαιιαγή  απηνχ  ηνπ  ηξφπνπ  ππάξρεη  θαη  ζην  επίπεδν  κε  δπλαηφηεηα  

ρξήζεο  φκσο ηνπιάρηζηνλ  ηξηψλ  αμφλσλ (θίλεζε 2.5  δηαζηάζεσλ). O  ζπγρξνληζκφο  

απηφο  γίλεηαη  κε παξεκβνιή (Interpolation) πνπ πινπνηείηαη ζπλήζσο ζε  ινγηζκηθφ. Ο  

ηχπνο απηφο  ειέγρνπ νλνκάδεηαη “γεληθεπκέλεο ηξνρηάο”.    

Καζνξηζκφο ησλ αμφλσλ 

Οη  άμνλεο  ζπληεηαγκέλσλ  θαη  ν  ηξφπνο  θαζνξηζκνχ  ηεο  ζεηηθήο  θαηεχζπλζεο  

θίλεζεο  γηα εξγαιεηνκεραλέο  αξηζκεηηθνχ  ειέγρνπ  πεξηγξάθνληαη  ζην ISO-841  ηνπ  

1974  θαη  ζηα αληίζηνηρα  εζληθά  πξφηππα DIN, BS  θιπ.  

Οξίδεηαη  δεμηφζηξνθν  θαξηεζηαλφ  ζχζηεκα   γηα ηνπο θχξηνπο άμνλεο Υ, Τ θαη Ε 

(Δηθόλα I.3.1) 

Οη γξακκηθνί άμνλεο κηαο εξγαιεηνκεραλήο είλαη   

•  νη θχξηνη Υ, Τ, Ε,  

•  νη δεπηεξεχνληεο U, V, W, παξάιιεινη πξνο ηηο δηεπζχλζεηο x, y, z αληίζηνηρα.  

•  νη βνεζεηηθνί P, Q θαη R., φρη αλαγθαία παξάιιεινη πξνο ηηο δηεπζχλζεηο x, y, z.  

Οη άμνλεο πεξηζηξνθήο ζπκβνιίδνληαη κε A, B θαη C θαη είλαη επίζεο παξάιιεινη πξνο  

ηηο θχξηεο θαξηεζηαλέο δηεπζχλζεηο x, y, z. Ζ ζεηηθή θαηεχζπλζε πεξηζηξνθήο γηα ηνπο 

άμνλεο A, B θαη C  πξνζδηνξίδεηαη  κε  ηνλ  θαλφλα  ηνπ  δεμηφζηξνθνπ  θνριία   

θνηηψληαο πξνο ηε  ζεηηθή θαηεχζπλζε ησλ αμφλσλ Υ,Τ,Ε αληίζηνηρα (Δηθόλα I.3.2).  

Ο  άμνλαο R (Reference =  αλαθνξά)  ζπρλά  ρξεζηκνπνηείηαη  αληί  ηνπ  Ε  γηα  λα  

δειψζεη  ην επίπεδν (αλαθνξάο) φπνπ απνζχξεηαη  ην εξγαιείν θξέδαο, δξαπάλνπ θαη 
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άιισλ ζπλαθψλ εξγαιεηνκεραλψλ  κεηά  ηελ  νινθιήξσζε  κηαο  θάζεο  θνπήο  θαη  

πξηλ  ηελ  έλαξμε  ηεο επφκελεο θαη πάλσ απφ ην νπνίν ην εξγαιείν είλαη δπλαηφ λα 

θηλείηαη κε γξήγνξε πξφσζε. 

                                   

         Δηθόλα I.3.1              Δηθόλα I.3.2 

 

Οη  θαλφλεο  πξνζαλαηνιηζκνχ  ηνπ  θαξηεζηαλνχ  ζπζηήκαηνο  ζε  εξγαιεηνκεραλέο  

είλαη νη αθφινπζνη :  

Γηα ηνλ άμνλα ησλ Ε :  

•  ε  εξγαιεηνκεραλέο  θξεδαξίζκαηνο  ή  δηάηξεζεο  ε  ζχκβαζε  είλαη  ν  Ε  άμνλαο  

λα  είλαη παξάιιεινο  κε  ηελ  άηξαθην  θαη  ε  ζεηηθή  θαηεχζπλζε  λα  αληηζηνηρεί  ζε  

αχμεζε  ηεο απφζηαζεο ηεκαρίνπ - εξγαιείνπ.   

•  Γεληθά ν άμνλαο Ε είλαη θαηά κήθνο ηεο θχξηαο αηξάθηνπ (απηήο πνπ δηαζέηεη ηελ 

κέγηζηε ηζρχ). Ζ άηξαθηνο κπνξεί  λα πεξηζηξέθεη  ην  εξγαιείν (φπσο ζε δξάπαλα) ή  ην  

ηεκάρην (φπσο ζε ηφξλνπο).  

•  Δάλ δελ ππάξρεη άηξαθηνο, φπσο ι.ρ. ζε πιάλεο, ν άμνλαο Ε είλαη θάζεηνο ζηελ 

επηθάλεηα ζπγθξάηεζεο ηνπ ηεκαρίνπ (ηξαπέδη).  

Γηα ηνλ άμνλα ησλ Υ :  

•  Ο  άμνλαο  Υ  είλαη παξάιιεινο πξνο  ηελ  επηθάλεηα  ζπγθξάηεζεο  θαη παξάιιεινο 

πξνο ηελ  καθξχηεξε  απφ  ηηο  θηλήζεηο  ηεο  κεραλήο.  πνπ  είλαη  δπλαηφλ  πξέπεη  λα  

είλαη νξηδφληηνο.  

•  ε  εξγαιεηνκεραλέο  κε πεξηζηξεθφκελα  εξγαιεία  εάλ  ν  άμνλαο  Ε  είλαη   

νξηδφληηνο,  ε ζεηηθή θαηεχζπλζε Υ είλαη πξνο ηα δεμηά θνηηψληαο απφ ηελ θνιψλα πξνο 

ην ηεκάρην. Δάλ  ν  άμνλαο  Ε  είλαη  θαηαθφξπθνο  ε  ζεηηθή  θαηεχζπλζε  ηνπ  άμνλα  Υ  

είλαη πξνο ηα δεμηά θνηηψληαο απφ ηελ άηξαθην πξνο ηελ θνιψλα. 

•  ηελ πεξίπησζε ηφξλνπ ν άμνλαο Υ έρεη θαηεχζπλζε αθηηληθά πξνο ηα έμσ.  

Γηα  ηνλ  άμνλα  ησλ Τ  ε  ζεηηθή  θαηεχζπλζε πξνθχπηεη  απφ  ην  δεμηφζηξνθν  

ζχζηεκα Υ-Τ-Ε κεηά ηνλ πξνζδηνξηζκφ ησλ ζεηηθψλ θαηεπζχλζεσλ γηα ηνπο άμνλεο Υ 

θαη Ε. 
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Πην αλαιπηηθά, γηα λα γίλεη θαηαλνεηή ε έλλνηα ησλ αμφλσλ θαηεξγαζίαο, είλαη 

επθνιφηεξν λα ππνηεζεί φηη φιεο νη θηλήζεηο κηαο θαηεξγαζίαο κε ςεθηαθά 

θαζνδεγνχκελε εξγαιεηνκεραλή γίλνληαη απφ ην θνπηηθφ εξγαιείν, ρσξίο βέβαηα λα 

ηζρχεη απηφ.  

Γηα παξάδεηγκα, ζηελ ηφξλεπζε κε ςεθηαθή θαζνδήγεζε, άμνλεο θαηεξγαζίαο είλαη νη 

θηλήζεηο, πνπ εθηειεί ην εξγαιείν θάζεηα θαη παξάιιεια πξνο ηνλ άμνλα πεξηζηξνθήο 

ηνπ θαηεξγαδφκελνπ ηεκαρίνπ, επνκέλσο, αξθεί ε ρξήζε επίπεδσλ ζπζηεκάησλ 

ζπληεηαγκέλσλ, θαη κάιηζηα θαξηεζηαλψλ, φπσο παξνπζηάδεηαη ζηελ Δηθόλα I.3.3. 

 

 

Δηθόλα I.3.3 
 

 

  Παξάδεηγκα ηφξλεπζεο. 

Αληίζηνηρα, ζην θξεδάξηζκα κε ςεθηαθή θαζνδήγεζε, νη βαζηθέο θηλήζεηο πνπ εθηειεί 

έλα εξγαιείν σο πξνο ην θαηεξγαδφκελν θνκκάηη, είλαη ε θάζεηε, ε δηακήθεο θαη ε 

εγθάξζηα. ηηο θξέδεο κε ςεθηαθή θαζνδήγεζε, ηνπιάρηζηνλ δχν απφ απηέο ηηο θηλήζεηο, 

δειαδή ε  δηακήθεο θαη ε εγθάξζηα σο πξνο ην ηεκάρην, κπνξνχλ λα εθηειεζηνχλ 
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αλεμάξηεηα ε κία απφ ηελ άιιε αιιά θαη ηαπηφρξνλα. Αθφκα είλαη δπλαηέο θαη 

πεξηζηξνθηθέο θηλήζεηο. Γη‟ απηφ ην ιφγν, ζπρλά ρξεζηκνπνηείηαη ν δηαρσξηζκφο κεηαμχ 

ησλ γξακκηθψλ θαη ησλ πεξηζηξνθηθψλ βαζκψλ ειεπζεξίαο. (Δηθόλα I.3.4) 

 

 Δηθόλα I.3.4 

 Παξάδεηγκα θξεδαξίζκαηνο. 

Αλάινγα κε ηνπο άμνλεο θαηεξγαζίαο κίαο κεραλήο, απηή παίξλεη έλα αληίζηνηρν φλνκα. 

Έηζη, φινη νη ηφξλνη ςεθηαθήο θαζνδήγεζεο είλαη ηνπιάρηζηνλ 2 αμφλσλ (δηαμνληθνί). 

ηελ ίδηα θαηεγνξία αλήθνπλ θαη πξέζζεο, κεραλέο θνπήο κε laser θαη plasma, κεραλέο 

ειεθηξνδηάβξσζεο, θαζψο θαη κεραλέο δηάηξεζεο.  

Μία κεραλή, ζηελ νπνία θηλείηαη ηαπηφρξνλα ην ηξαπέδη ζηνπο δχν νξηδφληηνπο άμνλεο, 

αιιά φρη θαη ζηνλ θαηαθφξπθν άμνλα, ιέγεηαη κεραλή 2 ½ αμφλσλ. Αλ ε θαζνδήγεζε 

επηηξέπεη ηελ ηαπηφρξνλε θίλεζε θαη ζηνλ θαηαθφξπθν άμνλα, ε κεραλή είλαη 3 αμφλσλ 
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(ηξηαμνληθή). Μεραλέο 3 αμφλσλ είλαη νη θξέδεο, νη κεηξεηηθέο κεραλέο, νη κεραλέο 

δηάηξεζεο θαη πνιιέο άιιεο. 

Σέινο, αλάινγα ηηο δπλαηφηεηεο πεξηζηξνθήο ηνπ ηξαπεδηνχ κε ην θνπηηθφ εξγαιείν, 

δειαδή, εάλ ππάξρεη κία ή θαη πεξηζζφηεξεο πεξηζηξνθηθέο θηλήζεηο, κπνξεί κηα κεραλή 

λα είλαη 4, 5 ή 6 αμφλσλ.  

Οη πεξηζζφηεξεο θξέδεο είλαη ηξηαμνληθέο, ελψ πεξηζζφηεξνπο άμνλεο δηαζέηνπλ ηα 

θέληξα θαηεξγαζίαο πνπ είλαη ζπλήζσο ηεηξαμνληθά ή πεληαμνληθά.  

 

4. Κοπηικά επγαλεία 

Σα θνπηηθά εξγαιεία ζηηο εξγαιεηνκεραλέο είλαη απηά πνπ εθηεινχλ φιεο ηηο 

θαηεξγαζίεο. Σα εξγαιεία θαηαζθεπάδνληαη απφ δηάθνξα πιηθά θαη κε δηαθνξεηηθή 

γεσκεηξία, πξνθεηκέλνπ λα είλαη θαηάιιεια γηα ην είδνο ηηο θαηεξγαζίαο πνπ εθηεινχλ 

θαη γηα ην θαηεξγαδφκελν πιηθφ θαη γηα λα πξνζδίδνπλ ηελ επηζπκεηή αθξίβεηα. ηε 

βηνκεραλία ππάξρνπλ πνιιά πιηθά θνπηηθψλ εξγαιείσλ πνπ ρξεζηκνπνηνχληαη (Δηθόλα 

I.4.1). Σν θαιχηεξν  εξγαιείν  γηα  κηα  θαηεξγαζία  είλαη  απηφ  πνπ  έρεη επηιερζεί 

πξνζεθηηθά θαη πξαγκαηνπνηεί ηελ θαηεξγαζία γξήγνξα, απνδνηηθά θαη νηθνλνκηθά. 

 Έλα θνπηηθφ εξγαιείν, γηα λα παξάγεη πνηνηηθά θαη νηθνλνκηθά θνκκάηηα, ζα πξέπεη λα 

δηαηεξεί ηε ζθιεξφηεηά ηνπ, ηηο πςειέο ζεξκνθξαζίεο πνπ  αλαπηχζζνληαη  θαηά  ηελ  

θνπή,  ηελ  αλζεθηηθφηεηά  ηνπ,  ψζηε  λα  κελ ζξπκκαηίδεηαη  θαηά  ηελ  θαηεξγαζία,  

θαη  ηελ  αληνρή  ηνπ  ζηε  θζνξά,  γηα  λα επηηεπρηεί  ε  επηζπκεηή  δσή  ηνπ  εξγαιείνπ,  

πξηλ  απηφ  ρξεηαζηεί  λα αληηθαηαζηαζεί.   

Ζ  δσή  ηνπ  θνπηηθνχ  εξγαιείνπ  είλαη  ν  πην  ζεκαληηθφο  νηθνλνκηθφο παξάγνληαο 

ζηελ  θνπή  κεηάιισλ  θαη  επεξεάδεηαη απφ  ηελ  ηαρχηεηα  θνπήο θαη ηελ ηαρχηεηα 

παξαγσγήο. Ζ κείσζε ηεο ηαρχηεηαο θνπήο απμάλεη ηε δσή ηνπ  εξγαιείνπ,  φκσο  

κεηψλεη  ηελ  ηαρχηεηα  παξαγσγήο.  Δλψ  αληίζεηα,  ε αχμεζε  ηεο  ηαρχηεηαο  θνπήο  

απμάλεη  ηελ  ηαρχηεηα  παξαγσγήο  αιιά απαηηνχληαη πεξηζζφηεξεο  αιιαγέο  ησλ 

θζαξκέλσλ  θνπηηθψλ  εξγαιείσλ,  ην νπνίν ζπλεπάγεηαη αχμεζε ηνπ θφζηνπο. 

Σα  θπξηφηεξα  πιηθά  ησλ  θνπηηθψλ  εξγαιείσλ  είλαη,  ν  ράιπβαο (ηδηαίηεξα ν 

ηαρπράιπβαο HSS - High Speed Steel),  ηα ρπηεπηά θξάκαηα(Cast Alloys),  ηα  

ζθιεξνκέηαιια (Carbides),  ηα  θεξακηθά (Ceramics),  ηα  δηακάληηα  θαη  νη ιεηαληηθέο 

ζθφλεο. Σα θνπηηθά εξγαιεία απφ ηαρπράιπβα θαη ζθιεξνκέηαιιν είλαη απηά πνπ 

ρξεζηκνπνηνχληαη ζε κεγαιχηεξε  έθηαζε  γηα  ηηο  θαηεξγαζίεο αθαίξεζεο πιηθνχ. 
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  Δηθόλα I.4.1 

Γηα ηηο CNC θξέδεο θαη ηα θέληξα θαηεξγαζίαο, ηα πην ζεκαληηθά εξγαιεία είλαη ηα 

θνλδχιηα, ηα ηξππάληα, νη ζπεηξνηφκνη ξχκεο θ.α.. ηα θνλδχιηα κπνξνχκε λα έρνπκε 

κέρξη δέθα πεξίπνπ πηεξχγηα. 

Ο αξηζκφο ησλ θηεξψλ - πηεξπγίσλ (flutes) ζηα θνλδχιηα θξεδαξίζκαηνο εμαξηάηαη απφ 

ην θαηεξγαδφκελν πιηθφ, ηηο δηαζηάζεηο ηνπ ππφ θαηεξγαζία ηεκαρίνπ θαη ηηο ζπλζήθεο 

θαηεξγαζίαο. Γεληθά ηζρχεη φηη φζν πεξηζζφηεξα πηεξχγηα ηφζν κεγαιχηεξε αθξίβεηα 

αθαίξεζεο πιηθνχ.  

Γηα ηελ επηινγή ηνπ θαηάιιεινπ εξγαιείνπ πξέπεη λα πξνζδηνξίζνπκε ηηο επηζπκεηέο 

ζπλζήθεο θνπήο. Γη απηφ είλαη ρξήζηκν λα ειέγρνπκε ην βάζνο θνπήο θαη ηελ πιάγηα 

κεηαηφπηζε (απφ ηνπο θαηαιφγνπο ησλ θαηαζθεπαζηψλ) θαη λα ππνινγίζνπκε ηελ 

ηαρχηεηα πεξηζηξνθήο ηεο αηξάθηνπ θαη ηελ ηαρχηεηα πξφσζεο ηεο εξγαιεηνκεραλήο. 

Γηα ηνλ ππνινγηζκφ ησλ ηαρπηήησλ απηψλ, νη θαηαζθεπαζηέο παξέρνπλ ηελ 

πεξηθεξεηαθή ηαρχηεηα θαη ηελ πξφσζε αλά πηεξχγην. 

Ζ πεξηθεξεηαθή ηαρύηεηα είλαη ε απφζηαζε πνπ δηαλχεη ην θνπηηθφ εξγαιείν ζηελ 

πεξηθέξεηά ηνπ θαζψο πεξηζηξέθεηαη γηα λα πξαγκαηνπνηήζεη κηα ζπγθεθξηκέλε 

θαηεξγαζία, ή αιιηψο ε ηαρύηεηα θνπήο (cutting speed), θαη ζπκβνιίδεηαη κε cv  θαη 

κεηξηέηαη ζε κέηξα αλά ιεπηφ (m/min). 

Ζ πξόσζε θνπήο f (cutting feed) είλαη  ε  απφζηαζε  ηελ  νπνία  δηαλχεη  ην θνπηηθφ  ή  

ην  ππφ  θαηεξγαζία  ηεκάρην (κεηαηφπηζε  ηξαπέδεο  εξγαιεηνκεραλήο),  θαηά  ηε  

δηάξθεηα  κηαο  πεξηζηξνθήο  ηεο θπξίαο αηξάθηνπ ηεο εξγαιεηνκεραλήο (spindle) καδί κε 

ην θνπηηθφ, κεηξνχκελε ζε ίληζεο αλά πεξηζηξνθή (IPR) ή mm αλά πεξηζηξνθή 

(mm/rev). Γηα  έλα πνιχθηεξν θνπηηθφ εξγαιείν (multi-point tool) , ε πξφσζε θνπήο 
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ηζνχηαη κε ηε πξόσζε αλά δόληη zf  (feed per tooth) θαη κεηξηέηαη ζε  ίληζεο  αλά  δφληη 

(IPT)  ή  mm/δφληη, πνιιαπιαζηαζκέλε  κε  ηνλ αξηζκφ ησλ δνληηψλ ηνπ θνπηηθνχ. 

 

Παξαθάησ παξνπζηάδεηαη ε βαζηθή νξνινγία θαη δηάθνξνη ζπκβνιηζκνί θαηά ην 

θξεδάξηζκα:  

cD  : Γηάκεηξνο θνπήο (mm)        

ml   : Τπφ θαηεξγαζία κήθνο (mm)      

pa  : Βάζνο θνπήο (mm)  

ea  : Πιάηνο θνπήο (mm)  

cv  : Σαρχηεηα θνπήο (m/min)  

nz  : Αξηζκφο δνληηψλ  

zf  : Πξφσζε αλά δφληη (mm/δφληη)  

nf  : Πξφσζε αλά πεξηζηξνθή (mm/rev)  

fv   : Σαρχηεηα πξφσζεο ηξαπέδεο (mm/min)  

exh  : Μέγηζην πάρνο απνβιήηνπ (mm)  

mh  : Μέζν ζεσξεηηθφ πάρνο απνβιήηνπ (mm)  

 n   :  ηξνθέο αηξάθηνπ (RPM)  

rk  :  Βαζηθή γσλία θνπήο (degrees)   

 

Οη βαζηθέο ζρέζεηο ππνινγηζκνχ είλαη:  
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5. Κώδικαρ επγαλειομησανήρ  

Ζ παξαγσγή ηνπ θψδηθα ηεο εξγαιεηνκεραλήο είλαη ην ηειεπηαίν ζηάδην ηεο  εηθνληθήο  

δεκηνπξγίαο  ησλ  δηαθφξσλ θαηεξγαζηψλ. Σειεηψλνληαο, γηα παξάδεηγκα, ηηο  

θαηεξγαζίεο θνπήο ελφο κνληέινπ θαηεξγαζίαο, νη δηαδξνκέο ησλ εξγαιείσλ πξέπεη λα 

ελσζνχλ θαη λα κεηαθξαζηνχλ ζηνλ  θψδηθα  ηεο  εξγαιεηνκεραλήο.  Τπάξρνπλ  πνιινί  

δηαθνξεηηθνί θσδηθνπνηεηέο,  θαζψο  ππάξρνπλ  θαη πνιιέο  δηαθνξεηηθέο  

εξγαιεηνκεραλέο. Γηα  απηφ  ην  ιφγν,  πξέπεη  λα  βξεζεί  ν  ζσζηφο  θσδηθνπνηεηήο  γηα  

ηελ  θάζε εξγαιεηνκεραλή πνπ ρξεζηκνπνηείηαη. 

Ο  θψδηθαο  ηεο  εξγαιεηνκεραλήο πξέπεη λα  πεξηέρεη  ζπληεηαγκέλεο  γηα  ηελ θίλεζε  

ηνπ  εξγαιείνπ  θαη  ηνπ  θνκκαηηνχ,  φπσο  επίζεο  θαη πιεξνθνξίεο  γηα ηνλ  έιεγρν  

ησλ  ζπζηεκάησλ  ηεο  εξγαιεηνκεραλήο,  φπσο  είλαη  ε  ηαρχηεηα πεξηζηξνθήο,  ε  

ρξήζε  ηνπ  ςπθηηθνχ  πγξνχ  θαη  ε  αιιαγή  ηνπ  θνπηηθνχ εξγαιείνπ. 

Τπάξρνπλ ηξεηο δηαθνξεηηθέο πξνζεγγίζεηο ζηνλ ηξφπν ζχληαμεο θαη απνζηνιήο ελφο 

θψδηθα ζε κηα κεραλή αξηζκεηηθνχ ειέγρνπ, νη νπνίεο είλαη ε ρεηξνλαθηηθή (Manual), ε 

ειεθηξνληθά ππνβνεζνπκέλε (Computer assisted) θαη ε απηφκαηε πξνζέγγηζε. 

ηελ ρεηξνλαθηηθή, ν θψδηθαο ζπληάζζεηαη ζην ρέξη ρξεζηκνπνηψληαο ηξηγσλνκεηξηθέο 

θαη αιγεβξηθέο ζρέζεηο θαη κεηαθέξεηαη ζηελ θεληξηθή κνλάδα ηεο κεραλήο είηε απφ ην 

πιεθηξνιφγην ηεο κεραλήο είηε κέζσ θάπνηνπ άιινπ κέζνπ κεηάδνζεο φπσο δηάηξεηεο 

θάξηεο (ζε πην παιηέο κεραλέο), ζεηξηαθή ζχξα (RS232) θαη δίθηπν (Ethernet). Ζ 

δεκηνπξγία θψδηθα κε απηφλ ηνλ ηξφπν είλαη αξθεηά πνιχπινθε θαη ρξνλνβφξα, εηδηθά 

γηα πνιχπινθα θνκκάηηα θαη ηδηαίηεξα γηα απηά κε επηθάλεηεο ειεχζεξεο κνξθήο. 

Δπίζεο, κπνξνχλ εχθνια λα δεκηνπξγεζνχλ ζπληαθηηθά θαη ππνινγηζηηθά ιάζε ζην 

πξφγξακκα ή λα γίλεη ιάζνο εηζαγσγή δεδνκέλσλ ζηε κεραλή. 

χκθσλα κε ηελ ειεθηξνληθά ππνβνεζνπκέλε πξνζέγγηζε, πεξηγξάθεηαη ζε κηα γιψζζα 

πξνγξακκαηηζκνχ ε γεσκεηξία ηνπ αληηθεηκέλνπ θαζψο θαη ε επηζπκεηή πνξεία ηνπ  

θνπηηθνχ θαη κε βάζε απηά γίλεηαη απηφκαηα ε δεκηνπξγία ηνπ αξρείνπ ζέζεο  θνπηηθνχ 

(CL File – Cutter Location File). ηε ζπλέρεηα έλαο θαηάιιεια ξπζκηζκέλνο ηειηθφο 

επεμεξγαζηήο (Post-processor) αλαιακβάλεη ηελ κεηαηξνπή ηνπ αξρείνπ ζέζεο θνπηηθνχ 

ζε αξρείν κε θψδηθα πνπ αληηιακβάλεηαη ε εθάζηνηε κεραλή. Απφ εθείλν ην ζεκείν θαη 

κεηά γίλεηαη ε κεηάδνζε ηνπ αξρείνπ ζηελ κεραλή φπσο θαη ζηελ ρεηξνθίλεηε 

πξνζέγγηζε. Απηή ε πξνζέγγηζε ρξεζηκνπνηείην πξηλ ηελ αλάπηπμε ησλ ζπγρξφλσλ 

CAD/CAM ζπζηεκάησλ. 

Σέινο ζηελ απηφκαηε πξνζέγγηζε ην θνκκάηη πνπ ζέινπκε λα θαηαζθεπάζνπκε 

ζρεδηάδεηαη ζε έλα πξφγξακκα CAD θαη ζηελ ζπλέρεηα πεξηγξάθνπκε ηελ γεσκεηξία 

ηνπ, ψζηε λα δεκηνπξγεζεί απηφκαηα ε πνξεία πνπ ζα αθνινπζήζεη ην θνπηηθφ. Σα 

δεδνκέλα απηά δεκηνπξγνχλ ην αξρείν ζέζεο ηνπ θνπηηθνχ (CL File – Cutter Location 

File), ην νπνίν κε έλα θαηάιιεια ξπζκηζκέλν ηειηθφ επεμεξγαζηή κεηαηξέπεηαη ζε 

αξρείν κε θψδηθα πνπ αληηιακβάλεηαη ε εθάζηνηε κεραλή. Απφ εθείλν ην ζεκείν θαη 
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κεηά γίλεηαη ε κεηάδνζε ηνπ αξρείνπ ζηελ κεραλή φπσο θαη ζηελ ρεηξνθίλεηε 

πξνζέγγηζε. ηα ζχγρξνλα ζπζηήκαηα CAD/CAM, ηα θπξηφηεξα πξνγξάκκαηα πνπ 

ρξεζηκνπνηνχληαη είλαη CATIA – Dassault, Pro/ENGINEER – PTC, UG – Unigraphics 

solutions, I-DEAS – SCDR/ Unigraphics solutions, Solidworks – Solidworks/ Dassault, 

Inventor/ Autocad – Autodesk θαη πνιιά άιια.  

 

 

Σν αξρείνπ ζέζεο θνπηηθνχ (CL File – Cutter Location File) είλαη έλα πξφγξακκα 

θαηεξγαζίαο ηνπ αληηθεηκέλνπ, γξακκέλν ζε APT. 

Ζ APT (Automatically Programmed Tools) είλαη ε πξψηε θαη πην αληηπξνζσπεπηηθή 

γιψζζα πξνγξακκαηηζκνχ CNC. Δίλαη πξνζαλαηνιηζκέλε  ζηνλ  νξηζκφ  γεσκεηξίαο  

θαη  ιηγφηεξν  ζηε  ιχζε  ηερλνινγηθψλ  ζεκάησλ ηεο  θνπήο.  Έρεη ηελ δπλαηφηεηα  

πξνγξακκαηηζκνχ 5  αμφλσλ  θαη  έρεη επεξεάζεη  ηε  δεκηνπξγία πνιιψλ παξφκνησλ  

γισζζψλ,  φπσο NELAPT  θαη  EXAPT,  νη  νπνίεο  φκσο  θαιχπηνπλ θαη ηελ 

ηερλνινγία θνπήο, φπσο ππνινγηζκφ παζψλ (δηαδνρηθψλ πεξαζκάησλ), πξφσζεο θιπ.  

Ζ  ΑΡΣ  πεξηιακβάλεη  ηξία  είδε  εληνιψλ.  Απηέο  πνπ  νξίδνπλ  γεσκεηξία  ε  νπνία  

ζα ρξεζηκνπνηεζεί  γηα  ηνλ  θαζνξηζκφ  ηεο ηξνρηάο ηνπ εξγαιείνπ,  απηέο  πνπ  νξίδνπλ  

ηηο  θηλήζεηο  ηνπ εξγαιείνπ  θαη  απηέο   πνπ  ζπκπιεξψλνπλ  ην  πξφγξακκα  κε  ηνλ  

νξηζκφ  ηερλνινγηθψλ παξακέηξσλ (πξφσζε,  αιιαγή  εξγαιείνπ  θιπ)  αιιά  θαη  

παξακέηξσλ  δηαρείξηζεο  ηνπ πξνγξάκκαηνο. 
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Ο θψδηθαο κεραλήο είλαη ν θψδηθαο πνπ αληηιακβάλεηαη ε κεραλή. Ο θψδηθαο 

απαξηίδεηαη απφ έλα πιήζνο εληνιψλ πνπ εθηεινχλ δηαθνξέο ιεηηνπξγίεο ζηελ κεραλή. 

Οη εληνιέο είλαη ρσξηζκέλεο, αλάινγα κε ηελ ιεηηνπξγία ηνπο, ζε 7 θαηεγνξίεο. 

   Αξηζκφο πξφηαζεο (Νxxx): Γειψλεη ηνλ αξηζκφ ηνπ ζεη εληνιψλ.  

   Δληνιέο δξαζηεξηνπνίεζεο θίλεζεο (Gxx): Δίλαη νη εληνιέο πνπ δίλνπλ 

πιεξνθνξίεο γηα ην είδνο ηεο θίλεζεο πνπ ζα εθηειέζεη ην θνπηηθφ.  

   πληεηαγκέλεο (X,Y,Z, A θαη Β): Γειψλνπλ ηηο ζπληεηαγκέλεο θαη ηνλ 

πξνζαλαηνιηζκφ ηνπ θνπηηθνχ.  

   Πξφσζε (F): Γειψλνπλ ηελ ηαρχηεηα κε ηελ νπνία γίλεηαη κηα θίλεζε.  

   Σαρχηεηα πεξηζηξνθήο (S): Γειψλεη ηελ ηαρχηεηα πεξηζηξνθήο ηεο αηξάθηνπ  

   Κνπηηθφ (Σ): Γειψλεη ην θνπηηθφ πνπ ζα ρξεζηκνπνηεζεί γηα ηελ εθηέιεζε ελφο 

κπινθ εληνιψλ  

   Βνεζεηηθέο ιεηηνπξγίεο (Μ): Γειψλνπλ ηελ ελεξγνπνίεζε ή απελεξγνπνίεζε 

θάπνησλ πξνζζεηψλ ιεηηνπξγηψλ (π.ρ. ελεξγνπνίεζε ηεο αηξάθηνπ, ξνή ςπθηηθνχ θιπ) .  

Κάζε ζεη εληνιψλ απνηειείηαη θπξίσο απφ εληνιέο δξαζηεξηνπνίεζεο θίλεζεο (θψδηθεο 

G)  ή/θαη απφ βνεζεηηθέο ιεηηνπξγίεο (θψδηθεο M). ην ηέινο θάζε κπινθ εληνιψλ 

εηζάγεηαη θαη ν ραξαθηήξαο eob πνπ δειψλεη ην ηέινο ηνπ κπινθ εληνιψλ πνπ πξέπεη λα 

εθηειεζηεί. 

Οη πξνθαηαξθηηθνί θψδηθεο ιεηηνπξγίαο ή θψδηθεο G πξνεηνηκάδνπλ ηελ κεραλή έηζη 

ψζηε λα γλσξίδεη ηη λα θάλεη κε ηηο ππφινηπεο πιεξνθνξίεο. Οη βαζηθφηεξνη θψδηθεο G 

κηαο ηππηθήο θξέδαο CNC κε ζχζηεκα ειέγρνπ FANUC είλαη:  

 

G 00 Δπζχγξακκε θίλεζε κε ηαρεία πξφσζε 

G 01 Γξακκηθή παξεκβνιή 

G 02 Κπθιηθή παξεκβνιή κε ηελ θνξά ησλ δεηθηψλ ηνπ ξνινγηνχ 

G 03 Κπθιηθή παξεκβνιή αληίζεηα απφ ηελ θνξά ησλ δεηθηψλ ηνπ ξνινγηνχ 

G 04 Υξνληθά θαζνξηζκέλε αλακνλή 

G 33 Κνπή ζπεηξψκαηνο κε ζηαζεξφ βήκα 

G 40 Αθχξσζε ηεο αληηζηάζκηζεο ησλ θνπηηθψλ 

G 43 Αληηζηάζκηζε κήθνπο ηνπ θνπηηθνχ 

G 70 Πξνγξακκαηηζκφο ζε αγγινζαμνληθφ ζχζηεκα 

G 71 Πξνγξακκαηηζκφο ζε κεηξηθφ ζχζηεκα 

G 90 Απφιπην ζχζηεκα ζπληεηαγκέλσλ 

G 91 ρεηηθφ ζχζηεκα ζπληεηαγκέλσλ 
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Ζ εληνιή θψδηθα Μ ρξεζηκνπνηείηαη  γηα ηνλ έιεγρν παξαιεηπφκελσλ ιεηηνπξγηψλ, φπσο 

είλαη ε εθθίλεζε ηεο αηξάθηνπ, ε ζηάζε, ε αιιαγή θνπηηθνχ εξγαιείνπ θηι. ε θάζε 

κπινθ είλαη δπλαηφλ λα νξηζζεί κφλν κηα ιεηηνπξγία Μ. Οη ιεηηνπξγίεο M 

παξνπζηάδνληαη ζηνλ παξαθάησ πίλαθα: 

Μ 00 Γηαθνπή πξνγξάκκαηνο 

Μ 01 Πξναηξεηηθή δηαθνπή πξνγξάκκαηνο 

Μ 02 Σέινο πξνγξάκκαηνο 

Μ 03 Γεμηφζηξνθε πεξηζηξνθή ηεο αηξάθηνπ 

Μ 04 Αξηζηεξφζηξνθε πεξηζηξνθή ηεο αηξάθηνπ 

Μ 05 Γηαθνπή ιεηηνπξγίαο αηξάθηνπ 

Μ 06 Αιιαγή θνπηηθνχ 

Μ 07 Φπθηηθφ ζε κνξθή νκίριεο 

Μ 08 Φπθηηθφ ζε ξνή 

Μ 09 Γηαθνπή ςπθηηθνχ 

Μ 19 Πξνζαλαηνιηζκφο αηξάθηνπ 

Μ 30 Σέινο ηαηλίαο 

Μ 48 Παξάθακςε – αθχξσζε OFF 

Μ 49 Παξάθακςε – αθχξσζε ON 

Μ 98 Μεηαθνξά ζε ππνπξφγξακκα 

Μ 99 Μεηαθνξά ζην θχξην πξφγξακκα (ηέινο ππνπξνγξάκκαηνο) 

 

 

6. Σηάδια μελέηηρ για ππογπαμμαηιζμό CNC 

Σα ζηάδηα κειέηεο πνπ είλαη απαξαίηεην λα γίλνπλ πξηλ ηνλ πξνγξακκαηηζκφ ηεο 

θαηεξγαζίαο, πνπ πεξηγξάθηεθε πξνεγνπκέλσο, είλαη : 

 Ζ επηινγή ηεο κεραλήο (θαηάιιειε θαη επηζπκεηή κεραλή, θάζεηε ή νξηδφληηα, 

δηάθνξεο πνιπαμνληθέο θ.α.) 

 Ζ επηινγή ηνπ ηξφπνπ ζπγθξάηεζεο (πξνζδηνξηζκφο δηαζηάζεσλ ηνπ 

αθαηέξγαζηνπ θνκκαηηνχ, ζρεδηαζκφο ηδηνζθεπήο-fixture γηα ηελ θαιχηεξε 

ζπγθξάηεζή ηνπ) 

 Ο πξνζδηνξηζκφο ησλ θάζεσλ θαηεξγαζίαο (αλάινγα κε ηελ γεσκεηξία ηνπ 

θαηεξγαδφκελνπ θνκκαηηνχ, γεληθά επηζπκνχκε φζν ην δπλαηφλ ιηγφηεξεο θάζεηο 

γηα λα εμνηθνλνκήζνπκε ρξφλν θαη θφζηνο) 

 Ο πξνζδηνξηζκφο ησλ ζηαδίσλ θαηεξγαζίαο (φπσο ε πξνεξγαζία- preparation, ην 

μερφλδξηζκα- roughing, ην πξνθηλίξηζκα- semi-finish θαη ην θηλίξηζκα- finish θαη 

δεκηνπξγία ππνδνκήο ζην ππφινηπν πιηθφ γηα ηελ επφκελε θάζε θαη γεληθφο 

πξνζδηνξηζκφο θαηεξγαζηψλ)   
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II. Pro/Manufacturing 

1. Ειζαγωγή 

Σν Pro/Manufacturing απνηειεί έλα απφ ηα βαζηθά ππνζπζηήκαηα ηνπ Pro/Engineer. 

Σν ππνζχζηεκα απηφ επηηξέπεη ηε δεκηνπξγία θαη ηελ εθηέιεζε πξνγξακκάησλ γηα 

κεραλέο αξηζκεηηθνχ ειέγρνπ, ηε δεκηνπξγία πξνγξακκάησλ γηα ηελ επηζεψξεζε 

θνκκαηηψλ θαζψο θαη άιιεο ιεηηνπξγίεο πνπ ζρεηίδνληαη θαη κε άιια ππνζπζηήκαηα ηνπ 

Pro/Engineer. Πην ζπγθεθξηκέλα, ην Pro/Manufacturing δεκηνπξγεί ηα αλαγθαία 

δεδνκέλα γηα ηελ θαζνδήγεζε ηνπ εξγαιείνπ ζε κηα κεραλή αξηζκεηηθνχ ειέγρνπ, γηα 

ηελ θαηεξγαζία ελφο θνκκαηηνχ ην νπνίν έρεη ήδε κνληεινπνηεζεί ζην ινγηζκηθφ CAD 

ηνπ Pro/Engineer. Γίλεηαη αθξηβήο πξνζδηνξηζκφο ηεο δηαδηθαζίαο θαηαζθεπήο ηνπ 

θνκκαηηνχ, θαζψο ππάξρεη ε δπλαηφηεηα νξηζκνχ φισλ ησλ παξακέηξσλ θνπήο θαη 

επηινγήο ησλ θαηάιιεισλ θνπηηθψλ εξγαιείσλ θαη επίζεο, ην πην βαζηθφ, γίλεηαη 

πξνζνκνίσζε ησλ θαηεξγαζηψλ ζηνλ ππνινγηζηή. Βάζεη ηεο πξνζνκνίσζεο γίλεηαη 

έιεγρνο γηα ηπρφλ ιάζε θαη βειηηζηνπνηνχληαη νη θαηεξγαζίεο. Έπεηηα, αθνχ επηιεγεί ε 

θαηάιιειε αιιεινπρία θαηεξγαζηψλ, ην ινγηζκηθφ έρεη ηε δπλαηφηεηα λα εμάγεη ηηο 

θαηεξγαζίεο απηέο ζε κνξθή ζπκβαηνχ θψδηθα κε ηελ ζπγθεθξηκέλε κεραλή πνπ ζα 

θαηεξγαζηεί ην θνκκάηη. Ο θψδηθαο απηφο, ζηε ζπλέρεηα, κεηαθέξεηαη ζηε κεραλή κέζσ 

θαηάιιεινπ ινγηζκηθνχ, ζπλήζσο κέζσ ζχξαο RS-232. 

  
Σν Pro/Manufacturing απνηειείηαη απφ ηα παξαθάησ ππνζπζηήκαηα: 

 
 

 Pro/NC  

Σν Pro/NC είλαη ην θχξην ππνζχζηεκα ηνπ Pro/Manufacturing κε ην νπνίν 

κπνξνχκε λα δεκηνπξγήζνπκε πξνγξάκκαηα γηα κεραλέο αξηζκεηηθνχ ειέγρνπ 

(θξέδεο, ηφξλνπο, κεραλέο ειεθηξνδηάβξσζεο θ.α.) 

 Expert machinist  

Σν Expert machinist είλαη έλα ππνζχζηεκα ηνπ Pro/Manufacturing, ην νπνίν 

πξνζθέξεη έλα γξαθηθφ πεξηβάιινλ φπνπ κπνξνχλ λα δεκηνπξγεζνχλ πην εχθνια 

θαη γξήγνξα αθνινπζίεο αξηζκεηηθνχ ειέγρνπ, κε ζθνπφ ηε δεκηνπξγία 

πξνγξακκάησλ γηα θξέδεο ηξηψλ αμφλσλ. Σν πξφγξακκα απηφ παξέρεη έλα 

ζχλνιν 18 έηνηκσλ θαηεξγαζηψλ φπσο θαηεξγαζία πξνζψπνπ, πξνθίι, δηάλνημε 

θνηιφηεηαο, νπήο θαη θαλαιηνχ, φπσο θαίλεηαη ζην παξαθάησ πιαίζην: 

 

 Pro/Process  

Σν Pro/Process είλαη έλα ππνζχζηεκα ηνπ Pro/Manufacturing ζην νπνίν γίλεηαη 

ν πξνγξακκαηηζκφο ησλ θαηεξγαζηψλ γηα ηελ δεκηνπξγία ηνπ θνκκαηηνχ θαζψο 

θαη νη θάζεηο ζηηο νπνίεο ζα δεκηνπξγεζεί. 
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 Pro/CMM  

Σν Pro/CΜΜ είλαη ην ηειεπηαίν ππνζχζηεκα ηνπ Pro/Manufacturing κε ην νπνίν 

κπνξνχκε λα δεκηνπξγήζνπκε πξνγξάκκαηα γηα κεηξεηηθέο κεραλέο γηα ηελ 

επηζεψξεζε ησλ ραξαθηεξηζηηθψλ ελφο θνκκαηηνχ. 

 Pro/NC-GPost  

Σν Pro/NC-GPost είλαη ην ππνζχζηεκα εθείλν ζην νπνίν κπνξνχκε λα 

δεκηνπξγήζνπκε θαη λα ξπζκίζνπκε ηνπο ηειηθνχο επεμεξγαζηέο γηα λα 

κεηαηξέςνπκε ην αξρείν ζέζεο θνπηηθνχ ζε αξρείν θψδηθα κεραλήο.  

Κάζε θαηεξγαζία (NC Sequence) απνηειεί έλα CL Data (Cutter Location Data) 

αξρείν, ην νπνίν αληηπξνζσπεχεη ηελ ηξνρηά ηνπ θνπηηθνχ εξγαιείνπ. ηα αξρεία 

απηά πξέπεη λα γίλεη θαηάιιειε επεμεξγαζία ψζηε λα αλαγλσξίδνληαη απφ ηελ 

εξγαιεηνκεραλή. Ζ επεμεξγαζία απηή γίλεηαη, ζχκθσλα κε ηηο ξπζκίζεηο ζην 

αξρείν Post Processor File, ην νπνίν εμαξηάηαη απφ ηνλ ηχπν ηεο κεραλήο (ην 

γξαθηθφ πεξηβάιινλ δεκηνπξγίαο ηειηθνχ επεμεξγαζηή εκθαλίδεηαη απφ ηελ 

γξακκή εξγαιείσλ ηνπ Pro/Manufacturing: Applications     NC Post Processor - 

Δηθόλα ΙI.1.2). Ο Post Processor απνηειεί ηνλ ζπλδεηηθφ θξίθν ηνπ ππνινγηζηή 

κε ηελ εξγαιεηνκεραλή, αθνχ ζε απηφλ απνζηέιινληαη ηα CL Data αξρεία θαη 

απηφο κε ηε ζεηξά ηνπ δεκηνπξγεί ηνλ θαηάιιειν θψδηθα πνπ θαηαλνεί ε 

εξγαιεηνκεραλή (ζπλήζσο G θψδηθα). Δπνκέλσο, ην ζχζηεκα Pro/NC-GPost 

ρσξίδεηαη ζε δπν δηαθξηηά κέξε, ζην κέξνο πνπ αλαιακβάλεη ηελ κεηαγιψηηηζε 

ηνπ CL-File θαη ζην κέξνο πνπ πεξηιακβάλεη έλα ζχζηεκα, ην νπνίν, κέζσ ελφο 

γξαθηθνχ πεξηβάιινληνο, βνεζά ζηνλ θαζνξηζκφ ησλ ξπζκίζεσλ γηα ηελ 

εθάζηνηε κεραλή αξηζκεηηθνχ ειέγρνπ (βι. Δηθόλα ΙI.1.1). 

 

 

 Δηθόλα ΙI.1.1 
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  Δηθόλα ΙI.1.2 

  
  
  
ηε ζπλέρεηα παξνπζηάδεηαη ην ινγηθφ δηάγξακκα ξνήο γηα ην Pro/Manufacturing. 
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III. Pro/NC 

1. Ειζαγωγή  

Σν Pro/NC,  φπσο αλαθέξακε θαη πξνεγνπκέλσο, απνηειεί ην θχξην ππνζχζηεκα ηνπ 

Pro/Manufacturing γηα ηελ δεκηνπξγία πξνγξακκάησλ γηα CNC εξγαιεηνκεραλέο. 

Σν κνληέιν ζρεδίαζεο, ή αιιηψο ην ηειηθφ αληηθείκελν (Reference Model), 

αληηπξνζσπεχεη ηελ ηειηθή κνξθή ηνπ κνληέινπ, πνπ ρξεζηκνπνηείηαη σο βάζε γηα ηηο 

επηζπκεηέο θαηεξγαζίεο. Σν αληηθείκελν εξγαζίαο (πξνο θαηεξγαζία) (Workpiece) 

απνηειεί ην αθαηέξγαζην αληηθείκελν πνπ ζα θαηεξγαζηνχκε γηα λα ζρεκαηίζνπκε ην 

ηειηθφ αληηθείκελν. Σν κνληέιν θαηεξγαζίαο (Manufacturing Model) απνηειεί ηελ 

ζπλαξκνιφγεζε ησλ δπν παξαπάλσ θαη καο δίλεη κηα αλαπαξάζηαζε ηνπ αληηθεηκέλνπ, 

πξηλ θαη κεηά ηελ θαηεξγαζία. Δπίζεο, εάλ πξνζζέζνπκε ηελ γεσκεηξία ησλ θνπηηθψλ 

(Tool geometry) θαζψο θαη ην ρψξν εξγαζίαο ηεο κεραλήο (Workcell) παίξλνπκε ην 

πεξηβάιινλ θαηεξγαζίαο (Manufacturing Environment) θαη κε ηελ ηνπνζέηεζε ηνπ 

κνληέινπ θαηεξγαζίαο ζηνλ ζθηθηήξα (Fixture), ζε δεδνκέλν πεξηβάιινλ θαηεξγαζίαο, 

κπνξνχκε λα νξίζνπκε κηα ιεηηνπξγία (Operation), ε νπνία είλαη κηα ζεηξά απφ 

αθνινπζίεο αξηζκεηηθνχ ειέγρνπ (NC Sequences) πνπ δεκηνπξγνχληαη κέζα ζε έλα 

ζπγθεθξηκέλν ρψξν εξγαζίαο έρνληαο ππφςε έλα ζπγθεθξηκέλν ζχζηεκα 

ζπληεηαγκέλσλ. Οη αθνινπζίεο απηέο πεξηιακβάλνπλ ζηνηρεία ηεο γεσκεηξίαο ηνπ 

αληηθεηκέλνπ θαη θάπνηεο παξακέηξνπο νη νπνίεο νξίδνπλ ηνλ ηξφπν θίλεζεο ηνπ 

θνπηηθνχ θαη ηελ ηαρχηεηα ηνπ. 

Αθνχ νξηζηεί κηα αθνινπζία αξηζκεηηθνχ ειέγρνπ (NC Sequence) κπνξνχκε λα 

θαηαζθεπάζνπκε ην αξρείν ζέζεο ηνπ θνπηηθνχ (CL File) ψζηε λα εθηειέζνπκε κηα 

πξνζνκνίσζε θνπήο κε ην Vericut. Δάλ ε πξνζνκνίσζε δελ καο δψζεη ηα επηζπκεηά 

απνηειέζκαηα ηφηε πξέπεη λα επαλαπξνζδηνξίζνπκε θάπνηεο απφ ηηο παξακέηξνπο ή 

θάπνηα απφ ηα άιια ζηνηρεία πνπ έρνπκε δψζεη θαηά ηελ δηάξθεηα ηεο δεκηνπξγίαο ηεο 

αθνινπζίαο. Δάλ ε πξνζνκνίσζε καο δψζεη ηα επηζπκεηά απνηειέζκαηα κπνξνχκε λα 

αθαηξέζνπκε ηνλ φγθν πνπ θαηεξγαζηήθακε θαη λα ζπλερίζνπκε αλάινγα κε ην ζηάδην 

πνπ βξηζθφκαζηε ζηνλ νξηζκφ ηεο επφκελεο αθνινπζίαο ή ζηελ ηειηθή επεμεξγαζία ηνπ 

αξρείνπ ζέζεο ηνπ θνπηηθνχ. 

Ζ ηειηθή επεμεξγαζία ησλ δεδνκέλσλ (Post Process) είλαη κηα δηαδηθαζία θαηά ηελ 

δηάξθεηα ηεο νπνίαο ην αξρείν ζέζεο ηνπ θνπηηθνχ κεηαηξέπεηαη ζε αξρείν κε θψδηθα 

θαηαλνεηφ απφ ηελ κεραλή, κε βάζε ηηο ξπζκίζεηο πνπ έρνπλ γίλεη ζην γξαθηθφ 

πεξηβάιινλ ηνπ ηειηθνχ επεμεξγαζηή (Post Processor). Δάλ ην απνηέιεζκα ηεο ηειηθήο 

επεμεξγαζίαο δελ ηαηξηάδεη απφιπηα κε απηά πνπ απαηηεί ε κεραλή ηφηε 

επαλαπξνζδηνξίδνπκε ηηο ξπζκίζεηο ηνπ ηειηθνχ επεμεξγαζηή (Option File). Δάλ ε κνξθή 

θψδηθα είλαη απνδεθηή απφ ηελ κεραλή, ηφηε πξνρσξάκε ζηελ απνζηνιή ηνπ 

πξνγξάκκαηνο ζηελ κεραλή κε ηελ βνήζεηα ηεο ζχξαο RS-232. Σν πξφγξακκα 

απνζηνιήο κέζσ ηεο ζχξαο RS-232 ζα πξέπεη λα είλαη θαη απηφ ζπγρξνληζκέλν κε ηελ 
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κεραλή αξηζκεηηθνχ ειέγρνπ φζνλ αθνξά ηελ ηαρχηεηα ηεο κεηάδνζεο ησλ δεδνκέλσλ 

θαη ην κέγεζνο ησλ απνζηειιφκελσλ παθέησλ. 

 
Μφιηο απνζηαιεί ην πξφγξακκα ζηελ κεραλή, κπνξνχκε λα πξνρσξήζνπκε ζηελ 

θαηεξγαζία ηνπ θνκκαηηνχ. Δάλ ην απνηέιεζκα ηεο θαηεξγαζίαο δελ καο ηθαλνπνηεί ηφηε 

επαλαπξνζδηνξίδνπκε θάπνηα ή θάπνηεο απφ ηηο αθνινπζίεο αξηζκεηηθνχ ειέγρνπ. 
 
ια φζα πξναλαθέξζεθαλ παξνπζηάδνληαη δηαγξακκαηηθά ζην παξαθάησ ζρήκα. Οη 

βξφγρνη κε ην θίηξηλν ρξψκα εθηεινχληαη πνιιέο θνξέο ζηελ αξρή ηεο ρξήζεο ηνπ 

πξνγξάκκαηνο θαη ηεο κεραλήο, φπνπ ν ρξήζηεο κπνξεί λα ειέγρεη θαη λα γλσξίδεη ηα 

απνηειέζκαηα ησλ ξπζκίζεσλ, ρσξίο λα αλαηξέρεη ζπρλά ζηηο ξπζκίζεηο ησλ 

παξακέηξσλ. Αληίζηνηρα, ν βξφγρνο κε ην κσβ ρξψκα εθηειείηαη θπξίσο, κφλν, θαηά ηελ 

δεκηνπξγία ηνπ ηειηθνχ επεμεξγαζηή θαη κέρξη λα επηηχρνπκε ηηο επηζπκεηέο ξπζκίζεηο.  
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2. Ακολοςθίερ απιθμηηικού ελέγσος 

Οη αθνινπζίεο αξηζκεηηθνχ ειέγρνπ (NC Sequences) πνπ ρξεζηκνπνηνχληαη γηα 

θξεδάξηζκα, ρσξίδνληαη ζηηο εμήο θαηεγνξίεο: 

 Volume: αλαθέξεηαη ζε θαηεξγαζία ελφο ζπγθεθξηκέλνπ φγθνπ αλνηρηνχ ή 

θιεηζηνχ ν νπνίνο αθαηξείηαη κε δηαδνρηθά παξάιιεια πεξάζκαηα 2.5 αμφλσλ 

(παξάιιεια ζην επίπεδν επηζηξνθήο). 

 Local Mill: θαηεξγάδεηαη θάπνην φγθν, ν νπνίνο έρεη απνκείλεη απφ κηα 

πξνεγνπκέλε θαηεξγαζία. Ζ θαηεξγαζία απηή γίλεηαη ζπλήζσο κε θνπηηθφ 

κηθξφηεξεο δηακέηξνπ. πλήζσο αλαθέξεηαη ζε αθνινπζία Volume, αιιά κπνξεί 

λα αλαθέξεηαη θαη ζε κηα αθνινπζία Profile, Conventional Surface, Contour 

Surface ή κηα πξνεγνχκελε Local Milling. 

 Surface Mill: ρξεζηκνπνηείηαη γηα ηελ θαηεξγαζία θάπνηαο επηθάλεηαο κε 2.5-5 

άμνλεο. 

 Face: αλαθέξεηαη ζηελ θαηεξγαζία ηεο άλσ επηθάλεηαο ηνπ αληηθεηκέλνπ κε 

δηαδνρηθά πεξάζκαηα 2.5 αμφλσλ. Υξεζηκνπνηείηαη γηα λα „θαηεβάζεη‟ ηελ 

πξφζνςε ηνπ Workpiece κε έλα επίπεδν ή αθηηληθφ θξεδάξηζκα. 

 Profile: αλαθέξεηαη ζηελ θαηεξγαζία ελφο κέξνπο ή νιφθιεξεο ηεο πεξηθέξεηαο 

ελφο αληηθεηκέλνπ κε δηαδνρηθά πεξάζκαηα 2.5-5 αμφλσλ. Γηα εθρφλδξηζε ή 

ηειηθή απνπεξάησζε θάζεησλ ή δηαγψλησλ επηθαλεηψλ. ηηο επηιεγκέλεο 

επηθάλεηεο πξέπεη λα είλαη δπλαηή ε χπαξμε κηαο ζπλερνχο πνξείαο ηνπ θνπηηθνχ 

εξγαιείνπ. 

 Pocketing: είλαη κηα αθνινπζία πνπ έρεη σο ζθνπφ ηελ απνπεξάησζε 

θνηινηήησλ, χζηεξα απφ κηα αξρηθή εθρφλδξηζε, ή γηα απεπζείαο απνπεξάησζε. 

Ζ θνηιφηεηεο κπνξεί λα πεξηθιείνπλ νξηδφληηεο, θάζεηεο ή δηαγψληεο επηθάλεηεο. 

Οη επηιεγκέλεο επηθάλεηεο πξέπεη θαη εδψ λα επηηξέπνπλ ηελ χπαξμε κηαο 

ζπλερνχο πνξείαο ηνπ θνπηηθνχ εξγαιείνπ. 

 Trajectory: έρεη σο ζθνπφ ηελ θαηεξγαζία ηνπ φγθνπ ηνπ αληηθεηκέλνπ πνπ 

βξίζθεηαη πάλσ ζε κηα ηξνρηά πνπ έρεη νξηζζεί απφ ηνλ ρξήζηε. Τπάξρνπλ 

πνιιέο δπλαηφηεηεο θαζνξηζκνχ ηεο πνξείαο ηνπ θνπηηθνχ, επηιέγνληαο ν 

ρξήζηεο ηνλ ηξφπν κε ηνλ νπνίν ην θνπηηθφ αθνινπζεί κα θίλεζε θνπήο ή 

ζπλδένληαο καδί πνιιαπιέο θηλήζεηο θνπήο. 

 Holemaking: έρεη σο ζθνπφ ηελ δεκηνπξγία θαη θαηεξγαζία νπψλ πάλσ ζε 

θάπνηα απφ ηηο επηθάλεηεο ηνπ αληηθεηκέλνπ. Οη νπέο δεκηνπξγνχληαη 

επηιέγνληαο αξρηθά ηνλ θαηάιιειν ηχπν (δηάηξεζε-drill, πξφζνςε-face, 

δηεχξπλζε αλνίγκαηνο νπήο-countersink θηι.), ζηε ζπλέρεηα επηιέγνληαο ηηο νπέο 

θαη ηέινο, πξνζδηνξίδνληαο ηελ κέζνδν ζχλδεζεο ησλ νπψλ κεηαμχ ηνπο. 

 Thread: έρεη σο ζθνπφ ηελ δεκηνπξγία ζπεηξσκάησλ ηφζν ζε εζσηεξηθέο φζν 

θαη ζε εμσηεξηθέο θπιηλδξηθέο επηθάλεηεο. 

 Engraving: έρεη σο ζθνπφ ηελ ράξαμε. Σν θνπηηθφ εξγαιείν αθνινπζεί έλα 

πξνζρεδηαζκέλν απιάθη. 

 Plunge: έρεη δεκηνπξγεζεί γηα ηελ εθρφλδξηζε θνηινηήησλ κεγάινπ βάζνπο κε 
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δηαδνρηθά βπζίζκαηα ηνπ θνπηηθνχ κέζα ζην φγθν ηνπ θνκκαηηνχ.  

Σέινο, νη αθνινπζίεο Roughing, Re-Roughing θαη Finishing αλαθέξνληαη ζηελ 

εθρφλδξηζε ή απνπεξάησζε ζπγθεθξηκέλσλ πεξηνρψλ ηνπ αληηθεηκέλνπ κε 

θαηεξγαζία πςειψλ ηαρπηήησλ.  
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3. Δημιοςπγία μονηέλος καηεπγαζίαρ 

Σν κνληέιν θαηεξγαζίαο απνηειεί κηα ζπλαξκνιφγεζε, ε νπνία πεξηέρεη ηελ γεσκεηξία 

ηνπ ηειηθνχ αληηθεηκέλνπ θαη κπνξεί λα πεξηέρεη θαη ηελ γεσκεηξία ηνπ αξρηθνχ 

(αθαηέξγαζηνπ) αληηθεηκέλνπ (εάλ φρη κπνξνχκε λα ην δεκηνπξγήζνπκε φπσο ζα δνχκε 

παξαθάησ). Δηζάγνληαο ηελ κνξθή ηνπ αξρηθνχ αληηθεηκέλνπ ην Pro/Manufacturing 

κπνξεί λα ππνινγίζεη ηα φξηα θαζψο θαη ηηο παξακέηξνπο ηεο θαηεξγαζίαο, φπσο επίζεο 

παξέρεη ηελ δπλαηφηεηα ηεο δπλακηθήο πξνζνκνίσζε ηεο θαηεξγαζίαο κε ηελ βνήζεηα 

ηνπ πξνγξάκκαηνο Vericut. Δηζάγνληαο ην αξρηθφ αληηθείκελν επίζεο κπνξνχκε λα 

έρνπκε αλαπαξάζηαζε ηνπ πιηθνχ πνπ απνκαθξχλεηαη απφ θάζε θαηεξγαζία. 

Πξνθεηκέλνπ λα θαηαζθεπαζζεί ην κνληέιν θαηεξγαζίαο είλαη απαξαίηεην λα 

γλσξίδνπκε ηφζν ην αληηθείκελν πνπ έρνπκε ζθνπφ λα θαηαζθεπάζνπκε φζν θαη ην 

θνκκάηη αθαηέξγαζηνπ πιηθνχ απφ ην νπνίν απηφ ζα πξνέιζεη. Σν ηειηθφ θνκκάηη είλαη 

απαξαίηεην λα έρεη κνληεινπνηεζεί εθ ησλ πξνηέξσλ ζε έλα ζχζηεκα CAD, ελψ ην 

αξρηθφ θνκκάηη κπνξεί είηε λα θαηαζθεπαζζεί ζην Pro/Manufacturing γηα ζρεηηθά απιέο 

γεσκεηξίεο είηε λα κνληεινπνηεζεί φπσο ην ηειηθφ θνκκάηη γηα πην ζπλζέηεο γεσκεηξίεο 

π.ρ. ελδηάκεζα πξντφληα. 

Σν ζπγθεθξηκέλν αληηθείκελν πνπ ζέινπκε λα θαηεξγαζηνχκε είλαη έλα δνθίκην απφ 

αινπκίλην κε πάρνο 30mm, πιάηνο 120mm θαη κήθνο 120mm, φπσο θαίλεηαη ζηελ 

παξαθάησ εηθφλα. Σα γεσκεηξηθά ραξαθηεξηζηηθά ηνπ αληηθεηκέλνπ θαίλνληαη ζην 

κεραλνινγηθφ ζρέδην πνπ ππάξρεη ζηα Παξαξηήκαηα. 
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Ζ θαηαζθεπή ηνπ κνληέινπ θαηεξγαζίαο γίλεηαη σο εμήο: 
 
Δθθηλνχκε ην Pro/ENGINEER Wildfire. ηε ζπλέρεηα, απφ ηελ θαξηέια File ηνπ 

Wildfire 4 επηιέγνπκε Set Working Directory θαη εληνπίδνπκε ην θάθειν πνπ είλαη 

ηνπνζεηεκέλν ην ηειηθφ θαζψο θαη ην πξνο θαηεξγαζία θνκκάηη (αλ ππάξρεη). Απηφ 

εμαζθαιίδεη φηη φιεο νη απνζεθεχζεηο αξρείσλ πνπ ζα θάλεηε ζα γίλνληαη ζε απηφλ ην 

θάθειν πνπ νξίζαηε σο Working Directory. 

Απφ ηελ θαξηέια File επηιέγνπκε New γηα λα εκθαληζηεί ην παξάζπξν δεκηνπξγίαο ελφο 

λένπ εγγξάθνπ (Δηθόλα ΙΙΙ.3.1) επηιέγνπκε Assembly, NC Model θαη γξαθνχκε ην φλνκα 

ηνπ κνληέινπ θαηεξγαζίαο. 

 

  Δηθόλα III.3.1 

 

 

Αθνχ παηήζνπκε ΟΚ καο εκθαλίδεηαη έλα παξάζπξν ζην νπνίν καο δεηείηαη λα 

επηιέμνπκε ην ηειηθφ αληηθείκελν – Reference Model (Δηθόλα ΙΙΙ.3.2). 
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 Δηθόλα ΙΙΙ.3.2 

 

 

Δπηιέγνληαο ην αληηθείκελν πνπ ζέινπκε κεηαθεξφκαζηε απηφκαηα ζηελ ηξηζδηάζηαηε 

ζπλαξκνιφγεζε κε ην ηειηθφ αληηθείκελν (Δηθόλα ΙΙΙ.3.3). 

 

 Δηθόλα ΙΙΙ.3.3 
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Δάλ ζέινπκε λα πξνζζέζνπκε θαη ην αξρηθφ ηεκάρην (αληηθείκελν εξγαζίαο – 

Workpiece) ζα πξέπεη λα ην θάλνπκε κε έλα απφ ηνπο δπν παξαθάησ ηξφπνπο: 

1) Δάλ ην αξρηθφ θνκκάηη έρεη ήδε κνληεινπνηεζεί ζε θάπνην ζχζηεκα CAD 

επηιέγνπκε απφ ην Menu manager ηελ επηινγή Retrieve Stock θαη αθνχ 

επηιέμνπκε ην αληηθείκελν πνπ ζέινπκε ην ζπλαξκνινγνχκε κε βάζε ηα επίπεδα 

αλαθνξάο (datum planes).  

2) Δάλ ην αξρηθφ θνκκάηη δελ έρεη κνληεινπνηεζεί ζε θάπνην ζχζηεκα CAD θαη 

έρεη ζρεηηθά απιή γεσκεηξία ηφηε ην θαηαζθεπάδνπκε κέζα ζην Assembly 

επηιέγνληαο απφ ην Menu manager ηελ επηινγή Create Stock. Ζ επηινγή απηή 

καο εκθαλίδεη έλα πιαίζην ζην νπνίν ζα θαηαρσξήζνπκε ηηο ζρεηηθέο δηαζηάζεηο 

ηνπ αθαηέξγαζηνπ θνκκαηηνχ κε βάζε απηέο ηνπ ηειηθνχ (Δηθόλα ΙΙΙ.3.4). Σν 

θνκκάηη απηφ κπνξεί λα είλαη είηε πξηζκαηηθφ (rectangular workpiece) είηε 

θπιηλδξηθφ (round workpiece). Αθνχ επηιέμνπκε ην είδνο ηνπ αθαηέξγαζηνπ 

θνκκαηηνχ, εηζάγνπκε ηηο γσλίεο πνπ ζρεκαηίδεη ην αθαηέξγαζην θνκκάηη κε ην 

ηειηθφ θαη ηελ πεξίζζεηα πιηθνχ ζε θάζε δηάζηαζε.  

 

 Δηθόλα ΙΙΙ.3.4 

 

Γηα ην ζπγθεθξηκέλν κνληέιν θαηεξγαζίαο ζέηνπκε ηηο παξακέηξνπο φπσο απηέο 

θαίλνληαη ζηελ Δηθόλα ΙΙΙ.3.5. 
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 Δηθόλα ΙΙΙ.3.5 

Σειηθά, ην κνληέιν θαηεξγαζίαο ζα πεξηέρεη ην ηειηθφ αληηθείκελν ζε γθξη ρξψκα θαη ην 

αξρηθφ ηεκάρην ζε πξάζηλν εκηδηαθαλέο ρξψκα (Δηθόλα ΙΙΙ.3.6). 

 Δηθόλα ΙΙΙ.3.6 

ε πεξίπησζε αιιαγήο ησλ δηαζηάζεσλ ηνπ αξρηθνχ θνκκαηηνχ επηιέγνπκε απφ ην Menu 

Manager ην Modify Stock.  
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4. Config.pro options (επιλογέρ διάηαξηρ) 

To πεξηβάιινλ ηνπ Pro/NC δηαζέηεη θάπνηεο πνιχ ζεκαληηθέο επηινγέο δηάηαμεο 

(config.pro options), νη νπνίεο είλαη αλαγθαίν λα ξπζκηζηνχλ γηα ηε δεκηνπξγία ελφο πην 

εχρξεζηα ιεηηνπξγηθνχ πεξηβάιινληνο θαη γηα απνθπγή επαλαιεπηηθήο ξχζκηζεο 

νξηζκέλσλ παξακέηξσλ. Με απηφ ηνλ ηξφπν ην πεξηβάιινλ ηνπ γίλεηαη πην θαηαλνεηφ 

θαη ιεηηνπξγηθφ, απνθεχγνληαη ηπρφλ άζθνπα ιάζε θαηά ηελ δεκηνπξγία θαηεξγαζηψλ 

θαη εμνηθνλνκείηαη ζεκαληηθφο ρξφλνο απφ ηελ πιεπξά ηνπ ρξήζηε. 

Παξαθάησ παξνπζηάδνληαη νξηζκέλεο απφ ηηο πην ζεκαληηθέο config.pro options: 

 pro_mf_workcell_dir (δηαδξνκή φπνπ απνζεθεχνληαη νη ρψξνη εξγαζίαο)  

 pro_mf_tprm_dir  (δηαδξνκή φπνπ απνζεθεχνληαη νη παξάκεηξνη ησλ θνπηηθψλ εξγαιείσλ)  

 pro_mf_param_dir (δηαδξνκή φπνπ απνζεθεχνληαη νη παξάκεηξνη ηεο κεραλήο θαη ηα 

αξρεία θαηεξγαζίαο)  

 postpp_dir (δηαδξνκή φπνπ απνζεθεχεηαη ε βηβιηνζήθε ηνπ ηειηθνχ επεμεξγαζηή) 

 pro_library_dir (δηαδξνκή γηα ηηο πξφηππεο βηβιηνζήθεο, ζπκπεξηιακβαλνκέλεο ηεο 

βηβιηνζήθεο ησλ θνπηηθψλ εξγαιείσλ)  

 start_model_dir (δηαδξνκή γηα ηελ ηνπνζεζία ησλ αξρηθψλ κνληέισλ θαη ζρεδίσλ)  

 search_path (δηαδξνκή γηα ηπρφλ θαθέινπο πνπ πεξηέρνπλ ηα κνληέια πνπ απαηηνχληαη, 

φπσο ζθηγθηήξεο θαη ζηεξεά εξγαιεία)  

 cl_arrow_scale  (ε ηηκή 0 ζεκαίλεη φηη δελ ππάξρνπλ βέιε πνπ δείρλνπλ ηελ πνξεία ηνπ 

θνπηηθνχ εξγαιείνπ - βνεζάεη θαηά ηελ πεξηζηξνθή ηνπ κνληέινπ κε εκθαλή ηελ πνξεία ηνπ 

θνπηηθνχ) 

 rename_drawings_with_object  (ν νξηζκφο „both‟- θνηλφ- δεκηνπξγεί ηα ζρέδηα απηφκαηα 

θαηά ηε δεκηνπξγία ελφο λένπ κνληέινπ θαηεξγαζίαο - απηφκαηε ξχζκηζε θχιισλ)  

Γηα λα εκθαλίζνπκε θαη λα επεμεξγαζηνχκε ηηο επηινγέο απηέο, επηιέγνπκε Tools → 

Options θαη εκθαλίδεηαη ην παξάζπξν ηεο παξαθάησ εηθφλαο (Δηθόλα ΙΙΙ.4.1). Μεηά ηηο 

επηζπκεηέο αιιαγέο πνπ θάλνπκε, κπνξνχκε λα ηηο απνζεθεχζνπκε (Configure files)  

νξίδνληαο θάπνηα ζπγθεθξηκέλε δηαδξνκή, ψζηε λα κπνξνχκε λα ηηο αλαθηήζνπκε ζε 

θάζε άιιε πεξίπησζε, ή κπνξνχκε απιά λα ηηο ρξεζηκνπνηήζνπκε γηα ηελ ηξέρνπζα 

θαηεξγαζία. 
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 Δηθόλα ΙΙΙ.4.1 
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5.  Δημιοςπγία πεπιβάλλονηορ καηεπγαζιών 

Αθνχ έρνπκε δεκηνπξγήζεη ην κνληέιν θαηεξγαζίαο θαη έρνπκε νξίζεη ηηο επηζπκεηέο  

επηινγέο δηάηαμεο (config.pro options) κπνξνχκε λα μεθηλήζνπκε ηε δεκηνπξγία ηνπ 

πεξηβάιινληνο (Manufacturing environment) κέζα ζην νπνίν ζα γίλνπλ νη θαηεξγαζίεο, 

θαζψο θαη νη ιεηηνπξγίεο (Manufacturing operations) πνπ ζα ιακβάλνπλ ρψξα ζην 

πεξηβάιινλ απηφ. Κάζε ιεηηνπξγία πξέπεη λα πεξηέρεη ηα δεδνκέλα ηεο κεραλήο, ην 

ζχζηεκα ζπληεηαγκέλσλ κε βάζε ην νπνίν γίλνληαη νη θαηεξγαζίεο, ην επίπεδν 

επηζηξνθήο ηα θνπηηθά εξγαιεία, ηηο αθνινπζίεο αξηζκεηηθνχ ειέγρνπ θαζψο θαη ηα 

κέζα κε ηα νπνία γίλεηαη ε ζπγθξάηεζε ηνπ θνκκαηηνχ ζηελ ηξάπεδα ηεο κεραλήο. 

Γηα λα νξίζνπκε ην πεξηβάιινλ ζην νπνίν ζα γίλεη ε ζρεδίαζε θάλνπκε ηα εμήο: 

Απφ ηελ θαξηέια File επηιέγνπκε New γηα λα εκθαληζηεί ην παξάζπξν δεκηνπξγίαο ελφο 

λένπ εγγξάθνπ (Δηθόλα ΙΙΙ.5.1), επηιέγνπκε Manufacturing, NC Assembly θαη γξάθνπκε 

ην φλνκα ηνπ πεξηβάιινληνο θαηεξγαζηψλ. 

 Δηθόλα ΙΙΙ.5.1 

Αθνχ παηήζνπκε ΟΚ κεηαθεξφκαζηε ζηελ νζφλε ηξηζδηάζηαηεο ζρεδίαζεο. Σαπηφρξνλα 

εκθαλίδεηαη ζηα δεμηά ηεο νζφλεο ην Menu manager. Απηφ δεκηνπξγεί ην λέν πεξηβάιινλ 

ζην νπνίν ζα γίλνπλ νη θαηεξγαζίεο. Αξρηθά πξέπεη λα νξίζνπκε φηη νη κνλάδεο κέηξεζεο 

είλαη mm επηιέγνληαο ινηπφλ Set up → Units θαη ζην παξάζπξν πνπ καο εκθαλίδεηαη 

επηιέγνπκε ηα mmNS θαη ζηε ζπλέρεηα ζην παξάζπξν πνπ ζα εκθαληζζεί επηιέγνπκε λα 

κεηαγισηηίζνπκε ηηο απνζηάζεηο (interpret). 
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ηε ζπλέρεηα, πξέπεη λα εηζάγνπκε ην κνληέιν θαηεξγαζίαο ζην πεξηβάιινλ 

θαηεξγαζηψλ. Δπηιέγνπκε απφ ην Menu manager ηα εμήο Mfg model → Assemble → 

Gen Assem. Με απηέο ηηο επηινγέο καο εκθαλίδεηαη έλα παξάζπξν ζην νπνίν επηιέγνπκε 

ηε ζπλαξκνιφγεζε ηνπ κνληέινπ θαηεξγαζίαο πνπ έρνπκε θαηαζθεπάζεη πξνεγνπκέλσο 

θαη ηνπνζεηήζνπκε ην αληηθείκελν έηζη ψζηε λα ηαπηηζηνχλ ηα ζπζηήκαηα 

ζπληεηαγκέλσλ ηεο ζπλαξκνιφγεζεο θαη ηνπ πεξηβάιινληνο θαηεξγαζηψλ (Δηθόλα 

ΙΙΙ.5.2).  

 

 Δηθόλα ΙΙΙ.5.2 

ηε ζπλέρεηα, νξίδνπκε ην ζχζηεκα ζπληεηαγκέλσλ ηεο κεραλήο, δειαδή ην ζχζηεκα 

ζπληεηαγκέλσλ κε βάζε ην νπνίν ζα κεηξνχληαη νη απνζηάζεηο. Απηφ ην ζχζηεκα 

ζπληεηαγκέλσλ είλαη ην ζεκείν πνπ νξίδνπκε θαη σο κεδέλ ζηελ κεραλή CNC (Machine 

zero) (Δηθόλα ΙΙΙ.5.3). 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

45 

 

 Δηθόλα ΙΙΙ.5.3 

Οριζμός λειηοσργίας (Operation) 

Μηα ιεηηνπξγία (Operation) είλαη κηα ζεηξά απφ Αθνινπζίεο Αξηζκεηηθνχ Διέγρνπ (NC 

Sequences) πνπ εθηεινχληαη ζε έλα ζπγθεθξηκέλν Υψξν Δξγαζίαο (Workcell) θαη 

ρξεζηκνπνηνχλ έλα ζπγθεθξηκέλν χζηεκα πληεηαγκέλσλ (Coordinate System). 

ε κηα ιεηηνπξγία πξέπεη λα νξηζηνχλ ν Υψξνο Δξγαζίαο (Workcell), δειαδή ν ηχπνο ηεο 

κεραλήο αξηζκεηηθνχ ειέγρνπ (NC Machine), ην κέζν ζπγθξάηεζεο (ζθηγθηήξαο), ην 

ζχζηεκα ζπληεηαγκέλσλ ηεο κεραλήο (Machine Zero) θαη ε επηθάλεηα επηζηξνθήο ηνπ 

θνπηηθνχ εξγαιείνπ. 

Πξνρσξάκε ζνλ νξηζκφ κηαο λέαο ιεηηνπξγίαο, επηιέγνληαο Mfg Setup → Operation 

(ζηελ πεξίπησζε πνπ ε ιεηηνπξγία είλαη ε πξψηε πνπ δεκηνπξγείηαη, ην παξάζπξν ηεο 

λέαο ιεηηνπξγίαο εκθαλίδεηαη απηφκαηα κε ηελ επηινγή ηνπ Mfg Setup) θαη ην παξάζπξν 

νξηζκνχ λέαο ιεηηνπξγίαο εκθαλίδεηαη (Δηθόλα ΙΙΙ.5.4).  
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 Δηθόλα ΙΙΙ.5.4 

 

i. Γημιοσργία μητανής αριθμηηικού ελέγτοσ 

 

Σν πξψην βήκα ζηνλ νξηζκφ ηεο λέαο ιεηηνπξγίαο είλαη ε επηινγή ή δεκηνπξγία κηαο 

λέαο κεραλήο αξηζκεηηθνχ ειέγρνπ (NC Machine). 

Με ην εηθνλίδην  εκθαλίδεηαη ην παξάζπξν νξηζκνχ κηαο κεραλήο αξηζκεηηθνχ 

ειέγρνπ (Δηθόλα ΙΙΙ.5.5), ζην νπνίν εηζάγνπκε ην φλνκα ηεο κεραλήο, ην είδνο θαη ηνπο 

άμνλεο. Βάζεη ηνπ είδνπο ηεο κεραλήο, επηιέγνληαη θαη νη άμνλεο. πγθεθξηκέλα γηα 

θξέδα (Mill) : 3-5 άμνλεο, γηα ηφξλν (Lathe) : 1 ή 2 εξγαιεηνθνξεία, γηα θξέδα/ηφξλν 

(Mill/ Lathe) :   2-5 άμνλεο θαη γηα ειεθηξνδηάβξσζε (Wedm) : 2 ή 4 άμνλεο. Δπηπιένλ, 

γηα ηηο επηινγέο ηφξλν θαη θξέδα/ηφξλν εηζάγεηαη θαη ν πξνζαλαηνιηζκφο ηεο κεραλήο 

(νξηδφληηα/θάζεηε). Αθφκα, κπνξνχλ λα εηζαρζνχλ πξναηξεηηθά ην είδνο ηνπ ειεγθηή 

(CNC Control) ηεο κεραλήο θαζψο θαη ε ηνπνζεζία ηνπ (Location). 
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 Δηθόλα ΙΙΙ.5.5 

ην παξάζπξν απηφ εκθαλίδνληαη νη παξαθάησ θαξηέιεο: 

-Output: φπνπ εηζάγνληαη πιεξνθνξίεο γηα ηα αξρεία ζέζεο θνπηηθνχ (CL files – 

Cutter Location files), ηνλ ηειηθφ επεμεξγαζηή (Post-Processor) θαη γηα ηα ζρφιηα πνπ 

ζέινπκε λα εηζαρζνχλ ζην αξρείν ζέζεο ηνπ θνπηηθνχ απφ ην ζχζηεκα (PPrint). 

-Spindle: φπνπ εηζάγνληαη ε κέγηζηε δπλαηή ηαρχηεηα πεξηζηξνθήο ηεο αηξάθηνπ (ζε 

RPM), πνπ πεξηνξίδεη ηηο ηπρφλ ιάζνο ηαρχηεηεο πεξηζηξνθήο ζε θάπνηα αθνινπζία 

αξηζκεηηθνχ ειέγρνπ, θαη ε ηππνδχλακε ηεο κεραλήο (Horsepower). 

-Feed: φπνπ εηζάγνληαη νη κνλάδεο κέηξεζεο ηεο πξφσζεο θαη ην φξην ηεο ηαρχηεηαο 

θίλεζεο κε ηαρεία πξφσζε. Οη κνλάδεο κέηξεζεο ηεο πξφσζεο είλαη είηε IPM (inches per 

minute) είηε MMPM (millimetres per minute) θηι. 

-Cutting tools: φπνπ εηζάγνληαη ν ρξφλνο αιιαγήο ηνπ θάζε θνπηηθνχ θαη ηα εξγαιεία 

γηα θάζε κηα απφ ηηο θεθαιέο (δχν θεθαιέο έρνπλ νη ηφξλνη 2 εξγαιεηνθνξείσλ θαη νη 

θξέδεο/ηφξλνη 4 θαη 5 αμφλσλ, ελψ νη ππφινηπνη ηχπνη κεραλψλ έρνπλ 1 θεθαιή). Σα 

θνπηηθά εξγαιεία κπνξνχλ λα ηξνπνπνηεζνχλ θαη ζε κεηαγελέζηεξν ζηάδην. 

-Travel: φπνπ εηζάγνληαη ηα φξηα ηνπ ρψξνπ εξγαζίαο ζε θάζε άμνλα κε βάζε ην 

ζχζηεκα ζπληεηαγκέλσλ ηεο κεραλήο. Αλ θαηά ηελ δηάξθεηα κηαο αθνινπζίαο ην φξην 

απηφ παξαβηαζηεί ηφηε εκθαλίδεηαη κήλπκα ζηελ νζφλε ην νπνίν πξνεηδνπνηεί γηα ηελ 

παξαβίαζε. 
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-Custom circles: φπνπ κπνξνχλ λα εηζαρζνχλ θχθινη θαηεξγαζίαο γηα ηελ δεκηνπξγία 

δηαηξήζεσλ (Holemaking).  

-Comments: φπνπ εηζάγνληαη ηπρφλ ζρφιηα πνπ ζρεηίδνληαη κε ηελ κεραλή. 

ηελ δηθηά καο πεξίπησζε, εηζάγνπκε ην φλνκα ηεο κεραλήο, ην είδνο ηεο (θξέδα ηξηψλ 

αμφλσλ). Δπηιέγνπκε πνηεο πιεξνθνξίεο ζέινπκε λα εμάγνληαη ζην αξρείν CL παηψληαο 

PPrint → Create θαη επηιέγνληαο πξψηα πνηεο πιεξνθνξίεο επηζπκνχκε (Δηθόλα ΙΙΙ.5.6) 

θαη ζηελ ζπλέρεηα ΟΚ θαη DONE (νη ξπζκίζεηο απηέο απνζεθεχνληαη ζην ζπγθεθξηκέλν 

ρψξν εξγαζίαο). Οξίδνπκε σο πξνεπηιεγκέλν ηειηθφ επεμεξγαζηή (UNCX01 XX) ηελ 

κέγηζηε ηαρχηεηα πεξηζηξνθήο (ζε rpm), ηηο κνλάδεο πξφσζεο ζε MMPM, θαη ηελ 

ηαρεία πξφσζε ζε mmpm. Σέινο νξίδνπκε ηνλ ρξφλν αιιαγήο ηνπ θνπηηθνχ ζε sec φπσο 

επηζπκνχκε. Σα θνπηηθά εξγαιεία ζα ηα νξίζνπκε ζηελ ζπλέρεηα. Αθνχ εηζάγνπκε ηα 

δεδνκέλα πηέδνπκε ΟΚ θαη επηζηξέθνπκε ζην παξάζπξν δεκηνπξγίαο λέαο ιεηηνπξγίαο. 

 

 Δηθόλα ΙΙΙ.5.6 

 

Υξήζηκε ζπκβνπιή 

Μηα πνιχ ζεκαληηθή ζπκβνπιή είλαη ε απνζήθεπζε θαη ε επαλαρξεζηκνπνίεζε ησλ 

Υψξσλ Δξγαζίαο (workcells).  

Με απηφλ ηνλ ηξφπν, κπνξνχκε εχθνια λα αλαθηήζνπκε ηνλ ήδε δεκηνπξγεκέλν ρψξν 

εξγαζίαο πνπ πξφθεηηαη γηα κηα θξέδα 3 αμφλσλ θαη νλνκάδεηαη "MACH01", θάζε θνξά 

πνπ μεθηλάκε έλα λέν πξφγξακκα. 
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Γηα λα απνζεθεχζνπκε ην ρψξν εξγαζίαο πνπ έρνπκε δεκηνπξγήζεη, επηιέγνπκε File → 

Save ζην παξάζπξν νξηζκνχ ηεο κεραλήο αξηζκεηηθνχ ειέγρνπ (Δηθόλα ΙΙΙ.5.5) θαη έηζη 

απνζεθεχεηαη σο έλα αξρείν *.gph ζην pro_mf_workcell_dir θάθειν (φπσο έρνπκε 

νξίζεη, ζηηο επηινγέο δηάηαμεο - config.pro options)  

πκβνπιή: Όηαλ δεκηνπξγνύκε έλα ρώξν εξγαζίαο, θαη επηιέγνπκε  “Defaults”, καο 

επηηξέπεηαη λα επηιέμνπκε έλα πξνεπηιεγκέλν αξρείν θαηεξγαζίαο γηα λα ρξεζηκνπνηνύκε 

κε απηό ηνλ ρώξν εξγαζίαο. Σν ηξέρσλ ζπλαθέο αξρείν θαηεξγαζίαο ζα απνζεθεπηεί ζην 

ρώξν εξγαζίαο. 

πκβνπιή: Δίλαη επίζεο κηα θαιή ηδέα λα δεκηνπξγνύκε ή λα κπνξνύκε λα αλαθηήζνπκε 

θάζε πξόηππν εξγαιείν θνπήο πνπ έρεη θνξησζεί ζηε κεραλή (πεξηζζόηεξα γηα εξγαιεία 

θνπήο ζην ππνθεθάιαην „Γεκηνπξγία θνπηηθώλ εξγαιείσλ‟). Σα θνπηηθά εξγαιεία πνπ 

έρνπλ νξηζηεί κε κηα ζπγθεθξηκέλε κεραλή, παξακέλνπλ ζε απηή όηαλ απνζεθεύνληαη.  

 

ii. Γημιοσργία μέζοσ ζσγκράηηζης 

 

ηε ζπλέρεηα, πξέπεη λα ηνπνζεηήζνπκε ην κέζν ζπγθξάηεζεο ηνπ αθαηέξγαζηνπ 

θνκκαηηνχ. Δπηιέγνπκε ην εηθνλίδην  θαη εκθαλίδεηαη απηνκάησο ην παξάζπξν 

νξηζκνχ ηνπ ζθηγθηήξα (Δηθόλα ΙΙΙ.5.7) 

 Δηθόλα ΙΙΙ.5.7 

ην παξάζπξν απηφ επηιέγνπκε ην „+‟ γηα λα εηζάγνπκε σο ζθηθηήξα έλα ήδε 

κνληεινπνηεκέλν αληηθείκελν (εάλ ζέινπκε κπνξνχκε λα θαηαζθεπάζνπκε θαη ζε απηφ 

ην πεξηβάιινλ έλα ζθηθηήξα). Σν κνληέιν πνπ ζα εηζάγνπκε πξέπεη λα είλαη 

απνζεθεπκέλν ζην ίδην θάθειν κε ηα αληηθείκελα πξηλ θαη κεηά ηελ θαηεξγαζία. 
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Ο ζθηγθηήξαο (Δηθόλα ΙΙΙ.5.8) πνπ έρνπκε ήδε κνληεινπνηήζεη είλαη ν αθφινπζνο: 

 Δηθόλα ΙΙΙ.5.8 

Αθνχ επηιέμνπκε, ινηπφλ, ηνλ ζθηγθηήξα καο, κεηαθεξφκαζηε ζηελ ηξηζδηάζηαηε 

απεηθφληζε θαη ζπλαξκνινγνχκε ην αθαηέξγαζην θνκκάηη κε ηνλ ζθηθηήξα, θαηά ηνλ 

επηζπκεηφ ηξφπν. Ζ ζπλνιηθή ζπλαξκνιφγεζε θαίλεηαη ζηελ Δηθόλα ΙΙΙ.5.9. 

  

 Δηθόλα ΙΙΙ.5.9 
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ηε ζπλέρεηα πξέπεη λα νξίζνπκε ην ζχζηεκα ζπληεηαγκέλσλ ηεο κεραλήο (Machine 

Zero) 

 επηιέγνληαο ην ζχζηεκα πνπ έρνπκε 

δεκηνπξγήζεη (Δηθόλα ΙΙΙ.5.3) ή ην δεκηνπξγνχκε απηή ηελ ζηηγκή. 

Σέινο, νξίδνπκε ηελ επηθάλεηα επηζηξνθήο ηνπ θνπηηθνχ, 

 δεκηνπξγψληαο έλα λέν datum plane, ή 

επηιέγνληαο έλα ήδε ππάξρνλ, ή δεκηνπξγψληαο κηα επηθάλεηα, ή ηέινο νξίδνληαο ηελ 

απφζηαζε σο πξνο ηνλ Ε άμνλα κε θνξά πξνο ηα ζεηηθά Ε. Γεκηνπξγνχκε, ινηπφλ, έλα  

plane νξίδνληαο απφζηαζε ίζε κε 5 mm ζεηηθά πξνο ηνλ Ε άμνλα. 

Δπηιέγνληαο OK νινθιεξψλνπκε ηε δεκηνπξγία ηεο λέαο ιεηηνπξγίαο θαη 

κεηαθεξφκαζηε ζηελ ηξηζδηάζηαηε ζρεδίαζε. 

 

iii.   Γημιοσργία κοπηικών εργαλείφν 

Ζ γεσκεηξία ησλ θνπηηθψλ παίδεη πξσηεχνληα ξνιφ ζηνλ νξηζκφ ησλ αθνινπζηψλ 

αξηζκεηηθνχ ειέγρνπ. Σα θνπηηθά εξγαιεία πξέπεη λα έρνπλ νξηζηεί θαηάιιεια γηα θάζε 

θαηεξγαζία.  

Γηα λα εκθαλίζνπκε ην παξάζπξν δεκηνπξγίαο θνπηηθψλ εξγαιείσλ (Δηθόλα ΙΙΙ.5.10) 

επηιέγνπκε απφ ην Menu Manager → Mfg Setup → Tooling θαη επηιέγνπκε ην ρψξν 

εξγαζίαο (NC Workcell) πνπ έρνπκε δεκηνπξγήζεη, φπσο πεξηγξάθεηαη πην πάλσ, ή απιά 

επηιέγνληαο ην εηθνλίδην  απφ ηελ γξακκή εξγαιείσλ. 

Δηθόλα ΙΙΙ.5.10 
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Γηα λα δεκηνπξγήζνπκε έλα λέν θνπηηθφ εξγαιείν επηιέγνπκε File → New. Με απηφλ 

ηνλ ηξφπν εκθαλίδεηαη έλα λέν θνπηηθφ εξγαιείν. Δηζάγνπκε ζην πεδίν Name έλα φλνκα 

γηα ην θνπηηθφ κε ην νπνίν ζα εκθαλίδεηαη ζηηο θαηεξγαζίεο, ην είδνο ηεο θαηεξγαζίαο 

πνπ εθηειεί, ην πιηθφ θαηαζθεπέο ηνπ (πξναηξεηηθά) θαη ηηο κνλάδεο ζηηο νπνίεο είλαη νη 

δηαζηάζεηο ηνπ θνπηηθνχ. Αθνχ ην θάλνπκε απηφ εηζάγνπκε ηελ γεσκεηξία ηνπ 

θνπηηθνχ, κε έλα απφ ηνπο ηξεηο ηξφπνπο πνπ αλαθέξνληαη παξαθάησ θαη ζηελ ζπλέρεηα 

εηζάγνπκε ηηο ξπζκίζεηο ηνπ θνπηηθνχ, ηηο αληνρέο ηνπ φζνλ αθνξά ηηο πξνψζεηο θαη ηηο 

ηαρχηεηεο πεξηζηξνθήο. 

Ο νξηζκφο ηεο γεσκεηξίαο ησλ θνπηηθψλ κπνξεί λα γίλεη κε ηξεηο ηξφπνπο: 

• Με ηξνπνπνίεζε ησλ έηνηκσλ ζρεδίσλ ησλ θνπηηθψλ εξγαιείσλ 

Σν Pro/Manufacturing παξέρεη 23 έηνηκα πξφηππα θνπηηθψλ γηα θάζε ηχπν 

θαηεξγαζίαο(Taper Mill, Tapping, Boring Bar, Corner Rounding, Milling, Drilling 

θηι.). 

Δπηιέγνληαο έλα απφ απηά θαη 

δηακνξθψλνληαο θαηάιιεια ηηο 

δηαζηάζεηο ηνπ, κπνξνχκε λα πάξνπκε ην 

εξγαιείν πνπ επηζπκνχκε.  

 

 

ε θάζε ηχπν εξγαιείνπ ππάξρεη έλα ζχλνιν παξακέηξσλ νη νπνίεο πξέπεη λα 

ξπζκηζηνχλ. Οη θπξηφηεξεο απφ απηέο είλαη ε δηάκεηξνο ηνπ θνπηηθνχ εξγαιείνπ 

(Cutter_Diam), ην κήθνο ηνπ (Length), ε αθηίλα θακππιφηεηαο ηνπ (Corner Radius), 

ε γσληά ηνπ θνπηηθνχ (Side Angle), ε γσλία ηεο αθκήο ηνπ θνπηηθνχ (Point Angle) 

θαη ν αξηζκφο ησλ δνληηψλ ηνπ θνπηηθνχ (Number of flutes) (Δηθόλα ΙΙΙ.5.11). 

    Δηθόλα ΙΙΙ.5.11 

 

ην ΠΑΡΑΡΣΖΜΑ 1 παξνπζηάδνληαη δηάθνξνη ηχπνη εξγαιείσλ, θαζψο θαη νη 

βαζηθέο ηνπο παξάκεηξνη. 
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• Με ζρεδίαζε ηνπ θνπηηθνχ ζε δπν δηαζηάζεηο (πξνθίι) 

Γηα λα ζρεδηάζνπκε ην θνπηηθφ επηιέγνπκε ζην παξάζπξν ηνπ Tools Setup → Edit 

→ Sketch θαη εκθαλίδεηαη ην παξαθάησ παξάζπξν, φπνπ κε ην Sketcher 

κεηαθεξφκαζηε ζην πεξηβάιινλ δηζδηάζηαηεο ζρεδίαζεο. 

 

ηελ δηζδηάζηαηε ζρεδίαζε ζρεδηάδνπκε ην δεμί κηζφ ηεο ηνκήο ηνπ θνπηηθνχ. Σν 

ηκήκα απηφ πξέπεη λα είλαη δεμηά (θαη κφλν) ηνπ άμνλα ζπκκεηξίαο, ν νπνίνο είλαη 

θαηαθφξπθνο θαη θπζηθά λα είλαη έλα θιεηζηφ ζρήκα.  

 

• Με αλαδήηεζε ελφο ήδε ζρεδηαζκέλνπ αληηθεηκέλνπ ή ζπλαξκνιφγεζε ζε έλα 

πξφγξακκα ηξηζδηάζηαηεο κνληεινπνίεζεο (*.prt  ή *.asm), επηιέγνληαο File → 

Open Tool Library.  

Σν ζρεδηαζκέλν εξγαιείν γηα λα κπνξνχκε λα ην εηζάγνπκε ζα πξέπεη λα είλαη 

ζρεδηαζκέλν έηζη ψζηε νη δηαζηάζεηο θαη νη παξάκεηξνη πνπ απαηηνχληαη γηα ηνλ 

πιήξε νξηζκφ ηνπ θνπηηθνχ λα έρνπλ εηζαρζεί κε ην φλνκα ηνπο ζηελ ζρεδίαζε ηνπ 

θαη ην ζχζηεκα ζπληεηαγκέλσλ ηνπ θνπηηθνχ λα έρεη φλνκα TIP θαη ν άμνλαο z λα 

ηαπηίδεηαη κε ηνλ άμνλα πεξηζηξνθήο κε ηα ζεηηθά πξνο ην εζσηεξηθφ ηνπ 

εξγαιείνπ. Έλα ηέηνην θνπηηθφ παξνπζηάδεηαη ζηελ επφκελε εηθφλα (Δηθόλα 

ΙΙΙ.5.12): 

 Δηθόλα ΙΙΙ.5.12 
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Ρπζκίζεηο ηνπ θνπηηθνύ 

ηελ θαξηέια Settings (Δηθόλα ΙΙΙ.5.13) εηζάγνληαη ν αξηζκφο ηνπ θνπηηθνχ (Tool 

Number), πνπ είλαη ν αξηζκφο πνπ ζα εμαρζεί ζηηο αιιαγέο ησλ θνπηηθψλ, ην κέηξν ηνπ 

κήθνπο ηνπ θνπηηθνχ ζηνπο άμνλεο X θαη Z (Gauge z , x Length) θαζψο θαη ηπρφλ ζρφιηα 

γηα ην εξγαιείν (Comments). Σέινο ζε απηή ηελ θαξηέια θαηαρσξείηαη ην αλ ην θνπηηθφ 

είλαη καθξχ (long tool) έηζη ψζηε εάλ ρξεζηκνπνηνχληαη πεξηζηξνθηθνί άμνλεο, ην 

εξγαιείν λα απνκαθξπλζεί ζε κηα ζέζε αζθαιείαο. 

 Δηθόλα ΙΙΙ.5.13 

 

Όξηα πεξηζηξνθήο θαη πξόσζεο 

ηελ θαξηέια Cut Data (Δηθόλα ΙΙΙ.5.14) εηζάγνληαη ηα φξηα κέζα ζηα νπνία πξέπεη λα 

θηλείηαη ην θνπηηθφ. Δάλ ηα ππεξβεί ηφηε εκθαλίδεηαη κήλπκα ιάζνπο (απηέο ε επηινγέο 

εθαξκφδνληαη κφλν εάλ έρνπλ εηζαρζεί ηα πιηθά ηφζν ηνπ πξνο θαηεξγαζία θνκκαηηνχ 

φζν θαη ηνπ θνπηηθνχ εξγαιείνπ). 

 Δηθόλα ΙΙΙ.5.14 
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Βηβιηνζήθε θνπηηθώλ εξγαιείσλ 

Έλαο ρξήζηκνο ηξφπνο γηα λα κελ δεκηνπξγνχκε θάζε θνξά θνπηηθά εξγαιεία είλαη λα 

δεκηνπξγήζνπκε κηα βηβιηνζήθε θνπηηθψλ εξγαιείσλ θαη λα ηα αλαδεηνχκε απφ εθεί. 

Γηα λα πξνζζέζνπκε έλα εξγαιείν ζηε βηβιηνζήθε εθηεινχκε ηα παξαθάησ:  

 Δπηιέγνπκε απφ ην Menu Manager →Mfg Setup→ Tooling→ επηιέγνπκε έλα ρψξν 

εξγαζίαο πνπ έρνπκε πξψηα δεκηνπξγήζεη (workcell).  

 Γίλνπκε φλνκα (Name) ζε θάζε εξγαιείν θαη νξίδνπκε  ηηο παξακέηξνπο, ηα ζρφιηα, 

θ.ιπ., φπσο απαηηείηαη, θαη ηελ γεσκεηξία ηνπ κε έλαλ απφ ηνπο 3 παξαπάλσ ηξφπνπο 

πνπ αλαπηχμακε.  

 Απνζεθεχνπκε ην εξγαιείν (απνζεθεχνληαη ζην pro_mf_tprm_dir). Σα 

απνζεθεπκέλα εξγαιεία κπνξνχλ λα αλαθιεζνχλ αλά πάζα ζηηγκή ζε άιιεο κεραλέο.  

 Γηα λα αλαθηήζνπκε έλα απνζεθεπκέλν εξγαιείν (Tool parameter files : *.xml, 

*.tpm, *.tprm) επηιέγνπκε File → Open Parameter File ή απιά Open . 
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iv.   Σσνδσαζμός σλικών καηεργαζίας με κοπηικά εργαλεία 

Μηα ζεκαληηθή θαη ρξήζηκε ηερληθή είλαη ε ζπζρέηηζε ησλ παξακέηξσλ κε ηα θνπηηθά 

εξγαιεία θαη ηα πιηθά ησλ αληηθεηκέλσλ θαηεξγαζίαο. Μπνξνχκε εχθνια λα νξίζνπκε 

θαη λα επαλαρξεζηκνπνηήζνπκε ηα πιηθά ησλ δεδνκέλσλ θνπήο κε ηα θνπηηθά εξγαιεία. 

Έηζη ζα έρνπκε ην θαηάιιειν εξγαιείν γηα ην θάζε πιηθφ ηνπ αληηθεηκέλνπ θαηεξγαζίαο.  

Μπνξνχκε λα νξίζνπκε ηα πιηθά καο, δεκηνπξγψληαο κηα δνκή θαθέινπ, σο εμήο: 

ην αξρείν θαθέινπ pro_mf_tprm_dir, δεκηνπξγνχκε έλα θάθειν κε ην φλνκα 

„materials‟ (πιηθά) θαη ζε απηφλ ηνλ θάθειν δεκηνπξγνχκε έλα θάθειν γηα ην θάζε ηχπν 

πιηθνχ. Απφ ην Tool Manager ηνπ Pro/NC, επηιέγνπκε έλα θνπηηθφ (είηε  δεκηνπξγία 

λένπ είηε αλαδήηεζε) θαη ζηελ θαξηέια Cut Data (θαξηέια γηα Speeds & Feeds) 

επηιέγνπκε ην πιηθφ (Δηθόλα ΙΙΙ.5.15) θαη ζηε ζπλέρεηα πξνζζέηνπκε ηα δεδνκέλα θαη ηηο 

ζπλζήθεο θνπήο ζην εξγαιείν απηφ (roughing ή Finishing, φξηα πεξηζηξνθήο θαη 

πξφσζεο). Αθνχ θάλνπκε φιεο ηηο απαξαίηεηεο ξπζκίζεηο απνζεθεχνπκε ην εξγαιείν θαη 

επαλαιακβάλνπκε φιε απηήλ ηελ δηαδηθαζία γηα θάζε επηζπκεηφ πιηθφ. 

 Δηθόλα ΙΙΙ.5.15 
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ε κηα αθνινπζία (NC sequence) 

Γηα λα ρξεζηκνπνηήζνπκε απηέο ηηο παξακέηξνπο ζε κηα αθνινπζία (NC sequence), 

επηιέγνπκε κία απφ ηηο αθφινπζεο κεζφδνπο:  (είλαη θαιύηεξν λα πξνζδηνξίζνπκε πξώηα 

ην πιηθό ζε κηα ιεηηνπξγία)  

 ην Parameter Tree ζε κηα αθνινπζία αξηζκεηηθνχ ειέγρνπ (NC sequence), 

επηιέγνπκε Edit → Copy From Tool → All / Spindle / Feed / Depth , 

Roughing/Finishing – (ε ηαρχηεηα, ε πξφσζε θαη ην θνπηηθφ βάζνο, γηα ην 

ζπγθεθξηκέλν πιηθφ, ζα δηαβαζηνχλ απφ ην αξρείν θνπηηθνχ)  

 Ή ρξεζηκνπνηνχκε ζρέζεηο ζηηο παξακέηξνπο γηα λα αλαθηήζνπκε ηα δεδνκέλα 

θνπήο. Σα νλφκαηα ησλ παξακέηξσλ πνπ ρξεζηκνπνηνχληαη ζηηο ζρέζεηο θαίλνληαη 

ζηνλ πίλαθα πνπ αθνινπζεί.  

Ζ ρξήζε ησλ ζρέζεσλ ηζρχεη γηα κεκνλσκέλα αξρεία παξακέηξσλ, θαζψο επίζεο θαη γηα 

αξρεία θαηεξγαζίαο, γεγνλφο πνπ ην θαζηζηά απηφ κηα πνιχ ηζρπξή ηερληθή. Γηα 

παξάδεηγκα, εάλ ζην ελεξγφ αξρείν ε επηινγή STEP_DEPTH έρεη νξηζηεί ζε 

TOOL_ROUGH_AXIAL_DEPTH, ηφηε ην STEP_DEPTH ζα νξίδεηαη πάληα κε απηή 

ηελ έλδεημε (κε ηελ πξνυπφζεζε φηη ην εξγαιείν πεξηέρεη πιεξνθνξίεο γηα ην πιηθφ).  

Cutting Data  Roughing Roughing  Finishing Finishing  

Speed (rpm)  TOOL_ ROUGH_SPINDLE_RPM TOOL_ FINISH_SPINDLE_RPM  

Speed (length/min.)  TOOL_ROUGH_SURFACE_SPEED TOOL_FINISH_SURFACE_SPEED  

Feed (/min.)  TOOL_ ROUGH_FEED_RATE TOOL_ FINISH_FEED_RATE  

Feed (/tooth, eg ipr)  TOOL_ROUGH_FEED_PER_UNIT TOOL_FINISH_FEED_PER_UNIT  

Axial Depth  TOOL_ROUGH_AXIAL_DEPTH TOOL_FINISH_AXIAL_DEPTH  

Radial Depth  TOOL_ROUGH_RADIAL_DEPTH TOOL_FINISH_RADIAL_DEPTH  
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6. Ππόηςπο μονηέλο καηεπγαζίαρ 

Ο πην γξήγνξνο ηξφπνο γηα λα μεθηλήζνπκε κηα λέα θαηεξγαζία/πξνγξακκαηηζκφ είλαη 

λα ρξεζηκνπνηήζνπκε έλα θαηαζθεπαζηηθφ πξφηππν (ε δεκηνπξγία ηέηνησλ πξνηχπσλ 

είλαη δηαζέζηκε ζην Wildfire 2.0 θαη άλσ). Μπνξνχκε λα δεκηνπξγήζνπκε θαη λα 

ρξεζηκνπνηήζνπκε φζα πξφηππα επηζπκνχκε, ηα νπνία είλαη επίζεο γλσζηά θαη σο start 

models. Μπνξνχκε, γηα παξάδεηγκα, λα έρνπκε έλα δηαθνξεηηθφ πξφηππν γηα θάζε 

κεραλή, ή αθφκε θαη γηα θάζε πιηθφ ή αληηθείκελν.  

Γηα λα δεκηνπξγήζνπκε έλα πξφηππν (template) πξέπεη λα εθηειέζνπκε νξηζκέλα 

βήκαηα (ζηελ πξαγκαηηθφηεηα κφλν ην πξψην θαη ην ηειεπηαίν βήκα απαηηνχληαη, 

σζηφζν φζν πεξηζζφηεξα ζηνηρεία ζπκπεξηιάβνπκε ζην πξφηππν, ηφζν πην ηζρπξφ θαη 

νινθιεξσκέλν ζα γίλεη ην κνληέιν καο). Σα απαηηνχκελα βήκαηα είλαη: 

1) Αξρηθά, δεκηνπξγνχκε έλα λέν κνληέιν θαηεξγαζίαο (manufacturing model) θαη ηνπ 

δίλνπκε έλα επηζπκεηφ φλνκα. (πκβνπιή: είλαη θαιχηεξν λα ρξεζηκνπνηήζνπκε ην 

πξνεπηιεγκέλν κνληέιν θαηεξγαζίαο (default mfg start model) γηα λα απνθχγνπκε ην 

βήκα 3 πνπ παξνπζηάδεηαη παξαθάησ)  

2) ηε ζπλέρεηα νξίδνπκε ηηο κνλάδεο (Setup →  Units). Δπηιέγνπκε ηα mmNS θαη ζηε 

ζπλέρεηα ζην παξάζπξν πνπ ζα εκθαληζζεί επηιέγνπκε λα κεηαγισηηίζνπκε ηηο 

απνζηάζεηο (interpret). 

3) Γεκηνπξγνχκε έλαλ πξνεπηιεγκέλν ζχζηεκα ζπληεηαγκέλσλ θαη επηπέδσλ (datum 

planes), εάλ είλαη απαξαίηεην. 

4) Γεκηνπξγνχκε layers γηα λα θξχςνπκε αληηθείκελα φπσο datum planes θαη 

απνζεθεχνπκε ηελ ηξέρνπζα θαηάζηαζε. 

5) Οξίδνπκε φςεηο φπσο επηζπκνχκε (γηα παξάδεηγκα, κηα φςε XZ γηα έλα ηφξλν ή top, 

front, θαη πιάγηεο φςεηο γηα κηα θξέδα ή γεληθά κηα φςε γηα θάζε ιεηηνπξγία)  

6) ηε ζπλέρεηα δεκηνπξγνχκε κία ή πεξηζζφηεξεο ιεηηνπξγίεο, θαζνξίδνληαο ην πιηθφ 

φπσο επηζπκνχκε ζε θάζε ιεηηνπξγία.  

7) Αλαθηνχκε ή δεκηνπξγνχκε έλα ρψξν εξγαζίαο (workcell) γηα θάζε ιεηηνπξγία. 

Δπίζεο, αλαθηνχκε ή δεκηνπξγνχκε θνπηηθά εξγαιεία, αλ ρξεηάδεηαη, γηα απηνχο 

ηνπο ρψξνπο εξγαζίαο.  

8) ηε ζπλέρεηα, αλαθηνχκε ή δεκηνπξγνχκε θαη ηα επηζπκεηά αξρεία θαηεξγαζίαο.  

9) Κάλνπκε φπνηεο άιιεο ξπζκίζεηο απαηηνχληαη – βαζηθά ξπζκίδνπκε νηηδήπνηε δελ ζα 

ππνζηεί μαλά αιιαγή ή ζα ην αιιάμνπκε ζπάληα θαη νηηδήπνηε δελ ζέινπκε λα ην 

νξίδνπκε θάζε θνξά (γηα παξάδεηγκα, ν νξηζκφο ηνπ κέζνπ ζπγθξάηεζεο- fixture). 

10) Γεκηνπξγνχκε έλα ζρέδην (drawing) ηνπ αξρηθνχ κνληέινπ (start model), 

ρξεζηκνπνηψληαο ην ίδην φλνκα κε απηφ ηνπ αξρηθνχ κνληέινπ θαη ρξεζηκνπνηψληαο 
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ην αξρείν manufacturing .asm σο ην πξνεπηιεγκέλν κνληέιν “default model”.  

Κάλνπκε ηηο ξπζκίζεηο απηέο φπσο επηζπκνχκε θαη απνζεθεχνπκε. 

11)  ην ηέινο απνζεθεχνπκε ην κνληέιν θαηεξγαζίαο. Σα αξρεία filename.mfg, θαη 

filename.asm ζα απνζεθεπηνχλ (καδί κε ηπρφλ εμαξηήκαηα ζπγθξάηεζεο πνπ έρνπκε 

δεκηνπξγήζεη). ια απηά ηα αξρεία ηα ελζσκαηψλνπκε ζην start_model_dir (θαη ην 

αξρηθφ ζρέδην, εάλ θάλνπκε). εκεηψλεηαη φηη ηα αξρεία απηά ζπλίζηαληαη κφλν γηα 

αλάγλσζε (Read Only). 

Γηα λα ρξεζηκνπνηήζνπκε έλα ήδε δεκηνπξγεκέλν πξφηππν, ην επηιέγνπκε απφ ηε ιίζηα 

θαηά ηε δεκηνπξγία ελφο λένπ κνληέινπ θαηεξγαζίαο (mfg model). Γηα λα είλαη εθηθηφ 

απηφ, πξέπεη πξψηα λα μεκαξθάξνπκε ην πξνεπηιεγκέλν πξφηππν, φπσο θαίλεηαη ζηελ 

εηθφλα  θαη ηφηε κεηαθεξφκαζηε ζην παξάζπξν επηινγήο πξνηχπσλ 

(Δηθόλα ΙΙΙ.6.1) θαη επηιέγνπκε απηφ πνπ επηζπκνχκε. 

 Δηθόλα ΙΙΙ.6.1 

Απηφ πνπ κέλεη ινηπφλ λα γίλεη είλαη ε αλάθηεζε ηνπ ηειηθνχ αληηθεηκέλνπ, ε δεκηνπξγία 

ή ε αλάθηεζε ηνπ αληηθεηκέλνπ πξνο θαηεξγαζία (workcell) θαη κεηά είκαζηε έηνηκνη λα 

μεθηλήζνπκε ηε δεκηνπξγία αθνινπζηψλ αξηζκεηηθνχ ειέγρνπ (NC sequences). 

Μηα αθφκα ζπκβνπιή, εάλ ππάξρεη έλα αξρείν ζρεδίνπ (γηα παξάδεηγκα, έλα θχιιν)  κε 

ην ίδην φλνκα κε ην πξφηππν θαηεξγαζίαο, ηαπηφρξνλα ζα δεκηνπξγεζεί θαη έλα ζρέδην 

ηνπ λένπ κνληέινπ θαηεξγαζίαο. Γηα λα είλαη εθηθηφ απηφ, αξθεί κφλν λα νξίζνπκε ηελ 

επηινγή rename_drawings_with_object ζηελ έλδεημε "both", γηα λα ην θάλεη απηφκαηα. 
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7. Παπάμεηποι καηεπγαζίαρ 

Οη παξάκεηξνη θαηεξγαζίαο είλαη απαξαίηεηεο θαηά ηελ δηάξθεηα ηεο δεκηνπξγίαο ησλ 

αθνινπζηψλ αξηζκεηηθνχ ειέγρνπ, θαζψο πεξηιακβάλνπλ παξακέηξνπο πνπ ζρεηίδνληαη 

κε ηελ θίλεζε ηνπ θνπηηθνχ θαη παξακέηξνπο ιεηηνπξγίαο ηεο κεραλήο CNC. Οη 

παξάκεηξνη παίξλνπλ είηε αξηζκεηηθέο ηηκέο, φπσο απνζηάζεηο είηε πξνεπηιεγκέλεο ηηκέο. 

Μεξηθέο απφ απηέο ηηο παξακέηξνπο είλαη ε ηαρχηεηα πξφσζεο, ε ηαρχηεηα πεξηζηξνθήο 

ηεο αηξάθηνπ, ην βάζνο θνπήο θαζψο θαη ν ηξφπνο κε ηνλ νπνίν θηλείηαη ην θνπηηθφ θαηά 

ηελ θαηεξγαζία κηαο επηθαλείαο. 

Οη παξάκεηξνη ζην Pro/Manufacturing ρσξίδνληαη ζε δπν θαηεγνξίεο, ζηηο βαζηθέο 

(basic), φπνπ εκθαλίδνληαη κφλν νη απαξαίηεηεο παξάκεηξνη γηα ηελ δεκηνπξγία ηεο θάζε 

αθνινπζίαο θαη ζηηο φιεο (all), φπνπ εκθαλίδνληαη φιεο νη παξάκεηξνη πνπ κπνξνχλ λα 

θαζνξίζνπλ ηελ αθνινπζία. Οη παξάκεηξνη πνπ είλαη απαξαίηεηεο γηα ηελ δεκηνπξγία 

κηαο αθνινπζίαο αξηζκεηηθνχ ειέγρνπ εκθαλίδνληαη κε θίηξηλν πιαίζην, ελψ νη άιιεο 

παίξλνπλ ηηο πξνεπηιεγκέλεο ηηκέο πνπ είλαη ζπλήζσο θαη απηέο πνπ ρξεζηκνπνηνχληαη 

(αληίζηνηρα ζην site tree, θαηά ηε δεκηνπξγία ελφο αξρείνπ θαηεξγαζίαο (site file), νη 

απαξαίηεηεο παξάκεηξνη έρνπλ ηελ ηηκή -1).  

ηελ παξαθάησ εηθφλα (Δηθόλα ΙΙΙ.7.1) θαίλνληαη νη παξάκεηξνη γηα κηα αθνινπζία 

volume milling: 

 Δηθόλα ΙΙΙ.7.1 
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Δπίζεο, νη παξάκεηξνη θαηεξγαζίαο ρσξίδνληαη ζηηο εμήο θαηεγνξίεο: νλφκαηα (Names), 

παξάκεηξνη θνπήο (Cut param), επηινγέο ηεο θνπήο (Cut option), παξάκεηξνη πξφσζεο 

(Feed), παξάκεηξνη ηεο κεραλήο (Machine) θαη παξάκεηξνη εηζφδνπ εμφδνπ (Entry/Exit). 

Οη θαηεγνξίεο  Cut param θαη Cut option κεηαβάιινληαη αλάινγα κε ην είδνο ηεο 

αθνινπζίαο αξηζκεηηθνχ ειέγρνπ, ελψ νη ππφινηπεο ηξεηο είλαη ζηαζεξέο γηα φια. 

ηελ θαηεγνξία νλνκάησλ (Names), νξίδνπκε ηα νλφκαηα πνπ θαζνξίδνπλ ηα αξρεία 

ζέζεο ηνπ θνπηηθνχ (CL file) πνπ ζα δεκηνπξγεζνχλ γηα ηελ αθνινπζία.  

ηελ θαηεγνξία ησλ παξακέηξσλ θνπήο νξίδνπκε ην βάζνο θνπήο (Step depth) ή ηνλ 

αξηζκφ ησλ πεξαζκάησλ (Number of cuts), ην ειάρηζην βάζνο θνπήο (Min step depth), 

ηελ πνζφηεηα αθαηέξγαζηνπ πιηθνχ πνπ πξέπεη λα απνκέλεη ζε επηιεγκέλεο επηθάλεηεο, 

ηελ γσληά πνπ ζα ζρεκαηίδεη ε πνξεία ηνπ θνπηηθνχ κε ηνλ άμνλα Υ (Cut angle) θαη ηελ 

επηθάιπςε ηνπ θνπηηθνχ θαηά ηελ θαηεξγαζία. 

ηελ θαηεγνξία Cut option πεξηέρνληαη νη ξπζκίζεηο θνπήο πνπ ειέγρνπλ παξακέηξνπο 

πνπ αθνξνχλ ηνλ ηξφπν ηεο θίλεζεο ηνπ θνπηηθνχ ζηα φξηα ηνπ ρψξνπ πνπ γίλεηαη ε 

θαηεξγαζία. Οη παξάκεηξνη απηέο ξπζκίδνπλ ηνλ ηξφπν ηεο θίλεζεο θαηά ηελ δηάξθεηα 

ηεο θαηεξγαζίαο (Scan Type) θαη πνην ηκήκα ηνπ δνθηκίνπ θαηεξγάδεηαη (trim to 

workpiece, rough option). 

ηελ θαηεγνξία ησλ παξακέηξσλ πξφσζεο ππάξρνπλ ξπζκίζεηο πνπ θαζνξίδνπλ ηελ 

ηαρχηεηα θίλεζεο ηνπ θνπηηθνχ θαη ηηο κνλάδεο κε ηηο νπνίεο κεηξηέηαη ε ηαρχηεηα απηή. 

Μεξηθέο απφ ηηο παξακέηξνπο απηέο είλαη ε ηαρχηεηα πξφσζεο θαηά ηελ θαηεξγαζία 

(Cut feed), θαηά ηελ απνκάθξπλζε ηνπ θνπηηθνχ (Retract feed), θαηά ηελ δηάξθεηα ηεο 

θίλεζεο ζε ηφμν (Arc feed) θαη θαηά ηελ δηάξθεηα εθηέιεζεο βχζηζεο .  

ηελ θαηεγνξία ησλ παξακέηξσλ ηεο κεραλήο πεξηέρνληαη νη ξπζκίζεηο πνπ 

πξνζδηνξίδνπλ επηινγέο πνπ αθνξνχλ ηελ κεραλή CNC. Απηέο πεξηιακβάλνπλ ηελ 

ηαρχηεηα πεξηζηξνθήο ηεο αηξάθηνπ (Spindle speed), ηελ θνξά πεξηζηξνθήο ηεο 

(Spindle sense), ην ζχζηεκα ζπληεηαγκέλσλ ηεο αθνινπζίαο, ηελ ελεξγνπνίεζε ή φρη ηεο 

αληηζηάζκηζεο ησλ θνπηηθψλ, ηελ παξνρή ή φρη ηνπ ςπθηηθνχ πγξνχ (Coolant option) θαη 

ηελ πίεζε ηνπ (Coolant pressure).  

ηελ θαηεγνξία ησλ παξακέηξσλ εηζφδνπ εμφδνπ ππάξρνπλ ξπζκίζεηο πνπ θαζνξίδνπλ 

ηνλ ηξφπν θίλεζεο ηνπ θνπηηθνχ θαηά ηελ δηάξθεηα ησλ θηλήζεσλ εηζφδνπ θαη εμφδνπ. 

Οη θπξηφηεξεο απφ απηέο είλαη ε απφζηαζε αζθαιείαο (Clear Dist), δειαδή, ε απφζηαζε 

ζηνλ άμνλα z πξνθεηκέλνπ λα βξεζεί πάλσ απφ ην αληηθείκελν, θαζψο θαη νη γσλίεο 

εηζφδνπ θαη εμφδνπ.  
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i. Αρτεία καηεργαζίας για παραμέηροσς καηεργαζίας 

Χρήζη αρτείφν καηεργαζίας για προεπιλεγμένες ρσθμίζεις ηφν παραμέηρφν  

Αληί λα αιιάδνπκε ζπλερψο νξηζκέλεο βαζηθέο παξακέηξνπο, θαηά ηελ δεκηνπξγία κηαο 

λέαο αθνινπζίαο, κπνξνχκε λα ρξεζηκνπνηήζνπκε έλα αξρείν θαηεξγαζίαο πνπ έρνπκε 

δεκηνπξγήζεη κε ηηο επηζπκεηέο ξπζκίζεηο ησλ παξακέηξσλ. Γηα παξάδεηγκα, εάλ 

ζέινπκε λα έρνπκε ξνή ςπθηηθνχ θαηά ηελ δηάξθεηα θάζε θαηεξγαζίαο, δελ ρξεηάδεηαη λα 

αιιάδνπκε θάζε θνξά ηελ έλδεημε ηνπ ςπθηηθνχ ζε  „on‟, επεηδή ε πξνεπηινγή ηνπ είλαη 

„off‟. Αξθεί κφλν λα έρνπκε δεκηνπξγήζεη έλα αξρείν κε ηελ ξχζκηζε απηή θαη λα 

ρξεζηκνπνηνχκε ην αξρείν απηφ. 

Γηα λα δεκηνπξγήζνπκε έλα αξρείν θαηεξγαζίαο επηιέγνπκε απφ ην Menu Manager → 

Mfg Setup → Param Setup → Site → Create → enter a name → select a type (επηινγή 

ηχπνπ απφ Generic, Mill, Turn, Holemaking, WEDM). ηε ζπλέρεηα, ξπζκίδνπκε ηηο 

παξακέηξνπο φπσο επηζπκνχκε θαη λα ην απνζεθεχνπκε (απνζεθεχεηαη σο .sit file ζην 

pro_mf_param_dir).  
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Γηα λα ρξεζηκνπνηήζνπκε έλα αξρείν θαηεξγαζίαο εθαξκφδνπκε κηα απφ ηηο επφκελεο 

κεζφδνπο:  

Μέζνδνο 1: Mfg Setup→Param Setup → Site →Create (Retrieve) →Activate → choose 

site. 

Μέζνδνο 2: ην παξάζπξν δηαιφγνπ ηεο κεραλήο - Machine Tool Setup (workcell) 

επηιέγνπκε ην θνπκπί Defaults θαη επηιέγνπκε ην αξρείν θαηεξγαζίαο γηα λα 

ελεξγνπνηεζεί γηα ηνλ ζπγθεθξηκέλν ρψξν εξγαζίαο  

Μέζνδνο 3: Καηά ηε δηάξθεηα ηεο δεκηνπξγίαο κηαο αθνινπζίαο αξηζκεηηθνχ ειέγρνπ, 

επηιέγνπκε File → Open Site απφ ην κελνχ Mfg Params ή Edit → Copy from Site θαη 

ζηε ζπλέρεηα δηαιέγνπκε ην αξρείν πνπ ζέινπκε λα ρξεζηκνπνηήζνπκε.  

8. Δημιοςπγία ακολοςθιών  

Οη αθνινπζίεο αξηζκεηηθνχ ειέγρνπ είλαη έλα ζχλνιν εληνιψλ πνπ έρνπλ σο ζθνπφ ηελ 

θαηεξγαζία κηαο πεξηνρήο κε ζπγθεθξηκέλεο παξακέηξνπο. Γηα λα δεκηνπξγήζνπκε κηα 

λέα αθνινπζία επηιέγνπκε απφ ην Menu  Manager → Machining → NC Sequence. ηελ 

νζφλε καο εκθαλίδεηαη έλα ζχλνιν αθνινπζηψλ αξηζκεηηθνχ ειέγρνπ πνπ κπνξνχλ λα 

δεκηνπξγεζνχλ, θαζψο θαη ν αξηζκφο ησλ αμφλσλ κε ηνπο νπνίνπο ζα γίλεη ε θαηεξγαζία 

(Δηθόλα IΙI.8.1). 

  Δηθόλα IΙI.8.1 
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Δπηιέγνληαο έλα απφ απηά ηα είδε θαηεξγαζηψλ θαη ηνλ αξηζκφ ησλ αμφλσλ κε ηνπο 

νπνίνπο ζα γίλεη ε θαηεξγαζία επηιέγνπκε DONE θαη κεηαθεξφκαζηε ζην κελνχ 

επηινγψλ ηεο αθνινπζίαο (Δηθόλα IΙI.8.2). Δδψ επηιέγνπκε ηηο πιεξνθνξίεο πνπ ζέινπκε 

λα εηζάγνπκε γηα ηελ δεκηνπξγία ηεο αθνινπζίαο. Ζ πιεηνλφηεηα εμ απηψλ έρεη 

πξναηξεηηθφ ραξαθηήξα κηαο θαη ζπκπιεξψλνληαη απηφκαηα θαη ππάξρνπλ γηα ηελ 

θαιχηεξε ξχζκηζε ηεο αθνινπζίαο. Σα ζεκαληηθφηεξα εμ‟ απηψλ είλαη ην φλνκα ηεο 

θαηεξγαζίαο (Name), ηα ζρφιηα (Comments), νη παξάκεηξνη ηεο θαηεξγαζίαο 

(Parameters), ην ζχζηεκα ζπληεηαγκέλσλ (Coord Sys) θαη ην θνπηηθφ εξγαιείν ηεο 

αθνινπζίαο (Tool). 

  Δηθόλα IΙI.8.2 

Αθνχ νινθιεξψζνπκε ηηο επηινγέο καο παηάκε ην DONE θαη εκθαλίδεηαη ε πξψηε απφ 

ηηο επηινγέο καο. Αθνχ, φπσο ζα δνχκε θαη παξαθάησ, ζπκπιεξψζνπκε ηηο απαηηνχκελεο 

πιεξνθνξίεο είκαζηε έηνηκνη λα δνχκε ηελ πνξεία ηνπ θνπηηθνχ ε νπνία αληηζηνηρεί ζηα 

δεδνκέλα ηα νπνία εηζαγάγακε. Απφ ην Menu manager επηιέγνπκε ην Play path. Με ηελ 

επηινγή απηή εκθαλίδεηαη έλα λέν κελνχ κε ηξεηο επηινγέο (Δηθόλα IΙI.8.3) 

  Δηθόλα IΙI.8.3 
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Γηα λα δνχκε ηελ γξαθηθή απεηθφληζε ηεο θίλεζεο ηνπ θνπηηθνχ εξγαιείνπ ζην 

πεξηβάιινλ ηνπ Pro/Manufacturing επηιέγνπκε απφ ην κελνχ απηφ ην Screen Play θαη 

εκθαλίδεηαη ην παξάζπξν ηεο Δηθόλαο IΙI.8.4. 

 Δηθόλα IΙI.8.4 

Δπίζεο, κε ην εηθνλίδην  εκθαλίδεηαη ην παξάζπξν πιεξνθνξηψλ ηεο θαηεξγαζίαο. 

ην παξάζπξν απηφ, κπνξνχκε λα δνχκε ην φλνκα ηεο κεραλήο θαη ηνπ ζεκείνπ κεδέλ, 

ην θνπηηθφ εξγαιείν θηι. (Δηθόλα IΙI.8.5) θαη παηψληαο πάλσ ζην θαζέλα απφ απηά 

κπνξνχκε λα δνχκε πεξηζζφηεξεο πιεξνθνξίεο, θαζψο επίζεο θαη ην ζεκείν πνπ 

βξίζθεηαη ην θέληξν ηνπ θνπηηθνχ ζε ζρέζε κε ην ζεκείν κεδέλ (Tool Path Info) (Δηθόλα 

IΙI.8.6), θαζ φιε ηε δηάξθεηα ηεο θίλεζεο ηνπ θνπηηθνχ.  

 Δηθόλα IΙI.8.5 

 Δηθόλα IΙI.8.6 
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Δπηπιένλ κε ηελ επηινγή NC Check κπνξνχκε λα δνχκε ηελ γξαθηθή πξνζνκνίσζε ηεο 

θίλεζεο ηνπ θνπηηθνχ ζην πξφγξακκα Vericut. ην πξφγξακκα απηφ, επηιέγνπκε ην Play 

απφ ηελ θάησ δεμηά κπάξα γηα λα δνχκε ηελ πξνζνκνίσζε ηεο θαηεξγαζίαο καο. 

 

Σέινο, εάλ ε θαηεξγαζία απφ ηελ γξαθηθή πξνζνκνίσζε καο ηθαλνπνηεί, ηφηε επηιέγνπκε 

Done Seq θαη νινθιεξψλνπκε ηελ δεκηνπξγία ηεο αθνινπζίαο (Δηθόλα IΙI.8.7). Δάλ φρη 

κπνξνχκε λα ηξνπνπνηήζνπκε  ηηο  παξακέηξνπο επηιέγνληαο ην Seq setup θαη  

επηιέγνπκε πνηεο παξακέηξνπο ζέινπκε λα ηξνπνπνηήζνπκε. 

 Δηθόλα IΙI.8.7 

 

i. Ακολοσθία καηεργαζίας προζώποσ (Face) 

ηελ αθνινπζία πξνζψπνπ (Face) θαηεξγαδφκαζηε ην πξφζσπν ηνπ αληηθεηκέλνπ, 

δειαδή ηελ επηθάλεηα πνπ είλαη παξάιιειε ζην επίπεδν XY θαη βξίζθεηαη ζηελ πάλσ 

πιεπξά ηνπ πξνο θαηεξγαζία θνκκαηηνχ (Δηθόλεο IΙI.8.8). Ζ θαηεξγαζία ηνπ είλαη κηα 

θαηεξγαζία 2.5 αμφλσλ θαη θαηά ηελ δηάξθεηα απηήο ηεο αθνινπζίαο ην θνπηηθφ 

εξγαιείν εθηειεί δηαδνρηθά πεξάζκαηα πάλσ απφ ηελ επηθάλεηα ηνπ πξνο θαηεξγαζία 

θνκκαηηνχ, απνκαθξχλνληαο θάζε θνξά κηα ζηξψζε πιηθνχ κε πάρνο φζν ην βάζνο 

θνπήο.  

                Δηθόλεο IΙI.8.8 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

67 

 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο πξνζψπνπ είλαη: 

 Cut feed: ε ηαρχηεηα πξφσζεο θαηά ηελ θαηεξγαζία      

 

 

 Step depth: ην βάζνο θνπήο, πνπ θαζνξίδεη ην πάρνο ηνπ 

πιηθνχ πνπ θαηεξγάδεηαη θάζε θνξά ην θνπηηθφ 

εξγαιείν.                                                                            

 

 

 Step over:  ε απφζηαζε κεηαμχ δηαδνρηθψλ πεξαζκάησλ            

 

 

 Scan type: Ζ παξάκεηξνο απηή ειέγρεη ηνλ ηξφπν κε ηνλ νπνίν θηλείηαη ην θνπηηθφ 

πάλσ ζηελ αθαηέξγαζηε επηθάλεηα. Οη επηινγέο είλαη: 
 

- Type 1, ζηελ νπνία ην θνπηηθφ θηλείηαη ζηελ 
επηθάλεηα αθνινπζψληαο ηελ θνξά δεμηά αξηζηεξά. 

 
 
 
  

- Type 3, ζηελ νπνία ην θνπηηθφ θηλείηαη φκνηα  
κε ηνλ πξψην ηξφπν, κφλν πνπ θαηεξγάδεηαη 
μερσξηζηά θάζε δψλε ηνπ αληηθεηκέλνπ.  

 
 
 

- Type spiral, ζηελ νπνία έρνπκε ζπεηξνεηδή 
θίλεζε ηνπ θνπηηθνχ.  

 
 
 

 
 
- Type one dir, ζηελ νπνία ην θνπηηθφ 
θαηεξγάδεηαη κφλν ζηελ θίλεζε θαηά ηελ κηα θνξά 
θαη απνκαθξχλεηαη κεηαμχ ησλ δηαδνρηθψλ 
πεξαζκάησλ.  
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 Clear dist:  ε απφζηαζε αζθαιείαο, δειαδή ε απφζηαζε 

ζηνλ z άμνλα πάλσ απφ ην αληηθείκελν.  

 

 Cut angle: ε γσλία θνπήο, δειαδή ε γσλία θίλεζεο ηνπ θνπηηθνχ ζε ζρέζε κε ηνλ 

άμνλα Υ. 

 

 Bottom stock allow: ην πάρνο ηνπ πιηθνχ πνπ αθήλνπκε 

αθαηέξγαζην ζην θνκκάηη πξνθεηκέλνπ λα θαηεξγαζηεί 

ζε επφκελε αθνινπζία.                                                          

 

 Approach distance: ε επηπιένλ απφζηαζε ηνπ θνπηηθνχ 

απφ ηελ αξρή ηνπ θνκκαηηνχ θαηά ηελ δηάξθεηα ηνπ 

πξψηνπ πεξάζκαηνο, δειαδή θαηά ηελ είζνδν ηνπ 

θνπηηθνχ ζην θνκκάηη.   

 

 Exit distance: ε επηπιένλ απφζηαζε ηνπ θνπηηθνχ θαηά ην 

ηειεπηαίν πέξαζκα, δειαδή θαηά ηελ έμνδν ηνπ θνπηηθνχ 

απφ ην θνκκάηη.  

 

 Start over travel: ε απνκάθξπλζε ηνπ θνπηηθνχ απφ ην 

θαηεξγαδφκελν θνκκάηη θαηά ηελ αξρή ησλ πεξαζκάησλ.                                                 

 

 

 End over travel: ε απνκάθξπλζε ηνπ θνπηηθνχ απφ ην 

θαηεξγαδφκελν θνκκάηη πνπ πξνζηίζεηαη απηφκαηα. 

 

 

 Spindle speed: ε ηαρχηεηα πεξηζηξνθήο ηεο αηξάθηνπ. 
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Γημιοσργία ηης ακολοσθίας καηεργαζίας προζώποσ 
 
Γηα ηνλ θαζαξηζκφ ηεο επηθάλεηαο ηνπ πξνζψπνπ ηνπ αθαηέξγαζηνπ θνκκαηηνχ ζα 

εθηειέζνπκε δπν δηαδνρηθά πεξάζκαηα. Σν έλα ζα είλαη γηα ηελ εθρφλδξηζε (Rough) ηεο 

επηθαλείαο θαη ην δεχηεξν γηα ηελ απνπεξάησζή ηεο (Finish). Γηα λα δεκηνπξγήζνπκε 

κηα αθνινπζία πξνζψπνπ επηιέγνπκε Machining → NC Sequence → Face → Done 

(Δηθόλα IΙI.8.9), θαη ζην επφκελν κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη 

επηιεγκέλα ηα: Name, Comments, Tool, Parameters, Coord Sys, Retract Surf θαη 

Surfaces (Δηθόλα IΙI.8.10) θαη επηιέγνπκε Done. 

 

  Δηθόλα IΙI.8.9      Δηθόλα IΙI.8.10 

ηε ζπλέρεηα εηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Face_Rough) θαη παηάκε Enter θαη 

αθνχ νξίζνπκε ην φλνκα ηεο αθνινπζίαο εκθαλίδεηαη έλα παξάζπξν ζην νπνίν κπνξνχκε 

λα εηζάγνπκε ηα ηπρφλ ζρφιηα πνπ έρνπκε γηα ηελ αθνινπζία. Μφιηο νινθιεξψζνπκε 

ηελ εηζαγσγή ησλ ζρνιίσλ επηιέγνπκε ΟΚ. 
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Έπεηηα, εκθαλίδεηαη ην παξάζπξν δεκηνπξγίαο ησλ θνπηηθψλ εξγαιείσλ. ε απηφ ην 

παξάζπξν επηιέγνπκε πνην θνπηηθφ είλαη απηφ πνπ ζα θάλεη ηελ αθνινπζία αξηζκεηηθνχ 

ειέγρνπ. Γηα λα αλαθηήζνπκε έλα απνζεθεπκέλν εξγαιείν επηιέγνπκε File → Open 

Parameter File ή απιά Open . Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, 

φπσο θαίλεηαη ζηελ Δηθόλα IΙI.8.11: 

 

Δηθόλα IΙI.8.11 

  
ε απηφ ην ζεκείν ην Pro/manufacturing καο δεηά λα εηζάγνπκε ηηο παξακέηξνπο 

θαηεξγαζίαο (Δηθόλα IΙI.8.12). 

 Δηθόλα IΙI.8.12 
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Πξέπεη λα αιιάμνπκε ινηπφλ ηηο παξακέηξνπο έηζη ψζηε λα έρνπκε ηελ επηζπκεηή 

πνξεία ηνπ θνπηηθνχ. Δθηφο απφ ηνλ απιφ ηξφπν, πνπ νξίδνπκε εδψ ηηο ηηκέο ζηηο 

παξακέηξνπο, ππάξρνπλ θαη 2 αθφκα ηξφπνη γηα λα ην θάλνπκε απηφ. 

1
ος

 ηρόπος 

 Έρνληαο εηζάγεη ζην θνπηηθφ ζηελ θαξηέια Cut Data (θαξηέια γηα Speeds & Feeds) 

ηα δεδνκέλα θαη ηηο ζπλζήθεο θνπήο ζην εξγαιείν απηφ (roughing ή Finishing, φξηα 

πεξηζηξνθήο θαη πξφσζεο) 

 

Δπηιέγνπκε απφ ην παξάζπξν ησλ παξακέηξσλ Edit → Copy From Tool → All / 

Spindle / Feed / Depth → Rough  θαη έηζη ε ηαρχηεηα, ε πξφσζε θαη ην θνπηηθφ 

βάζνο δηαβαζηνχλ απφ ην αξρείν ηνπ θνπηηθνχ.  
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ηε ζπλέρεηα θάλνπκε ηηο απαξαίηεηεο αιιαγέο ζηηο ππφινηπεο παξακέηξνπο. 

2
ος

 ηρόπος 

• Έρνληαο δεκηνπξγήζεη έλα αξρείν θαηεξγαζίαο (site file), κε ηνλ ηξφπν πνπ έρνπκε 

αλαθέξεη παξαπάλσ, θαη έρνληαο νξίζεη ηηο βαζηθέο παξακέηξνπο (ππελζπκίδνπκε 

φηη εδψ νη απαξαίηεηεο παξάκεηξνη έρνπλ ηηκή -1) 

 

Απνζεθεχνπκε ην αξρείν θαηεξγαζίαο θαη επηιέγνπκε απφ ην παξάζπξν ησλ 

παξακέηξσλ File → Open Site ή Edit → Copy from Site θαη επηιέγνπκε ην 

ζπγθεθξηκέλν. 

Έηζη απηφκαηα νη παξάκεηξνη αιιάδνπλ θαη παίξλνπλ ηηο ηηκέο απφ ην ζπγθεθξηκέλν 

αξρείν θαηεξγαζίαο. 
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ηε ζπλέρεηα θάλνπκε ηηο απαξαίηεηεο αιιαγέο ζηηο ππφινηπεο παξακέηξνπο, 

αλάινγα βέβαηα κε ηηο παξακέηξνπο πνπ έρνπκε νξίζεη ζην αξρείν θαηεξγαζίαο. 

 

Αθνχ νινθιεξψζνπκε ηελ εηζαγσγή ησλ παξακέηξσλ κε έλαλ απφ ηνπο παξαπάλσ 

ηξφπνπο, θιείλνπκε ην παξάζπξν θαη επηιέγνπκε OK. 

ηελ παξαθάησ εηθφλα θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Face_Rough (Δηθόλα 

IΙI.8.13). 
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 Δηθόλα IΙI.8.13 

 

ηελ ζπλέρεηα, καο δεηείηαη λα επηιέμνπκε ην ζχζηεκα ζπληεηαγκέλσλ (Coord Sys) κε 

βάζε ην νπνίν ζα γίλεη ε αθνινπζία. Δπηιέγνπκε ην Machine Zero θαη κεηά επηιέγνπκε 

ην επίπεδν επηζηξνθήο, επηιέγνληαο Select θαη ην datum ADTM1 θαη ΟΚ. 

Σέινο, καο δεηείηαη λα πεξηγξάςνπκε ηνλ φγθν πνπ ζα θαηεξγαζηεί ην θνπηηθφ. Απηφ 

κπνξεί λα γίλεη είηε επηιέγνληαο κηα επηθάλεηα ηνπ κνληέινπ, είηε θαηαζθεπάδνληαο ηνλ 

φγθν κε θάπνην feature ηνπ Pro/E φπσο extrude, sweep θ.ι.π. . Δκείο επηιέγνπκε ην 

Model θαη Done. Δπηιέγνληαο ηελ άλσ επηθάλεηα ηνπ κνληέινπ θαη Done έρνπκε 

νινθιεξψζεη ηελ ξχζκηζε ηεο αθνινπζίαο. 

ηε ζπλέρεηα, ζέινπκε λα ειέγμνπκε εάλ ε θίλεζε ηνπ θνπηηθνχ είλαη ηθαλή ψζηε λα 

θαηεξγαζηεί ην ζχλνιν ηεο επηθαλείαο πνπ επηιέμακε. ην κελνχ πνπ καο εκθαλίδεηαη 

ινηπφλ επηιέγνπκε Play path θαη screen play. Δπηιέγνπκε Play θαη βιέπνπκε ηελ πνξεία 

ηνπ θνπηηθνχ (θφθθηλε γξακκή) (Δηθόλα IΙI.8.14). 
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 Δηθόλα IΙI.8.14 

 

ηε ζπλέρεηα, επηιέγνπκε απφ ην Play path, ην NC Check γηα λα εθηειέζνπκε κηα 

γξαθηθή πξνζνκνίσζε θνπήο ζην πξφγξακκα Vericut. 

Μεηαθεξφκαζηε, ινηπφλ, ζην πεξηβάιινλ ηνπ Vericut, φπσο θαίλεηαη ζηελ παξαθάησ 

εηθφλα. 
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Καη επηιέγνληαο ην Play γίλεηαη ε πξνζνκνίσζε θνπήο, φπσο θαίλεηαη ζηηο παξαθάησ 

εηθφλεο (Δηθόλεο IΙI.8.15). 
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 Δηθόλεο IΙI.8.15 
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ηελ ζπλέρεηα, θαηαζθεπάδνπκε κε ηνλ ίδην ηξφπν κηα αθνινπζία θαηεξγαζίαο ηνπ 

πξνζψπνπ ηνπ αληηθεηκέλνπ γηα ηελ απνπεξάησζε ηεο επηθάλεηαο (Finish). Δηζάγνπκε 

σο φλνκα Face_Finish, επηιέγνπκε ην ίδην θνπηηθφ θαη ζην παξάζπξν επηινγψλ ησλ 

παξακέηξσλ είηε θάλνπκε έλαλ απφ ηνπο πξναλαθεξφκελνπο ηξφπνπο είηε επηιέγνπκε 

Edit →  Copy from Sequence θαη επηιέγνπκε ηελ πξνεγνχκελε αθνινπζία Face_rough.  

 

Ζ επηινγή απηή ζέηεη ηηο παξακέηξνπο ίδηεο κε απηέο ηεο πξνεγνπκέλεο θαηεξγαζίαο θαη 

αιιάδνπκε ηηο επηζπκεηέο παξακέηξνπο, κε ηειηθέο ηηκέο φπσο θαίλεηαη ζηελ παξαθάησ 

εηθφλα (Δηθόλα IΙI.8.16). 

 Δηθόλα IΙI.8.16 
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Ζ πνξεία ηνπ θνπηηθνχ ζηελ Face_Finish θαίλεηαη ζηελ Δηθόλα IΙI.8.17. 

Δηθόλα IΙI.8.17 

Καη ε πξνζνκνίσζε θνπήο θαη ησλ 2 παξαπάλσ αθνινπζηψλ ζην Vericut: 
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ii. Ακολοσθία καηεργαζίας προθίλ (Profile) 

ηελ αθνινπζία πξνθίι (Profile) θαηεξγαδφκαζηε ην πξνθίι ηνπ αληηθεηκέλνπ, δειαδή 

ηελ πεξηθεξεηαθή επηθάλεηά ηνπ. Καηά ηελ θαηεξγαζία απηή, ην θνπηηθφ εξγαιείν 

θηλείηαη πεξηθεξεηαθά ηνπ αληηθεηκέλνπ (Δηθόλα IΙI.8.18). 

 Δηθόλα IΙI.8.18 

 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο πξνθίι είλαη: 

 Cut feed 

 Step depth 

 Clear dist 

 Approach distance 

 Exit distance 

 Num prof passes: ν αξηζκφο αθηηληθψλ πεξαζκάησλ πνπ ειέγρεη ην πφζα 

πεξάζκαηα ζα θάλεη ζπλνιηθά ην θνπηηθφ γηα λα θαηεξγαζζεί ην δνθίκην γηα θάζε 

έλα βάζνο θνπήο, γηα λα θαηεξγαζηεί ην θνπηηθφ απφζηαζε κεγαιχηεξε απφ ηελ 

δηάκεηξν ηνπ.  

 Prof increment:  ην αθηηληθφ βάζνο θνπήο, δειαδή ην πάρνο ηνπ πιηθνχ πνπ ην 

θνπηηθφ θαηεξγάδεηαη αθηηληθά. Ζ κεηαβιεηή απηή έρεη λφεκα εάλ ν αξηζκφο 

αθηηληθψλ πεξαζκάησλ είλαη κεγαιχηεξνο ηνπ έλα. 

 Prof stock allow: ην πάρνο ηνπ αθαηέξγαζηνπ ππνινίπνπ, 

δειαδή ην πάρνο ηνπ πιηθνχ πνπ ζα παξακείλεη ζην 

πξνθίι ηνπ αληηθεηκέλνπ κεηά ην ηέινο ηεο θαηεξγαζίαο. 

 

 Chk srf stock allow: Σν πάρνο ηνπ αθαηέξγαζηνπ ππνινίπνπ, δειαδή ην πάρνο ηνπ 

πιηθνχ πνπ ζα παξακείλεη ζε κηα επηιεγκέλε επηθάλεηα ηνπ αληηθεηκέλνπ κεηά ην 

ηέινο ηεο θαηεξγαζίαο 

 Spindle speed 

 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

81 

 

Γημιοσργία ηης ακολοσθίας καηεργαζίας προθίλ 
 
Γηα ηνλ θαζαξηζκφ ηνπ πξνθίι ηνπ αθαηέξγαζηνπ θνκκαηηνχ ζα εθηειέζνπκε δπν 

δηαδνρηθά πεξάζκαηα. Σν έλα ζα είλαη γηα ηελ εθρφλδξηζε (Rough) ηεο επηθάλεηαο θαη ην 

δεχηεξν γηα ηελ απνπεξάησζή ηεο (Finish). Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία 

πξνζψπνπ επηιέγνπκε Machining → NC Sequence → New Sequence → Profile → Done 

(Δηθόλα IΙI.8.19), θαη ζην επφκελν κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη 

επηιεγκέλα ηα: Name, Tool, Parameters, Surfaces θαη Check Surfs (Δηθόλα IΙI.8.20) θαη 

επηιέγνπκε Done. 

   Δηθόλα IΙI.8.19               Δηθόλα IΙI.8.20 

 

ηε ζπλέρεηα εηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Profile_Rough) θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.21: 
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 Δηθφλα IΙI.8.21 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο κε έλαλ απφ ηνπο παξαπάλσ ηξφπνπο θαη 

επηιέγνπκε OK. 

ηελ παξαθάησ εηθφλα θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Profile_Rough 

(Δηθόλα IΙI.8.22). 

 Δηθόλα IΙI.8.22 
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Σέινο, γηα λα νινθιεξψζνπκε ηελ αθνινπζία, εηζάγνπκε θαη ην πξνθίι ην νπνίν ζα 

θαηεξγαζηεί ε κεραλή. Απηφ γίλεηαη επηιέγνληαο ηελ πεξίκεηξν ηνπ θνκκαηηνχ, δειαδή 

φιν ην πξνθίι θαη ζην Check Surfs επηιέγνπκε ηελ θάησ επηθάλεηα ηνπ αληηθεηκέλνπ. 

ηε ζπλέρεηα ζέινπκε λα ειέγμνπκε εάλ ε θίλεζε ηνπ θνπηηθνχ είλαη ηθαλή ψζηε λα 

θαηεξγαζηεί ην ζχλνιν ηεο επηθαλείαο πνπ επηιέμακε. ην κελνχ πνπ καο εκθαλίδεηαη 

ινηπφλ επηιέγνπκε Play path θαη screen play. Δπηιέγνπκε Play θαη βιέπνπκε ηελ πνξεία 

ηνπ θνπηηθνχ (θφθθηλε γξακκή) (Δηθόλεο IΙI.8.23). 

 

 Δηθόλεο IΙI.8.23 
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πσο θαίλεηαη θαη ζηελ γξαθηθή απεηθφληζε, έρνπκε ξπζκίζεη έηζη ηηο παξακέηξνπο 

(έρνπκε νξίζεη λα απνκείλνπλ 20,5mm πιηθνχ ζην Chk srf stock allow), ψζηε ην θνπηηθφ 

λα κελ ρηππά ζηηο ζηαγφλεο ηεο κέγγελεο. Γηα λα βεβαησζνχκε ζα εθηειέζνπκε κηα 

γξαθηθή πξνζνκνίσζε ηεο θνπήο κε ην Vericut (Δηθόλα IΙI.8.24). ην Vericut, εάλ 

ππάξρεη ιάζνο εκθαλίδεηαη κε θφθθηλν ρξψκα. 

 Δηθόλα IΙI.8.24 

 

ην Vericut δελ ππάξρεη ιάζνο θαη ε εηθφλα πνπ εκθαλίδεηαη καο ηθαλνπνηεί θαη έηζη 

επηιέγνπκε Done seq γηα λα νινθιεξψζνπκε ηελ δεκηνπξγία ηεο θαηεξγαζίαο. 

 

ηελ ζπλέρεηα θαηαζθεπάδνπκε κε ηνλ ίδην ηξφπν κηα αθνινπζία θαηεξγαζίαο ηνπ 

πξνζψπνπ ηνπ αληηθεηκέλνπ γηα ηελ απνπεξάησζε ηεο επηθάλεηαο (Finish). Δηζάγνπκε 

σο φλνκα Profile_Finish, επηιέγνπκε ην ίδην θνπηηθφ θαη ζην παξάζπξν επηινγψλ ησλ 

παξακέηξσλ είηε θάλνπκε έλαλ απφ ηνπο πξναλαθεξφκελνπο ηξφπνπο είηε επηιέγνπκε 

Edit →  Copy from Sequence θαη επηιέγνπκε ηελ πξνεγνχκελε αθνινπζία 

Profile_rough. Οη παξάκεηξνη θαίλνληαη ζηε επφκελε εηθφλα (Δηθόλα IΙI.8.25). 
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 Δηθόλα IΙI.8.25 

Ζ πνξεία ηνπ θνπηηθνχ ζηελ Profile_Finish θαίλεηαη ζηελ Δηθόλα IΙI.8.26: 

 Δηθόλα IΙI.8.26 
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Καη ε πξνζνκνίσζε θνπήο θαη ησλ 2 παξαπάλσ αθνινπζηψλ ζην Vericut: 

 

 

iii. Ακολοσθία καηεργαζίας διάηρηζης (Holemaking) 

Με ηελ δεκηνπξγία ηεο αθνινπζίαο δηάηξεζεο κπνξνχκε λα εθηειέζνπκε νπέο ζην 

θαηεξγαδφκελν αληηθείκελν. Τπάξρνπλ δηάθνξνη ηχπνη πνπ κπνξνχκε λα επηιέμνπκε ζε 

απηήλ ηελ θαηεξγαζία. Οη ηχπνη πνπ κπνξνχλ λα ρξεζηκνπνηεζνχλ είλαη:  

 ν ηχπνο drill: αλαθέξεηαη ζε θιαζζηθή δηάλνημε νπήο απφ θνπηηθφ εξγαιείν. Οη 

επηινγέο ζε απηφλ ηνλ ηχπν είλαη: Standard, Deep, Break Chip, Web, Back.  

 ν ηχπνο face: αλαθέξεηαη ζηε δεκηνπξγία νπήο κε δηαζθάιηζε νκαιήο επηθάλεηαο 

ζηε βάζε ηεο νπήο.   

 ν ηχπνο bore: αλαθέξεηαη ζηε δηάλνημε κηαο ηειηθήο νπήο κε κεγάιε αθξίβεηα.  

 ν ηχπνο countersink: αλαθέξεηαη ζηε δηάλνημε ηεο αξρήο ηεο νπήο κε θαηάιιεια 

δηακνξθσκέλν εξγαιείν, ψζηε λα δεκηνπξγήζεη εζσηεξηθφ chamfer ζηελ αθκή 

ηεο νπήο (θσληθή νπή). Ζ επηινγή ζε απηφλ ηνλ ηχπν είλαη Back, γηα back 

countersinking. 

 ν ηχπνο tap: αλαθέξεηαη ζηελ δεκηνπξγία ζπεηξψκαηνο ζε ππάξρνπζα νπή. Οη 

επηινγέο ζε απηφλ ηνλ ηχπν είλαη Fixed θαη Floating. 

 ν ηχπνο ream: αλαθέξεηαη ζηελ απνπεξάησζε κηαο νπήο κε πςειή αθξίβεηα.  
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 ν ηχπνο custom: αλαθέξεηαη ζηε δηάλνημε θαη ρξεζηκνπνίεζε επηζπκεηψλ θχθισλ 

θαηεξγαζίαο γηα ην ηξέρσλ θνπηηθφ εξγαιείν κεραλήο. 

 ηχπνο drill 

 ηχπνο countersink 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο δηάηξεζεο είλαη: 

 Cut feed 

 Clear dist 

 Scan type: Ζ παξάκεηξνο απηή θαζνξίδεη ηε ζεηξά κε ηελ νπνία ζα γίλνπλ νη νπέο.  

Οη επηινγέο είλαη: 

- Type 1, ζηελ νπνία ην θνπηηθφ ζθαλάξεη ηελ επηθάλεηα ηνπ αληηθεηκέλνπ, 

απμάλνληαο ην Y θαη ελαιιάζζνληαο ην X 

- Type spiral, ζηελ νπνία ην θνπηηθφ εθηειεί δεμηφζηξνθε ζπεηξνεηδή θίλεζε, 

αξρίδνληαο απφ ηελ πιεζηέζηεξε νπή ζην ζχζηεκα ζπληεηαγκέλσλ. 

- Type one dir, ζηελ νπνία ην θνπηηθφ ζθαλάξεη ηελ επηθάλεηα ηνπ 

αληηθεηκέλνπ, απμάλνληαο ην X θαη κεηψλνληαο ην Y. 

- Pick order, ζηελ νπνία ην θνπηηθφ δεκηνπξγεί νπέο κε ηελ ζεηξά πνπ έρεη 

νξίζεη ν ρξήζηεο. 

- Shortest, ζηελ νπνία ην θνπηηθφ δεκηνπξγεί νπέο κε ηέηνηα ζεηξά ψζηε λα 

δηαλχεη ηελ κηθξφηεξε δπλαηή δηαδξνκή. 

 Breakout distance: θαζνξίδεη ηελ απφζηαζε πνπ πξέπεη λα δηαλχζεη ην θνπηηθφ, 

ψζηε λα έρνπκε κηα ηθαλνπνηεηηθή νπή. Δμαξηάηαη απφ ηελ θσληθφηεηα ηνπ 

θνπηηθνχ. 
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 Rapto dist: θαζνξίδεη ηελ απφζηαζε επηζηξνθήο θαη επηηξέπεη ηελ θίλεζε ηνπ 

θνπηηθνχ κε ηαρεία πξφσζε αθφκα θαη θάησ απφ ηελ απφζηαζε αζθαιείαο (clear 

dist). 

 Spindle speed 

 

Γημιοσργία ηης ακολοσθίας καηεργαζίας διάηρηζης 

Θα δεκηνπξγήζνπκε δχν θιαζζηθέο νπέο δηαθνξεηηθψλ δηακέηξσλ, κηα κε δηάκεηξν 8mm 

θαη κηα κε δηάκεηξν 9mm. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία δηάηξεζεο επηιέγνπκε Machining → NC 

Sequence → New Sequence → Holemaking → Done (Δηθόλα IΙI.8.27), θαη ζην επφκελν 

κελνχ πνπ καο εκθαλίδεηαη επηιέγνπκε ην Drill θαη Standard (Δηθόλα IΙI.8.28) θαη 

επηιέγνπκε Done θαη ζην επφκελν κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη 

επηιεγκέλα ηα: Name, Tool, Parameters θαη Holes (Δηθόλα IΙI.8.29) θαη επηιέγνπκε 

Done. 

 

 Δηθόλα IΙI.8.27   Δηθόλα IΙI.8.28    Δηθόλα IΙI.8.29    
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ηε ζπλέρεηα εηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Hole 1) γηα ηελ νπή δηακέηξνπ 8mm 

θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.30: 

 Δηθφλα IΙI.8.30 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο κε έλαλ απφ ηνπο ηξφπνπο πνπ έρνπκε 

αλαθέξεη θαη επηιέγνπκε OK. 

ηελ παξαθάησ εηθφλα θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Hole 1 (Δηθόλα 

IΙI.8.31). 

 Δηθφλα IΙI.8.31 
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ηε ζπλέρεηα, ζην παξάζπξν πνπ εκθαλίδεηαη (Δηθόλα IΙI.8.32) εηζάγνπκε ηνλ άμνλα ηεο 

νπήο πνπ ζα δεκηνπξγήζνπκε. ην παξάζπξν, ινηπφλ, απηφ επηιέγνπκε Single θαη Add 

θαη επηιέγνπκε ηνλ επηζπκεηφ άμνλα θαη OK θαη ζηε ζπλέρεηα Done. 

 Δηθόλα IΙI.8.32 

 

ηε ζπλέρεηα ζέινπκε λα ειέγμνπκε ηελ θίλεζε ηνπ θνπηηθνχ. ην κελνχ πνπ καο 

εκθαλίδεηαη επηιέγνπκε Play path θαη screen play. Δπηιέγνπκε Play θαη βιέπνπκε ηελ 

πνξεία ηνπ θνπηηθνχ (θφθθηλε γξακκή) (Δηθόλα IΙI.8.33). 
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 Δηθόλα IΙI.8.33 

 

πλερίδνπκε κε ηνλ ίδην ηξφπν ηελ δεκηνπξγία νπήο δηακέηξνπ 9mm. Δηζάγνπκε ην 

φλνκα ηεο αθνινπζίαο (Hole 2) θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.34: 

Δηθόλα IΙI.8.34 
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ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο κε έλαλ απφ ηνπο ηξφπνπο πνπ έρνπκε 

αλαθέξεη θαη επηιέγνπκε OK. 

ηελ παξαθάησ εηθφλα θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Hole 2 (Δηθόλα 

IΙI.8.35). 

 Δηθόλα IΙI.8.35 

ηε ζπλέρεηα, επηιέγνπκε ηνλ άμνλα ηεο νπήο πνπ ζέινπκε λα δεκηνπξγήζνπκε θαη 

επηιέγνπκε OK θαη ζηε ζπλέρεηα Done. 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλα IΙI.8.36). 
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 Δηθόλα IΙI.8.36 

ηελ Δηθόλα IΙI.8.37 βιέπνπκε ηελ πξνζνκνίσζε θαη ησλ 2 νπψλ ζην πξφγξακκα 

Vericut. 

 Δηθόλα IΙI.8.37 
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iv. Ακολοσθία καηεργαζίας όγκοσ (Volume) 

Με ηελ αθνινπζία θαηεξγαζίαο φγθνπ κπνξνχκε λα θαηεξγαζηνχκε έλα κεγάιν θνκκάηη 

ζην αληηθείκελφ καο (Δηθόλα IΙI.8.38), αθνχ κπνξνχκε λα δεκηνπξγήζνπκε αθνινπζίεο 

εθρφλδξηζεο πνπ αθαηξνχλ κεγάιν κέξνο ηνπ πξνο θαηεξγαζία φγθνπ, κε ζρεηηθά εχθνιν 

ηξφπν, παξάιιεια πάληα πξνο ηελ επηθάλεηα επηζηξνθήο. 

                  Δηθόλα IΙI.8.38 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο φγθνπ είλαη: 

 Cut feed  

 Step depth  

 Step over 

 Clear dist  

 Cut angle 

 Bottom stock allow  

 Spindle speed 

 Rough option: αλαθέξεηαη ζηελ επηινγή ηνπ είδνπο ηεο θαηεξγαζίαο, δειαδή ηη 

θαηεξγαζίεο ζα γίλνπλ θαη κε πνηα ζεηξά. Οη επηινγέο είλαη: 

- Rough only, ζηελ νπνία ην θνπηηθφ θάλεη εθρφλδξηζε ηνπ φγθνπ θαη φρη 

απνπεξάησζε ησλ επηθαλεηψλ. 

- Rough & prof, ζηελ νπνία ην θνπηηθφ θάλεη εθρφλδξηζε θαη ζηε ζπλέρεηα 

απνπεξάησζε ησλ επηθαλεηψλ πνπ ζρεκαηίδνπλ ηνλ φγθν. 

- Prof & rough, ζηελ νπνία ην θνπηηθφ θάλεη απνπεξάησζε ησλ επηθαλεηψλ 

πνπ ζρεκαηίδνπλ ηνλ φγθν θαη ζηε ζπλέρεηα εθρφλδξηζε ηνπ φγθνπ. 

- Prof only, ζηελ νπνία ην θνπηηθφ θάλεη κφλν απνπεξάησζε ησλ επηθαλεηψλ 

πνπ ζρεκαηίδνπλ ηνλ φγθν. 

- Rough & clean up, ζηελ νπνία ην θνπηηθφ πξνεηνηκάδεη ηα ηνηρψκαηα ηνπ 

φγθνπ ρσξίο λα θάλεη απνπεξάησζε ησλ επηθαλεηψλ. 

- Pocketing, ζηελ νπνία ην θνπηηθφ θάλεη απνπεξάησζε ησλ επηθαλεηψλ πνπ 

ζρεκαηίδνπλ ηνλ φγθν θαη ζηε ζπλέρεηα απνπεξάησζε ησλ επηθαλεηψλ πνπ 

είλαη παξάιιειεο ζην επίπεδν επηζηξνθήο. 

- Faces only, ζηελ νπνία ην θνπηηθφ θάλεη απνπεξάησζε ησλ επηθαλεηψλ πνπ 

είλαη παξάιιειεο ζην επίπεδν επηζηξνθήο. 
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 Scan type: είλαη ε ηαθηηθή θαηεξγαζίαο θαη ειέγρεη ηνλ ηξφπν κε ηνλ νπνίν 

θηλείηαη ην θνπηηθφ πάλσ ζηελ αθαηέξγαζηε επηθάλεηα. Οη επηινγέο πνπ κπνξεί λα 

πάξεη είλαη:  
 

- Type 1: ζηελ νπνία ην θνπηηθφ θαηεξγάδεηαη ζπλερψο ηνλ φγθν θαη 

αλαζχξεηαη ζε ηπρφλ λεζίδεο πνπ δελ πξέπεη λα θαηεξγαζηνχλ.   

- Type 2: ζηελ νπνία ην θνπηηθφ θαηεξγάδεηαη ζπλερψο ηνλ φγθν, ρσξίο λα 

αλαζχξεηαη, θαη θηλείηαη γχξσ απφ λεζίδεο πνπ δελ πξέπεη λα θαηεξγαζηνχλ.  

- Type 3: ζηελ νπνία ην θνπηηθφ θαηεξγάδεηαη ηνλ φγθν ζε ζπλερείο δψλεο πνπ 

έρνπλ θαζνξηζηεί  απφ ηηο λεζίδεο πνπ δελ πξέπεη λα θαηεξγαζηνχλ. 

- Type spiral: ζηελ νπνία ην θνπηηθφ αθνινπζεί ζπεηξνεηδή ηξνρηά  

- Type one dir: ζηελ νπνία ην θνπηηθφ θαηεξγάδεηαη κφλν ζηελ θίλεζε θαηά ηε 

κηα θνξά θαη απνκαθξχλεηαη κεηαμχ ησλ δηαδνρηθψλ πεξαζκάησλ.  

- Type 1 connect: ζηελ νπνία ην θνπηηθφ θαηεξγάδεηαη κφλν ζηελ θίλεζε θαηά 
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ηε κηα θνξά, θαη εάλ ζηελ αξρή ηνπ θάζε πεξάζκαηνο ζπλαληήζεη θνκκάηη πνπ 

δελ πξέπεη λα θαηεξγαζηεί, αθνινπζεί ηνλ ηνίρν. 

- Constant load: ζηελ νπνία ην θνπηηθφ εθηειεί κηα θαηεξγαζία πςειήο 

ηαρχηεηαο (high speed machining) γηα εθρφλδξηζε (κε ην ROUGH_OPTION λα 

είλαη ROUGH_ONLY) ή απνπεξάησζε (κε ην ROUGH_OPTION λα είλαη 

PROF_ONLY).  

- Spiral maintain cut direction: ζηελ νπνία ην θνπηηθφ εθηειεί κηα θαηεξγαζία 

πςειήο ηαρχηεηαο (high speed machining) ελψ αθνινπζεί ζπεηξνεηδή ηξνρηά 

κε ζχλδεζε S κεηαμχ ησλ πεξαζκάησλ. 

- Spiral maintain cut type: ζηελ νπνία ην θνπηηθφ εθηειεί κηα θαηεξγαζία 

πςειήο ηαρχηεηαο (high speed machining), ελψ αθνινπζεί ζπεηξνεηδή ηξνρηά 

κε ηνμνεηδή ζχλδεζε κεηαμχ πεξαζκάησλ. 

- Follow hardwalls: ζηελ νπνία ην θνπηηθφ εθηειεί κηα θαηεξγαζία πςειήο 

ηαρχηεηαο (high speed machining) ελψ ην ζρήκα θάζε θνπήο αθνινπζεί ην 

ζρήκα ησλ ηνηρσκάησλ ηνπ φγθνπ. 

 

 

 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

97 

 

 Rough stock allow: ε παξάκεηξνο απηή αλαθέξεηαη ζην 

πάρνο ηνπ αθαηέξγαζηνπ πιηθνχ γηα ηα πεξάζκαηα 

εθρφλδξηζεο. 

 

 Prof stock allow: ε παξάκεηξνο απηή αλαθέξεηαη ζην πάρνο 

ηνπ αθαηέξγαζηνπ πιηθνχ γηα ηα πεξάζκαηα απνπεξάησζεο.  

 

 

Γημιοσργία ηης ακολοσθίας καηεργαζίας όγκοσ 

ην αληηθείκελφ καο ζα δεκηνπξγήζνπκε δχν αθνινπζίεο θαηεξγαζίαο φγθνπ, γηα 

εθρφλδξηζε θαη απνπεξάησζε ηεο θπθιηθήο εζνρήο δηακέηξνπ 20mm θαη βάζνπο 5mm. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο φγθνπ επηιέγνπκε Machining → NC 

Sequence → New Sequence → Volume → Done (Δηθόλα IΙI.8.38) θαη ζην επφκελν 

κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη επηιεγκέλα ηα: Name, Tool, 

Parameters, Volume θαη Top Surfaces (Δηθόλα IΙI.8.39) θαη επηιέγνπκε Done. 

 Δηθόλα IΙI.8.38   Δηθόλα IΙI.8.39 
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ην παξάζπξν ηεο Δηθόλαο IΙI.8.39 έρνπλ εκθαληζηεί νη επηινγέο Volume, Window, 

Close Loops, Excld Surfs, Top surfaces, Appr Walls. Απφ ηηο δχν πξψηεο, ε κηα είλαη 

δπλαηφλ λα επηιεγεί θαη λα νξίζεη ηνλ φγθν πνπ ζα θαηεξγαζηνχκε. Ζ επηινγή Close 

Loops αλαθέξεηαη ζε θιεηζηέο επηθάλεηεο, ε επηινγή Excld Surfs αλαθέξεηαη ζηηο 

επηθάλεηεο πνπ ζα απνθιεηζηνχλ απφ ηελ απνπεξάησζε, ε επηινγή Top surfaces 

αλαθέξεηαη ζηελ πάλσ επηθάλεηα ηνπ φγθνπ θαη ε επηινγή Appr Walls αλαθέξεηαη ζηηο 

δπλαηέο επηθάλεηεο απφ ηηο νπνίεο ην θνπηηθφ κπνξεί λα πξνζεγγίζεη ηνλ φγθν. 

Αθνχ έρνπκε επηιέμεη ηηο θαηάιιειεο επηινγέο απφ ην Seq Setup κελνχ, ζηε ζπλέρεηα 

εηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Circular Vol Rough) γηα ηελ εθρφλδξηζε ηεο 

θπθιηθήο εζνρήο θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.40: 

Δηθόλα IΙI.8.40 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο θαη επηιέγνπκε OK. ηελ παξαθάησ εηθφλα 

θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Circular Vol Rough (Δηθόλα IΙI.8.41). 
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Δηθόλα IΙI.8.41 

ηελ ζπλέρεηα γηα λα νξίζνπκε ηνλ φγθν πνπ ζα θαηεξγαζηνχκε, πξέπεη είηε λα νξίζνπκε 

έλα ήδε δεκηνπξγεκέλν είηε λα ηνλ δεκηνπξγήζνπκε κε ην Mill Volume Tool, φπσο 

θαίλεηαη ζηελ παξαθάησ εηθφλα:  
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ρεδηάδνπκε ινηπφλ ηνλ φγθν ζην Sketcher (έρνληαο νξίζεη έλα επίπεδν ζηελ επηθάλεηα 

ηνπ ηειηθνχ αληηθεηκέλνπ) θαη κεηά ηνλ θάλνπκε Extrude γηα λα ηνλ δεκηνπξγήζνπκε. 

ηελ ζπλέρεηα επηιέγνπκε σο top surface ηελ πάλσ επηθάλεηα ηνπ φγθνπ. 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλεο IΙI.8.42). 

 

 Δηθόλεο IΙI.8.42 
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ηελ ζπλέρεηα βιέπνπκε ηελ πξνζνκνίσζε θνπήο ζην Vericut (Δηθόλα IΙI.8.43). 

 Δηθόλα IΙI.8.43 

Γηα λα θαηεξγαζηνχκε θαη ην πιηθφ πνπ έρεη απνκείλεη απφ ηελ εθρφλδξηζε, φπσο 

θαίλεηαη θαη ζηελ εηθφλα ηεο πξνζνκνίσζεο, ζα θάλνπκε απνπεξάησζε ηεο επηθάλεηαο. 

Με ηνλ ίδην ηξφπν, εηζάγνπκε ην φλνκα (Circular Vol Finish) γηα ηελ απνπεξάησζε ηεο 

θπθιηθήο εζνρήο θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.44: 

Δηθόλα IΙI.8.44 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο, αλαθηψληαο ηηο παξακέηξνπο ηεο αθνινπζίαο 
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Circular Vol Rough θαη αιιάδνληαο ηηο επηζπκεηέο θαη επηιέγνπκε OK. ηελ παξαθάησ 

εηθφλα θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Circular Vol Finish (Δηθόλα IΙI.8.45) 

 Δηθόλα IΙI.8.45 

Δπηιέγνπκε θαη ηνλ φγθν πνπ έρνπκε δεκηνπξγήζεη ζηελ πξνεγνχκελε αθνινπζία, ζηελ 

Circular Vol Rough, γηα λα νινθιεξψζνπκε ηελ αθνινπζία. 

Ζ πνξεία ηνπ θνπηηθνχ (θφθθηλε γξακκή) θαίλεηαη ζηελ παξαθάησ εηθφλα (Δηθόλα 

IΙI.8.46) θαη ε πξνζνκνίσζε θνπήο ζην πξφγξακκα Vericut ζηελ Δηθόλα IΙI.8.47. 

 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

103 

 

 Δηθόλα IΙI.8.46 

 

 Δηθόλα IΙI.8.47 
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ηελ παξαθάησ εηθφλα παξνπζηάδεηαη ε πξνζνκνίσζε θνπήο θαη ησλ 2 παξαπάλσ 

αθνινπζηψλ (εθρφλδξηζε θαη απνπεξάησζε ηεο θπθιηθήο εζνρήο), ζην πξφγξακκα 

Vericut. 
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v. Ακολοσθία καηεργαζίας βύθιζης (Plunge) 

Ζ αθνινπζία θαηεξγαζίαο βχζηζεο ρξεζηκνπνηείηαη γηα λα γίλεη εθρφλδξηζε θνηινηήησλ 

κεγάινπ βάζνπο. Ζ θαηεξγαζία απηή  γίλεηαη κε δηαδνρηθά βπζίζκαηα ηνπ θνπηηθνχ κέζα 

ζηνλ φγθν ηνπ θνκκαηηνχ (Δηθόλα IΙI.8.48). 

     Δηθόλα IΙI.8.48 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο βχζηζεο είλαη: 

 Cut feed  

 Clear dist  

 Cut angle 

 Spindle speed 

 Scan type (type 3, type spiral, type one dir) 

 Prof stock allow 

 Chk srf stock allow 

 Plunge step: ε παξάκεηξνο απηή νξίδεη ηελ απφζηαζε κεηαμχ δχν δηαδνρηθψλ 

βπζίζεσλ ηνπ θνπηηθνχ εξγαιείνπ. 

 

Γημιοσργία ηης ακολοσθίας καηεργαζίας βύθιζης 

ην αληηθείκελφ καο ζα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο βχζηζεο γηα ηελ 

εθρφλδξηζε ησλ δχν ηξηγσληθψλ εζνρψλ. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία βχζηζεο επηιέγνπκε Machining → NC Sequence 

→ New Sequence → Plunge → Done (Δηθόλα IΙI.8.49) θαη ζην επφκελν κελνχ πνπ καο 

εκθαλίδεηαη θξνληίδνπκε λα είλαη επηιεγκέλα ηα: Name, Tool, Parameters, Surfaces θαη 

Check Surfs (Δηθόλα IΙI.8.50) θαη επηιέγνπκε Done. 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

 

106 

 

  Δηθόλα IΙI.8.49     Δηθόλα IΙI.8.50 

Δηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Plunge) θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.51: 

 Δηθόλα IΙI.8.51 
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ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο θαη επηιέγνπκε OK. ηελ παξαθάησ εηθφλα 

θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Plunge (Δηθόλα IΙI.8.52). 

 Δηθόλα IΙI.8.52 

ηελ ζπλέρεηα ζα επηιέμνπκε ηηο επηθάλεηεο πνπ ζα θαηεξγαζηνχκε. Δπηιέγνπκε Model 

θαη Done 
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Καη ζην κελνχ πνπ καο εκθαλίδεηαη επηιέγνπκε Add θαη ηηο επηθάλεηεο πνπ ζα 

θαηεξγαζηνχκε (Δηθόλα IΙI.8.53). 

 Δηθόλα IΙI.8.53 

Έπεηηα, καο δεηείηαη λα νξίζνπκε ηελ επηθάλεηα ζηελ νπνία ζα απνκείλεη πιηθφ πάρνπο 

κεηά ην ηέινο ηεο θαηεξγαζίαο θαη έηζη επηιέγνπκε ηηο ίδηεο επηθάλεηεο, δειαδή ηελ θάησ 

επηθάλεηα ησλ θνηινηήησλ, γηα λα νινθιεξψζνπκε ηελ ξχζκηζε ηεο αθνινπζίαο. 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλα IΙI.8.54). 
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 Δηθόλα IΙI.8.54 

Καη ηελ πξνζνκνίσζε θνπήο ζην πξφγξακκα Vericut (Δηθόλα IΙI.8.55). 

 Δηθόλα IΙI.8.55 
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vi. Ακολοσθία καηεργαζίας κοιλόηηηας (Pocketing) 

Ζ αθνινπζία θαηεξγαζίαο θνηιφηεηαο ρξεζηκνπνηείηαη γηα λα γίλεη απνπεξάησζε 

θνηινηήησλ. Με ηελ αθνινπζία απηή, ην θνπηηθφ εξγαιείν θαηεξγάδεηαη πξψηα ην 

πξνθίι  ηεο θνηιφηεηαο θαη ζηε ζπλέρεηα ηελ θάησ επηθάλεηά ηεο (Δηθόλα IΙI.8.56). 

         Δηθόλα IΙI.8.56 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο θνηιφηεηαο είλαη: 

 Cut feed  

 Step depth  

 Step over 

 Clear dist  

 Cut angle 

 Spindle speed 

 Scan type (type 1, type 2, type 3, type spiral, type one dir) 

 Prof stock allow 

 Bottom stock allow  

 Wall scallop hgt: ε παξάκεηξνο απηή ειέγρεη ην βάζνο θνπήο. πλήζσο παίξλεη 

ηελ ηηκή 0 θαη σο βάζνο θνπήο νξίδεηαη ην Step depth. Αλ πάξεη κεγαιχηεξε ηνπ 

κεδελφο ηηκή, ηφηε νξίδεηαη ην κηθξφηεξν απφ ηα δχν. 

Γημιοσργία ηης ακολοσθίας καηεργαζίας κοιλόηηηας 

ην αληηθείκελφ καο ζα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο θνηιφηεηαο γηα ηελ 

απνπεξάησζε ησλ δχν ηξηγσληθψλ εζνρψλ. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία θνηιφηεηαο επηιέγνπκε Machining → NC 

Sequence → New Sequence → Pocket → Done (Δηθόλα IΙI.8.57) θαη ζην επφκελν κελνχ 

πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη επηιεγκέλα ηα: Name, Tool, Parameters θαη 

Surfaces (Δηθόλα IΙI.8.58) θαη επηιέγνπκε Done. 
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 Δηθόλα IΙI.8.57    Δηθόλα IΙI.8.58 

Δηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Pocket) θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.59: 

 Δηθόλα IΙI.8.59 
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ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο θαη επηιέγνπκε OK. ηελ παξαθάησ εηθφλα 

θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Pocket (Δηθόλα IΙI.8.60). 

 Δηθόλα IΙI.8.60 

ηελ ζπλέρεηα ζα επηιέμνπκε ηηο επηθάλεηεο πνπ ζα θαηεξγαζηνχκε. Δπηιέγνπκε Model 

θαη Done, θαη επηιέγνπκε ηηο 2 ηξηγσληθέο θνηιφηεηεο. 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλα IΙI.8.61). 
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 Δηθόλα IΙI.8.61 

ηελ παξαθάησ εηθφλα (Δηθόλα IΙI.8.62) παξνπζηάδεηαη ε πξνζνκνίσζε θνπήο θαη ησλ 2 

παξαπάλσ αθνινπζηψλ (εθρφλδξηζε θαη απνπεξάησζε ησλ ηξηγσληθψλ εζνρψλ), ζην 

πξφγξακκα Vericut. 

 Δηθόλα IΙI.8.62 
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vii. Ακολοσθία καηεργαζίας όγκοσ ζε ηροτιά (Trajectory) 

Με ηελ αθνινπζία θαηεξγαζίαο φγθνπ ζε ηξνρηά, ην θνπηηθφ θαηεξγάδεηαη ην πιηθφ ηνπ 

αληηθεηκέλνπ, αθνινπζψληαο κηα ζπγθεθξηκέλε ηξνρηά (Δηθόλεο IΙI.8.63). 

     Δηθόλεο IΙI.8.63 

 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο φγθνπ ζε ηξνρηά είλαη: 

 Cut feed 

 Prof stock allow 

 Clear dist  

 Spindle speed 

 

Γημιοσργία ηης ακολοσθίας καηεργαζίας όγκοσ ζε ηροτιά 

ην αληηθείκελφ καο ζα δεκηνπξγήζνπκε δχν αθνινπζίεο θαηεξγαζίαο φγθνπ ζε ηξνρηά, 

κηα γηα ηηο εκηθπθιηθέο εγθνπέο θαη κηα γηα ηελ θαηεξγαζία ηνπ θπθιηθνχ ηκήκαηνο. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο φγθνπ ζε ηξνρηά επηιέγνπκε 

Machining → NC Sequence → New Sequence → Trajectory → Done (Δηθόλα IΙI.8.64) 

θαη ζην επφκελν κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη επηιεγκέλα ηα: Name, 

Tool, Parameters θαη Tool Motions (Δηθόλα IΙI.8.65) θαη επηιέγνπκε Done. 
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 Δηθόλα IΙI.8.64    Δηθόλα IΙI.8.65 

Δηζάγνπκε ην φλνκα ηεο αθνινπζίαο (Traject) θαη παηάκε Enter. 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ, φπσο θαίλεηαη ζηελ Δηθόλα 

IΙI.8.66: 
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 Δηθόλα IΙI.8.66 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο θαη επηιέγνπκε OK. ηελ παξαθάησ εηθφλα 

θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Traject (Δηθόλα IΙI.8.67). 

 

 Δηθόλα IΙI.8.67 
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ηε ζπλέρεηα, εκθαλίδεηαη ην παξάζπξν ηεο Δηθόλαο IΙI.8.68, ζην νπνίν ζα εηζάγνπκε 

ηελ θίλεζε θνπήο ηνπ εξγαιείνπ. 

 Δηθόλα IΙI.8.68 

Δπηιέγνπκε ην Curve Cut θαη κεηά Insert θαη κεηαθεξφκαζηε ζην παξάζπξν ηνπ Curve 

Trajectory Setup θαη δηακνξθψλνπκε ηελ ηξνρηά ηνπ θνπηηθνχ, φπσο θαίλεηαη ζηελ 

Δηθόλα IΙI.8.69. 

 Δηθόλα IΙI.8.69 

Δπίζεο, νξίδνπκε σο χςνο αλαθνξάο ηελ θακπχιε θαη απφ ηελ επηινγή Details → 

Options, νξίδνπκε ηηο επηθάλεηεο πνπ ζα νξηνζεηνχλ ηελ ηξνρηά ηεο θίλεζεο ηνπ 

θνπηηθνχ. 
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Έπεηηα, νξίδνπκε θαη ηηο ππφινηπεο ηξνρηέο κε ηνλ ίδην ηξφπν (Δηθόλα IΙI.8.70). Σν 

θνπηηθφ εθηειεί ηελ θίλεζε, αθνινπζψληαο, κε ηελ ζεηξά, ηηο ηξνρηέο πνπ έρνπκε νξίζεη 

ζην Tool Motions.  

 Δηθόλα IΙI.8.70 
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Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλεο IΙI.8.71). 

 

 

 Δηθόλεο IΙI.8.71 
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Ζ πξνζνκνίσζε θνπήο ζην Vericut παξνπζηάδεηαη ζηελ Δηθόλα IΙI.8.72. 

 Δηθόλα IΙI.8.72 

ηε ζπλέρεηα ζα θαηεξγαζηνχκε ηνλ φγθν κηαο θπθιηθήο ηξνρηάο. Με ηνλ ίδην ηξφπν, 

νξίδνπκε ην φλνκα ηεο αθνινπζίαο (Traject 2). Έπεηηα επηιέγνπκε ην θνπηηθφ καο κε 

δηάκεηξν 8mm, φπσο θαίλεηαη ζηελ Δηθόλα IΙI.8.73. 

 Δηθόλα IΙI.8.73 
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Οξίδνπκε ηηο παξακέηξνπο, ίδηεο κε ηεο πξνεγνχκελεο αθνινπζίαο, επηιέγνληάο ηελ απφ 

ην Edit → Copy from Sequence 

 

Καη ζηε ζπλέρεηα, νξίδνπκε ηελ ηξνρηά πνπ ζα αθνινπζήζεη ην θνπηηθφ, κε ηελ ίδηα 

παξαπάλσ δηαδηθαζία (Δηθόλεο IΙI.8.74). 

 

 Δηθόλεο IΙI.8.74 
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Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλα IΙI.8.75). 

 Δηθόλα IΙI.8.75 

ηελ παξαθάησ εηθφλα βιέπνπκε ηελ πξνζνκνίσζε θνπήο θαη ησλ 2 παξαπάλσ 

αθνινπζηψλ Trajectory ζην πξφγξακκα Vericut. 
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ην ζεκείν απηφ, ζα εθηειέζνπκε κηα αθνινπζία θαηεξγαζίαο φγθνπ  (Volume), γηα λα 

θαηεξγαζηνχκε ηελ εκηθπθιηθή επηθάλεηα ζην θέληξν ηνπ αληηθεηκέλνπ καο. Ζ 

αθνινπζία (Vol_cycle) ζα δεκηνπξγεζεί κε ηνλ ηξφπν πνπ έρνπκε πξναλαθέξεη. 

Οξίδνπκε απιά ην θνπηηθφ εξγαιείν, ίδην κε ηεο αθνινπζίαο  Circular Vol Rough, θαη νη 

παξάκεηξνη γηα ηελ αθνινπζία Vol_cycle θαίλνληαη ζηε παξαθάησ εηθφλα (Δηθόλα 

IΙI.8.76). 

 Δηθόλα IΙI.8.76 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(Δηθόλα IΙI.8.77). 

 Δηθόλα IΙI.8.77 
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viii. Ακολοσθία καηεργαζίας επιθάνειας (Surface) 

Ζ αθνινπζία θαηεξγαζίαο επηθάλεηαο ρξεζηκνπνηείηαη γηα λα γίλεη εθρφλδξηζε ή 

απνπεξάησζε επηθαλεηψλ πνπ έρνπλ ήδε δεκηνπξγεζεί (Δηθόλεο IΙI.8.78). 

             Δηθόλεο IΙI.8.78 

Οη βαζηθέο παξάκεηξνη ζηελ αθνινπζία θαηεξγαζίαο επηθάλεηαο είλαη: 

 Cut feed 

 Step over 

 Scan type (type 1, type 2, type 3, type spiral, type one dir) 

 Prof stock allow 

 Clear dist  

 Spindle speed 

Γημιοσργία ηης ακολοσθίας καηεργαζίας επιθάνειας 

ην αληηθείκελφ καο ζα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο επηθάλεηαο γηα ηελ 

απνπεξάησζε ηεο εκηθπθιηθήο επηθάλεηαο. 

Γηα λα δεκηνπξγήζνπκε κηα αθνινπζία θαηεξγαζίαο επηθάλεηαο επηιέγνπκε Machining 

→ NC Sequence → New Sequence → Surface Mill→ Done (Δηθόλα IΙI.8.79) θαη ζην 

επφκελν κελνχ πνπ καο εκθαλίδεηαη θξνληίδνπκε λα είλαη επηιεγκέλα ηα: Name, Tool, 

Parameters, Surfaces θαη Define cut (Δηθόλα IΙI.8.80) θαη επηιέγνπκε Done. 



ΚΔΦΑΛΑΗΟ IΗΗ:  PRO/NC 

125 

 

 Δηθόλα IΙI.8.79       Δηθόλα IΙI.8.80 

Απφ ηελ βηβιηνζήθε θνπηηθψλ επηιέγνπκε ην θνπηηθφ ηεο αθνινπζίαο Traject, απφ ην 

File → Use previous (Δηθόλα IΙI.8.81) 

 Δηθόλα IΙI.8.81 

ηε ζπλέρεηα εηζάγνπκε ηηο παξακέηξνπο θαη επηιέγνπκε OK. ηελ παξαθάησ εηθφλα 

θαίλνληαη νη παξάκεηξνη γηα ηελ αθνινπζία Surface (Δηθόλα IΙI.8.82) 
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 Δηθόλα IΙI.8.82 

ηελ ζπλέρεηα ζα επηιέμνπκε ηελ επηθάλεηα πνπ ζα θαηεξγαζηνχκε. Δπηιέγνπκε Model 

θαη Done θαη επηιέγνπκε ηελ επηζπκεηή επηθάλεηα. 

ηελ ζπλέρεηα, ζα επηιέμνπκε ηνλ ηξφπν κε ηνλ νπνίν ζα γίλεη ε απνπεξάησζε ηεο 

επηθάλεηαο. Οη επηινγέο είλαη:  

 

- Straight cut: ην θνπηηθφ εθηειεί παξάιιεια 

πεξάζκαηα ππφ γσλία κε ηνλ άμνλα Υ, θάπνηα αθκή ή 

θάπνηα άιιε επηθάλεηα. 

- From surfaces isolines: ην θνπηηθφ θηλείηαη ζχκθσλα 

κε ηηο ηζνπαξακεηξηθέο θακπχιεο ηεο επηθάλεηαο. 

- Cut line: ην θνπηηθφ εθηειεί θίλεζε βάζεη ηεο αξρηθή 

θακπχιεο, ηεο ηειηθήο θαη κεξηθψλ ελδηάκεζσλ. 

- Projected cuts: ην θνπηηθφ αθνινπζεί κηα πνξεία πνπ 

έρεη νξηζηεί ζε επίπεδν παξάιιειν ζηελ επηθάλεηα, 

πξνβάιινληάο ηελ ζε απηήλ. 
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Δπηιέγνπκε ην Projected cuts θαη νξίδνπκε ην Mill Window ηεο εκηθπθιηθήο επηθάλεηαο, 

σο πξνβεβιεκέλε πνξεία (Δηθόλα IΙI.8.83). 

 Δηθόλα IΙI.8.83 

 

Δπηιέγνληαο Play path θαη screen play θαη κεηά Play βιέπνπκε ηελ πνξεία ηνπ θνπηηθνχ 

(θφθθηλε γξακκή) (Δηθόλα IΙI.8.84). 

 Δηθόλα IΙI.8.84 
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ηελ παξαθάησ εηθφλα (Δηθόλα IΙI.8.85) βιέπνπκε ηελ πξνζνκνίσζε θνπήο ζην 

πξφγξακκα Vericut ησλ δχν ηειεπηαίσλ αθνινπζηψλ (Volume θαη Surface), ηεο 

εκηθπθιηθήο επηθάλεηαο πνπ βξίζθεηαη ζην θέληξν ηνπ αληηθεηκέλνπ. 

Δηθόλα IΙI.8.85 
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9. Πληποθοπίερ καηεπγαζίαρ  

Καηά ηελ δηάξθεηα ζρεδηαζκνχ ησλ αθνινπζηψλ, κπνξνχκε λα παίξλνπκε πιεξνθνξίεο 

γηα απηέο, φπσο γηα παξάδεηγκα ηνλ αλακελφκελν ρξφλν ηεο θαηεξγαζίαο (Machining 

time), ηα φξηα ηεο θαηεξγαζίαο σο πξνο ην ζχζηεκα ζπληεηαγκέλσλ (Tool travel 

envelope). Τπάξρνπλ δχν ηξφπνη ιήςεο απηψλ ησλ πιεξνθνξηψλ, είηε κε ην παξάζπξν 

πιεξνθνξηψλ, είηε κε ηνλ process manager. 

 Παξάζπξν πιεξνθνξηψλ 

Σν παξάζπξν πιεξνθνξηψλ καο παξέρεη πιεξνθνξίεο γηα ηελ αθνινπζία πνπ 

δεκηνπξγνχκε θάζε θνξά, είηε γηα νιφθιεξε ηελ ιεηηνπξγία. Τπάξρνπλ δηάθνξνη 

ηξφπνη εκθάληζήο ηνπ. Έλαο ηξφπνο είλαη λα επηιέμνπκε Info → Manufacturing θαη 

ζην παξάζπξν πνπ εκθαλίδεηαη, κπνξνχκε λα επηιέμνπκε Operation γηα νιφθιεξε ηελ 

ιεηηνπξγία ή NC Sequence γηα ηελ αθνινπζία πνπ ζέινπκε. Έλαο άιινο ηξφπνο είλαη 

λα επηιέμνπκε κέζσ κηαο ζπγθεθξηκέλεο αθνινπζίαο, απφ ην Menu Manager → Seq 

Info → Done Sel ή επηιέγνπκε ην εηθνλίδην  θαη παηάκε Sequence γηα ηηο 

πιεξνθνξίεο ηεο αθνινπζίαο θαη Operation γηα ηηο πιεξνθνξίεο ηεο ιεηηνπξγίαο. 

Γηα παξάδεηγκα, ην παξάζπξν πιεξνθνξηψλ γηα ηελ αθνινπζία Face Milling 

παξνπζηάδεηαη ζηηο Δηθόλεο IΙI.9.1 
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 Δηθόλεο IΙI.9.1 

 

 Process manager 

Με ηνλ process manager κπνξνχκε λα αληιήζνπκε πιεξνθνξίεο γηα ηηο αθνινπζίεο 

θαη επηπιένλ κπνξνχκε λα επηιέμνπκε πνηεο πιεξνθνξίεο επηζπκνχκε λα 

εκθαλίδνληαη. 

Σν παξάζπξν ηνπ process manager (Δηθόλα IΙI.9.2) εκθαλίδεηαη είηε επηιέγνληαο απφ 

ην Menu Manager → Process Mgr είηε κε ην εηθνλίδην . 

 Δηθόλα IΙI.9.2 
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Δπηπιένλ, κπνξνχκε λα δεκηνπξγήζνπκε έλα ζηηγκηφηππν ζηνλ process manager θαη 

λα επηιέμνπκε ηηο πιεξνθνξίεο πνπ καο ελδηαθέξνπλ λα εκθαλίδνληαη, επηιέγνληαο 

View → View Builder θαη λα ην απνζεθεχζνπκε. 

Αθφκα, επηιέγνληαο φιεο ηηο αθνινπζίεο θαη ζηε ζπλέρεηα επηιέγνληαο Tools → NC 

Check, αλνίγεη απηφκαηα ην πξφγξακκα Vericut, φπνπ κπνξνχκε λα 

παξαθνινπζήζνπκε ηελ πξνζνκνίσζε θνπήο ησλ αθνινπζηψλ πνπ έρνπκε 

δεκηνπξγήζεη. 

10.   Τελική επεξεπγαζία 

Αθνχ νινθιεξψζνπκε κε ηελ δεκηνπξγία ησλ αθνινπζηψλ γηα ηνλ ηειηθφ ζρεδηαζκφ ηνπ 

αληηθεηκέλνπ καο, πξέπεη λα γίλεη κεηαγιψηηηζε ηνπ αξρείνπ ζέζεο ηνπ θνπηηθνχ ζε κηα 

γιψζζα πνπ αληηιακβάλεηαη ε κεραλή πνπ ζα ζπλδέζνπκε. Γηα ην ιφγν απηφ, ζα πξέπεη 

λα γίλεη ζσζηή ξχζκηζε ηνπ post processor, ψζηε λα επηηχρνπκε ην επηζπκεηφ 

απνηέιεζκα. 

Γηα λα δεκηνπξγήζνπκε ην αξρείν ζέζεο θνπηηθνχ ησλ αθνινπζηψλ, επηιέγνπκε απφ ην 

Menu Manager → CL Data θαη επηιέγνπκε είηε γηα νιφθιεξε ηε ιεηηνπξγία είηε γηα 

φπνηεο αθνινπζίεο ζέινπκε (set of NC Sequences) είηε γηα κηα αθνινπζία. 

Δπηιέγνπκε λα εμάγνπκε ην αξρείν ζέζεο θνπηηθνχ γηα φιε ηελ ιεηηνπξγία (Δηθόλα 

IΙI.10.1) θαη ζε αξρείν (Δηθόλα IΙI.10.2) θαη ην απνζεθεχνπκε ζηνλ ίδην θάθειν. 

 Δηθόλα IΙI.10.1   Δηθόλα IΙI.10.2 
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Μφιηο δεκηνπξγεζεί επηηπρψο ην αξρείν (op010.ncl), επηιέγνπκε Done Output θαη ζηε 

ζπλέρεηα απφ ην Menu Manager → CL Data → Post Process, γηα λα αλνίμνπκε ην αξρείν 

πνπ δεκηνπξγήζεθε. Έπεηηα εκθαλίδνληαη νη δηαζέζηκνη ηειηθνί επεμεξγαζηέο θαη 

επηιέγνπκε ηνλ θαηάιιειν (uncx01.p01). Σέινο, εκθαλίδεηαη έλα παξάζπξν κε 

πιεξνθνξίεο ζρεηηθέο κε ηελ δηαδηθαζία πνπ νινθιεξψζεθε (Δηθόλα IΙI.10.3). 

 Δηθόλα IΙI.10.3 
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IV. Vericut 

1. Ειζαγωγή 

Σν πξφγξακκα Vericut απνηειεί έλα πξφγξακκα πξνζνκνίσζεο πξνγξακκάησλ 

αξηζκεηηθνχ ειέγρνπ κε πνιιέο δπλαηφηεηεο. ην πξφγξακκα απηφ, κπνξνχκε λα 

εηζάγνπκε αθνινπζίεο πνπ έρνπκε δεκηνπξγήζεη ζην Pro/NC ηνπ Pro/Manufacturing θαη 

λα παξαθνινπζήζνπκε ηελ πξνζνκνίσζε απηψλ. Δπίζεο, κπνξνχκε λα δνχκε θαηά πφζν 

καο ηθαλνπνηεί ε πξνζνκνίσζε, θαζψο ζην πξφγξακκα απηφ είλαη εκθαλείο νη ηπρφλ 

ζπγθξνχζεηο ηνπ θνπηηθνχ εξγαιείνπ κε ην θαηεξγαδφκελν θνκκάηη, κε ην κέζν 

ζπγθξάηεζεο ή κε δηάθνξα κέξε ηεο κεραλήο. Αθφκα, κπνξνχκε λα βειηηψζνπκε ηηο 

πξνψζεηο ηνπ πξνγξάκκαηνο, ψζηε λα επηηχρνπκε ηηο θαηάιιειεο γηα ην θαηεξγαδφκελν 

θνκκάηη θαη, ηέινο, ππάξρεη θαη ε δπλαηφηεηα θαηαγξαθήο ηεο πνξείαο ηνπ θνπηηθνχ ζε 

βίληεν. 

Σν πξφγξακκα Vericut κπνξνχκε λα ην αλνίμνπκε είηε επηιέγνληαο κέζα απφ κηα 

αθνινπζία Play Path → NC Check είηε απφ ην Menu Manager → CL Data → NC Check 

είηε αλνίγνληαο ηνλ Process Manager θαη επηιέγνληαο ηηο αθνινπζίεο θαη κεηά απφ ην 

Tools → NC Check, γηα λα πξνζνκνηψζνπκε πεξηζζφηεξεο απφ κηα αθνινπζία. 

Γηα λα εθηειεζηεί κηα πξνζνκνίσζε ζην πξφγξακκα Vericut, είλαη απαξαίηεην λα 

εηζάγνπκε ην αθαηέξγαζην θνκκάηη, δειαδή ην αληηθείκελν εξγαζίαο (Workpiece), ηελ 

πνξεία ηνπ θνπηηθνχ (ζε APT ή θψδηθα G) θαη ηηο δηαζηάζεηο ηνπ θνπηηθνχ. Δπηπιένλ, 

κπνξνχκε λα εηζάγνπκε θαη ηελ κεραλή CNC, γηα λα ειέγμνπκε πηζαλέο ζπγθξνχζεηο 

ηνπ θνπηηθνχ κε κέξε ηεο κεραλήο. 

Σν θεληξηθφ παξάζπξν ηνπ πξνγξάκκαηνο Vericut παξνπζηάδεηαη ζηελ Δηθόλα IV.1.1. 

 Δηθόλα IV.1.1 
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Γηα λα παξαθνινπζήζνπκε ηελ πξνζνκνίσζε ηνπ θνκκαηηνχ επηιέγνπκε ην Play to end 

, γηα λα δνχκε ηελ πνξεία ηνπ θνπηηθνχ θαηά βήκα επηιέγνπκε ην Single Step  θαη 

λα ην επαλαθέξνπκε ζηελ αξρηθή ηνπ θαηάζηαζε επηιέγνπκε ην Reset Model . 

Γηα λα αιιάμνπκε ηνλ πξνζαλαηνιηζκφ ηνπ αληηθεηκέλνπ καο, επηιέγνπκε View → 

Orient γηα λα εκθαληζηεί ην παξάζπξν ηεο Δηθόλαο IV.1.2 θαη είηε ην αιιάδνπκε 

ρεηξνθίλεηα κε βάζε θάπνηνλ άμνλα, είηε επηιέγνπκε κηα απφ ηηο έηνηκεο φςεηο, είηε ην 

πξνζαλαηνιίδνπκε φπσο επηζπκνχκε  επηιέγνληαο θάπνην ζεκείν ηνπ αληηθεηκέλνπ. 

 Δηθόλα IV.1.2 

Γηα λα εηζάγνπκε παξαπάλσ απφ κηα φςεηο επηιέγνπκε View → Layout → Standard. 

 

Γηα εκθάληζε ηεζζάξσλ φςεσλ, επηιέγνπκε ηελ YZ φςε θάησ δεμηά, ηελ XZ θάησ 

αξηζηεξά, ηελ XY πάλσ αξηζηεξά θαη πάλσ δεμηά ηελ default φςε (Δηθόλα IV.1.3). 

 Δηθόλα IV.1.3 
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Δπηπιένλ, κπνξνχκε λα θάλνπκε θάπνηεο ξπζκίζεηο, ψζηε λα έρνπκε θαιχηεξε εηθφλα 

ζηελ πξνζνκνίσζε, φπσο λα αιιάμνπκε ην ρξψκα ηνπ αληηθεηκέλνπ θαη παξακέηξνπο 

πνπ ζρεηίδνληαη κε ηελ θίλεζε ηνπ θνπηηθνχ εξγαιείνπ. 

Δπηιέγνληαο Configuration → Component Tree ή ην εηθνλίδην  εκθαλίδνληαη ηα 

αληηθείκελα πνπ απαξηίδνπλ ην κνληέιν καο θαη επηιέγνληαο Define ή ην εηθνλίδην  

εκθαλίδνληαη νη ξπζκίζεηο γηα ην θάζε αληηθείκελν (Δηθόλα IV.1.4), φπνπ κπνξνχκε λα 

αιιάμνπκε ην ρξψκα, ηελ κεηαηφπηζε ηνπ θαη πνιιά άιια. 

 Δηθόλα IV.1.4 

Δπίζεο, επηιέγνληαο Edit → Colors κπνξνχκε λα αιιάμνπκε ην ρξψκα γηα ηελ θάζε 

αθνινπζία.  

Με ηελ επηινγή Project → Processing Options → Motion εκθαλίδεηαη κηα θαξηέια 

(Δηθόλα IV.1.5) φπνπ κπνξνχκε λα αιιάμνπκε δηάθνξεο παξακέηξνπο πνπ ζρεηίδνληαη κε 

ηελ θίλεζε ηνπ θνπηηθνχ. 

 Δηθόλα IV.1.5 

Αθφκα, κπνξνχκε λα ειέγμνπκε ηα θνπηηθά εξγαιεία, επηιέγνληαο Project → Tools θαη 

λα εηζάγνπκε έλα λέν επηιέγνληαο απφ ην παξάζπξν απηφ Add → Tool → New → Mill. 
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Μεηά ην ηέινο ηεο πξνζνκνίσζεο κπνξνχκε λα ειέγμνπκε θάπνηεο ιεπηνκέξεηεο γηα 

χπαξμε ηπρφλ δηαθνξψλ ηεο επηζπκεηήο κε ηελ παξαγφκελε θαηεξγαζία, θαζψο θαη λα 

βειηηψζνπκε ηελ πνξεία ηνπ θνπηηθνχ, ψζηε λα έρνπκε βέιηηζηεο ζπλζήθεο θαηεξγαζίαο. 

Δπηιέγνληαο Analysis → NC Program Review ή ην εηθνλίδην  κπνξνχκε λα δνχκε 

αλαιπηηθά ηελ πνξεία ηνπ θνπηηθνχ θαη ηνλ θψδηθα ηνπ αξρείνπ ζέζεο ηνπ θνπηηθνχ ηεο 

θίλεζεο πνπ εθηειεί (Δηθόλα IV.1.6). 

 Δηθόλα IV.1.6 

Γηα λα θαηαγξάςνπκε ηελ πνξεία ηνπ θνπηηθνχ ζε βίληεν επηιέγνπκε File → Images → 

Record Movie θαη ζην παξάζπξν πνπ εκθαλίδεηαη (Δηθόλα IV.1.7), αθνχ δψζνπκε ην 

φλνκα ηνπ αξρείνπ πνπ ζα εμαρζνχλ ηα δεδνκέλα, επηιέγνπκε Record γηα εγγξαθή βίληεν 

ή Snapshot γηα λα πάξνπκε κηα εηθφλα ηεο θαηεξγαζίαο. 

 Δηθόλα IV.1.7 
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Σέινο, ην πξφγξακκα Vericut καο παξέρεη κηα πιεζψξα κεραλψλ πνπ κπνξνχκε λα 

εηζάγνπκε γηα λα έρνπκε κηα πην νινθιεξσκέλε πξνβνιή ηεο πξνζνκνίσζεο. 

Δπηιέγνληαο Configuration → Machine → Open αλνίγνπκε ηελ βηβιηνζήθε ησλ 

κεραλψλ. 

 

ηηο αθφινπζεο εηθφλεο (Δηθόλεο IV.1.8) θαίλνληαη κεξηθέο κεραλέο CNC απφ ηελ 

βηβιηνζήθε ηνπ Vericut. 

 

 

Δηθόλεο IV.1.8
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Αναζκόπηζη - Σσμπεράζμαηα  

ηε  παξνχζα  δηπισκαηηθή  εξγαζία  κειεηήζεθε  ν  απηφκαηνο  ηξφπνο  δεκηνπξγίαο  

θψδηθα εξγαιεηνκεραλψλ αξηζκεηηθνχ ειέγρνπ. Παξνπζηάζηεθε εθηελψο ε κεζνδνινγία  

κε  βάζε  ηελ  νπνία  γίλεηαη  ε απηφκαηε  δεκηνπξγία  ηνπ  θψδηθα  κε  ηελ βνήζεηα ηνπ 

Pro/Engineer. Σν Pro/Engineer απνηειεί έλα νινθιεξσκέλν παθέην παξακεηξηθνχ 

ινγηζκηθνχ ηξηζδηάζηαηεο κνληεινπνίεζεο θαη ην ππνζχζηεκα Pro/Manufacturing ηνπ 

Pro/Engineer πνπ κειεηήζεθε, επηηξέπεη ηε δεκηνπξγία θαη ηελ εθηέιεζε πξνγξακκάησλ 

γηα κεραλέο αξηζκεηηθνχ ειέγρνπ. 

πγθεθξηκέλα ζηελ εξγαζία απηή, παξνπζηάζηεθε ν ζχγρξνλνο ηξφπνο ζρεδηαζκνχ θαη 

εθηέιεζεο θαηεξγαζηψλ γηα CNC θξέδεο ηξηψλ αμφλσλ, θαη παξάιιεια κε απηφ, 

παξαηέζεθαλ ρξήζηκεο ζπκβνπιέο γηα θαιχηεξε νξγάλσζε ηνπ ιεηηνπξγηθνχ 

πεξηβάιινληνο ηνπ πξνγξάκκαηνο θαη ζεκαληηθέο πιεξνθνξίεο γηα ηηο παξακέηξνπο πνπ 

παίδνπλ ξφιν ζηελ εθάζηνηε θαηεξγαζία.  

Γηα ηελ παξνπζίαζε ησλ παξαπάλσ, πξαγκαηνπνηήζεθε ε δεκηνπξγία ελφο δνθηκίνπ θαη 

ησλ απαξαίηεησλ αθνινπζηψλ αξηζκεηηθνχ ειέγρνπ γηα ηελ πιήξε θαηεξγαζία απηνχ, 

θαη ζην ηέινο, ε πξνζνκνίσζε θνπήο κε ηελ βνήζεηα ηνπ πξνγξάκκαηνο Vericut.   

Καηά ηε δηάξθεηα ηνπ ζρεδηαζκνχ ηνπ αμίδεη λα ζεκεησζνχλ νη εμήο παξαηεξήζεηο:  

 Πξηλ ηνλ ζρεδηαζκφ ησλ θαηεξγαζηψλ πξέπεη:  

 Να νξηζηεί ν ηξφπνο ζπγθξάηεζεο ηνπ εθάζηνηε θνκκαηηνχ κε ην ηξαπέδη ηεο 

εξγαιεηνκεραλήο.  

 Να είλαη γλσζηά ηα θνπηηθά εξγαιεία κε ηα νπνία ζα γίλεη ε εθάζηνηε θαηεξγαζία 

θαη λα ηθαλνπνηνχλ ηηο γεσκεηξηθέο απαηηήζεηο ηνπ ηεκαρίνπ. Γηα θαηεξγαζίεο πνπ 

αθνξνχλ εθρφλδξηζε λα ρξεζηκνπνηνχληαη θνπηηθά κεγάιεο δηακέηξνπ γηα κείσζε 

ηνπ ρξφλνπ θαηεξγαζίαο.  

 Να γίλεη έλα δηάγξακκα ησλ θαηεξγαζηψλ θαη ησλ ππνδνκψλ πνπ ζα δεκηνπξγεζνχλ 

γηα πεξεηαίξσ θαηεξγαζίεο (π.ρ. απνπεξάησζε).  

 Καηά ηε δηάξθεηα ηνπ ζρεδηαζκνχ ησλ θαηεξγαζηψλ πξέπεη:  

 Να  ιακβάλνληαη  ππφςε  νη  αληνρέο  ησλ  θνπηηθψλ, λα γίλεηαη ζπζρέηηζε κε ην 

πιηθφ θαηεξγαζίαο θαη λα δίλεηαη ζεκαζία ζηηο ηδηαηηεξφηεηεο ηεο εθάζηνηε 

κεραλήο. Ζ ρξήζε ςπθηηθψλ πγξψλ απμάλεη ηε δηάξθεηα δσήο ησλ θνπηηθψλ θαη 

δηεπθνιχλεη ηηο θαηεξγαζίεο κε κεγάιεο πξνψζεηο. 

 Να  εηζάγνληαη  ζην  πξφγξακκα  ζρφιηα  γηα  ηε  δηεπθφιπλζε  ηνπ  ρεηξηζηή  ηεο 

εξγαιεηνκεραλήο.  

 Να γίλεηαη πξνζνκνίσζε ηνπ θψδηθα ζε εηδηθφ πξφγξακκα γηα ηελ αλίρλεπζε ιαζψλ 

ηνπ πξνγξάκκαηνο θαη ηε βειηίσζε ηεο πνξείαο ηνπ θνπηηθνχ.  
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 Να ιακβάλεηαη ππφςε ην γεγνλφο φηη κπνξεί ην αληηθείκελν πξνο θαηεξγαζία λα έρεη 

απφθιηζε ζην κέγεζνο απφ ην επηζπκεηφ, ψζηε λα ιακβάλνληαη ηα απαξαίηεηα κέηξα 

θαη φξηα. 

ζν αλαθνξά ηελ νξγάλσζε ηνπ ιεηηνπξγηθνχ πεξηβάιινληνο ηνπ πξνγξάκκαηνο, 

ππάξρεη ε δπλαηφηεηα ξχζκηζεο πνιιψλ επηινγψλ δηάηαμεο (config. pro options), ψζηε 

λα πξνζαξκφζνπκε ην πεξηβάιινλ ζηηο επηζπκεηέο ζπλζήθεο. Απηφ επηθέξεη 

εμνηθνλφκεζε ρξφλνπ θαη θφπνπ γηα επίζπεπζε δηαθφξσλ δηαδηθαζηψλ, φπσο 

δεκηνπξγία, θαηεξγαζία, απνζήθεπζε. 

Δπίζεο, ηδηαίηεξα ζεκαληηθά είλαη ηα αξρεία θαηεξγαζίαο, ηα νπνία ρξεζηκνπνηνχκε γηα 

λα νξίζνπκε θάπνηεο βαζηθέο ζπλήζεηο παξακέηξνπο, δειαδή λα δεκηνπξγήζνπκε έλα 

αξρείν ζηα δηθά καο πιαίζηα, πξνζδηνξίδνληαο πξνεπηιεγκέλεο ξπζκίζεηο παξακέηξσλ, 

ην νπνίν κπνξνχκε λα ρξεζηκνπνηήζνπκε ζε πεξηζζφηεξεο απφ κηα αθνινπζίεο. 

Έλα αθφκε δπλαηφ ζεκείν ηνπ πξνγξάκκαηνο απνηειεί ε δεκηνπξγία ελφο πξφηππνπ 

κνληέινπ θαηεξγαζίαο. Με απηφλ ηνλ ηξφπν, δεκηνπξγνχκε έλα ηθαλνπνηεηηθφ πξφηππν, 

πνπ πεξηέρεη ηηο βαζηθέο επηζπκεηέο ξπζκίζεηο, γηα λα καο δηεπθνιχλεη θαηά ηε 

δεκηνπξγία ελφο λένπ κνληέινπ θαηεξγαζίαο.  

πλνςίδνληαο, ε παξνχζα δηπισκαηηθή εξγαζία, απνηειεί έλα αξρηθφ ζηάδην γηα ηελ 

εηζαγσγή ζηελ πξνρσξεκέλε ζρεδίαζε ζην ππνζχζηεκα Pro/Manufacturing ηνπ 

Pro/Engineer, σζηφζν, είλαη επηζπκεηή ε επέθηαζή ηεο κε ζηφρν ηελ αμηνπνίεζε θαη  

ησλ ππφινηπσλ εθαξκνγψλ θαη δπλαηνηήησλ ηνπ ινγηζκηθνχ απηνχ.   
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Παράρηημα 1 – Κοπηικά εργαλεία 

 

 

Milling Tools 

 

 

Plunge Mill Tool 
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Side Mill Tool Sections 
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Thread Mill Tool 

 

 

 

 

Groove, Contouring, and Auxiliary Tools 
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Holemaking Tools - Drill and Tap 

 

 

 

 

Holemaking Tools - Countersink 

 

 



ΠΑΡΑΡΣΖΜΑΣΑ 

 

145 

 

 

Holemaking Tools - Bore and Back Spotting 

 

Holemaking Tools - Ream and Center Drill 
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Παράρηημα 2 – Μητανολογικά ζτέδια 
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Παράρηημα 3 – Φύλλο διαδικαζιών 

 

Φχιιν Γηαδηθαζηψλ (Route Sheet) 

 

 
 


